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LABORATORY 1: Attitude Measurements and Fundamental Structures.
I. Reference system

(A) Geological structures are represented by one or more lines or planes.

(B) A line can be defined in three-dimensional space by its angle with three orthogonal
axes. A plane can be represented by its normal, which itself is a line.

(C) Maps contain two horizontal references: Latitude and Longitude (N-S, E-W)

(D) The third reference axis is a vertical line.

(E) Geologists typically orient structures with reference to the horizontal (strike, bearing,
trace, trend) and the vertical (dip, plunge, inclination).

(F) Specifying the orientation or attitude relative to the horizontal and vertical references
will specify completely the three-dimensional orientation of a line or plane.

(G) Orientation within the horizontal reference plane (map) is read relative to a compass
direction (north, south, east, west) in units of degrees.

(H) Orientation relative to the vertical is described simply as the angle measured from the
horizontal plane to the plane or line of interest, this measurement being made in a vertical
plane. This angle ranges from 0 to 90E.

II. Important Geometrical Terms

(A) Apparent dip: dip (incline) of a plane in a vertical plane that is not perpendicular to
the strike.  The apparent dip is always less than the true dip.

(B) Attitude: orientation of a geometric element in space.

( C) Azimuth: a compass direction measured in degrees clockwise from north with
north=0, east=90, south=180, and west=270.

( D ) Bearing: the compass direction of a line, in quadrant format.

( E) Cross section: representation of a geometry on a plane perpendicular to the earth’s
surface.

(F) True dip: the inclination of a plane measured in a vertical plane trending
perpendicular to strike.

(G) Dip direction: trend of the dip line; always perpendicular to strike. 
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(H) Inclination: angle that the trace of a  geometric element (line or plane) makes with
the horizontal measured in a vertical plane. The maximum angle is 90 degrees (vertical).
The angle of inclination of a plane is termed dip, for a line it is referred to as the plunge. 

(H) Lineation: general tern for a geological feature that is best represented by a line
(mineral lineation, stretched pebbles, fold hinge, etc.)

(I) Pitch: the angle between a line and the strike of the plane that contains the line. Pitch
is synonymous with rake.

(J) Plunge: angle of inclination of a line measured in a vertical plane.

(K) Plunge direction: trend of a plunging line.

(L) Quadrant: a compass direction measured 0-90 degrees from north or south. An
example would be N60W (=300 azimuth)  or S30E (= 150 azimuth).

(M) Rake: angle measured between a line and the strike of the plane that contains the
line. The quadrant of the end of the strike line from which the measurement is made must
be included as part of the rake angle unless the rake angle = 90 (i.e. 40NE for a 40 degree
rake angle measured from the northeast end of the strike).

(N) Strike: the trend (compass direction)  of the horizontal line in a geological plane (i.e.
bedding, fault, joint, axial plane, etc.). By convention the compass direction of the strike
is always assigned to a north quadrant., therefore, the azimuth possibilities are 0-90 and
270-360. Note that 360 azimuth is the same strike as 0. 

(O) Trace: the line formed by the intersection of two non-parallel surfaces.

(P) Trend: azimuth direction of a line in map view. 

II. Attitude of Planes

(A) Bedding, cleavage, foliation, joints, faults, axial plane are some of the geological
structures that are represented as a plane. Although some of these features are actually
curviplanar (i.e. curved surfaces), over short distances their tangent surfaces can be
considered planar.

(B) The linear attitude component of a plane that is measured in the horizontal reference
plane is termed the strike. The strike of a plane is defined as the compass direction
formed by the intersection of that plane with a horizontal reference plane. Another way to
define strike is simply as the compass direction of the horizontal line contained in the
geological plane of interest. By convention the azimuth direction of a strike line is read
to a north quadrant so allowable measures of strike azimuth are in the range “000-090"
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and “270-360" for strike azimuth, or (N0E - N90E) and (N0W-N90W) for quadrant
format strike line bearing.

The only situation where the above definitions are ambiguous would be the special case
where the plane of interest is horizontal, in which case there are an infinite number of
horizontal lines in the plane. In this special case the strike is “undefined”, and a geologist
would describe the plane as “horizontal” or has a “dip = 0".

(C) The orientation of the strike line relative to the compass direction can be recorded in
one of two ways:

1. Quadrant - N45EE, N15EW, N90EE (always read to a north quadrant)
2. Azimuth- 033E, 280E, 090E (always read to a north quadrant)

Note that since there are two possible "ends" to a strike line, by convention strike lines
are measured in the northern quadrants.

(D) If you are using azimuth convention, be sure to use three digits even if the first one or
two digits are "0". This avoids confusion with plunge or dip.

(E) The dip of a plane defines its attitude relative to the vertical reference. There are two
types of dip values:

1. True dip- all planes have only one unique value for true dip
2. Apparent dip- all planes have many possible apparent dip values that range
from zero to less than, but not equal to, the true dip value.

(F) The dip angle is the angle measured in a vertical plane from the horizontal down to
the plane of interest. The true dip is always measured in the vertical plane that trends
perpendicular to the strike of the plane. A dip angle measured in a vertical plane trending
in any other map direction will always yield an apparent dip value less than that of the
true dip. An apparent dip measured parallel to strike always will yield a dip angle of 0E.

(G) Dip values always are in the range 0-90E . A dip angle of 0E defines a horizontal
attitude. 90E of dip describes a vertically oriented plane.

0-20E: Shallow
20-50E: Moderate
50-90E: Steep

(H) Specification of the strike orientation and dip angular value does not indicate the
three-dimensional orientation of a plane; the direction of the dip inclination must also be
known:
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Possible Strike/Dip quadrant combinations.

Northeast Strike (0-090
azimuth)

Northwest Strike (270-360
azimuth)

True dip trends east SE NE

True dip trends west NW SW

(I) Note that it is unnecessary to measure the exact compass direction of the dip direction
since it is by definition 90E from the strike. A full strike and dip might be recorded as:

N45EE, 30ESE (quadrant strike first, then dip and dip direction)
045E, 30ESE  (Strike azimuth first, then dip and dip direction)

(J) Several different map symbols have been agreed upon by geologists to represent
specific planar structures on geologic maps. All of the symbols have these characteristics
in common:

1. The long dimension of the symbol is parallel to the strike line.
2. A tic mark or arrow oriented perpendicular to strike will point in the dip
direction. A number next to this part of the symbol is the value of the true dip.
3. Special symbols exist for horizontal and vertical attitudes.

(K) Because a geologic map must sometimes show multiple generations of planar
structures, geologists must often "invent" symbols for a specific map. One should always
explain the meaning of all symbols used within the map legend.

(L) Besides strike and dip several alternative methods have been used to define a 3D
planar attitude:

1. Right-hand rule: the azimuth direction of the strike is recorded such that the
true dip is inclined to the right of the observer. In this case the strike azimuth
could be to any quadrant. For example, the traditional strike and dip of 320,
55SW would be recorded as 140, 55. 

2. Dip line trend and plunge: this method relies on the implicit 90E angle between
the true dip azimuth and the strike. The observer measures the dip azimuth and
then the true dip angle. For example, a traditional strike and dip of 320, 55SW
would instead be 230, 55 where 230 is the trend of the true dip line and 55 is the
plunge (= true dip). 

III. Attitude of Lines
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(A) Many geological structures such as fold hinges, mineral lineation, igneous flow
lineation, intersection lineation, fault striations, flute casts, etc., possess a linear geometry
in three-dimensional space.

(B) Strike and dip cannot be used to measure the attitude of a line. Trend and Plunge are
the two components of linear attitude.

(C) The plunge of a line is the angle that the line makes with the horizontal reference
measured in a vertical plane. The plunge angle ranges from 0-90E.

(D) The projection of the linear feature directly to the horizontal reference plane forms a
line that is the trend of the linear element. The trend, like the strike, is measured relative
to the compass direction. In this course we will normally use azimuth rather than
compass quadrants to indicate trend direction, however, you may have to work with data
that is recorded in quadrant format so you should be comfortable converting back-and-
forth from azimuth to quadrant bearing formats.

(E) Although the trend is measured in the same horizontal reference plane as the strike,
its trend may be to any quadrant of the compass. This is because the bearing of the linear
feature describes the compass direction of the plunge inclination, which could be to any
compass quadrant.

(F) To clearly distinguish it from a strike and dip, a linear attitude may be written as a
plunge and trend with the plunge angle first:

55E, 145E (plunge angle first, then the bearing azimuth)

Although this convention is not universally followed. 

(G) A plunge angle value of 0E describes a horizontal line. A plunge angle of 90E
denotes a vertical line, in which case the bearing is undefined since it has no component
parallel to the horizontal reference.

(H) Another term may be used to describe the attitude of a line if the line lies within a
plane of known strike and dip. This value is the rake or pitch angle, and it is defined as
the angle made by the line with the strike line of the plane in which it is contained. The
direction end of the strike line from which the angle is measured must be noted to fix the
attitude of the line.

(I) Linear elements are displayed on a geologic map with a variety of features. The long
dimension of these symbols describes the trend with an arrow pointing in the plunge
compass direction. The numeric value next to the arrowhead is the plunge angle value in
degrees.
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(J) Since many lineations are intimately related to certain planar features, such as a
metamorphic mineral lineation contained within a planar foliation, these two structural
elements may be combined into a composite map symbol on geologic maps.

IV. The Pocket Transit (Brunton Compass)

(A) The traditional survey instrument of the geologist has been the Brunton Compass or
pocket transit, although the alidade and plane table or Total Station is used in studies
where more accuracy is needed.

(B) The pocket transit contains a magnetic needle that always seeks true magnetic north.
On most, but not all, pocket transits, the white end of the needle points to magnetic north.

(C) The perimeter of the compass is divided into degrees based on one of two formats:

1. Quadrant- four quadrants (NE, SE, NW, SW) of 90E each.
2. Azimuth - 0 to 360E.

(D) A foldout metal pointer, termed the “sighting arm”, defines the long axis of the
instrument. This is used as a sighting alignment for measuring a strike line or bearing.

(E) Inside the compass is a bull's eye level and a clinometer level. The round bull's eye
levels the body of the compass within the horizontal plane. The clinometer can be used to
measure angles within a vertical plane. With the ability to measure both compass
direction from magnetic north and vertical angles with the clinometer, the pocket transit
can determine strike and dip or plunge and bearing of any geological structure.

(F) Examination of either format compass reveals that the compass directions run in
counterclockwise rather than clockwise fashion. This is done so that the north end of the
needle reads the correct quadrant or azimuth value if one is sighting along the extended
metal pointer arm.

V. Magnetic Declination

(A) Since magnetic north and geographic north do not coincide, geologic maps and
survey instruments must correct for the angular difference in these values. In the United
Sates, for example, the magnetic declination ranges from 0 to over 20E. The declination
angle is measured as east or west depending on its orientation relative to geographic
north.

(B) All United State Geological Survey (USGS) topographic maps have the magnetic
declination indicated in the margin information. 7.5' USGS topographic maps are the
standard mapping tools for geological mapping. GPS receivers typically provide an up-
to-date measurement of the magnetic declination. USGS maps published more than
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several decades ago will have inaccurate declination value.

(C) To correct for magnetic declination, the pocket transit can be adjusted by turning the
screw located on the side of the compass case. Turning this screw rotates the compass
direction scale. Therefore, the compass can be adjusted for magnetic declination by
ensuring that the long axis of the Brunton (sighting arm) points to geographic north when
the north end of the needle indicates the 0E position. All USGS maps have the magnetic
declination value for the map area printed on the bottom center margin of the map.

VI. Measurement of Planar Attitudes with the Pocket Transit

(A) Direct measurement of strike.

(B) Direct measurement of dip.

(C) Use of notebook or compass plate to simulate attitude of plane.

(D) Shooting a strike and dip from a distance with peep sight.

(E) Dips less than 12E cannot be measured because of the clinometer ring protector.

1.  Water will run directly down the true dip direction id dripped on a smooth
planar surface. 

2. Visually estimate the true dip direction. Measure the dip angle in several
directions sub-parallel to this direction. The steepest dip is the true dip direction.

The strike is, of course, perpendicular to the true dip direction determined from the above
methods.

(F) When measuring dip angles remember that the clinometer bubble must be up while
the pocket transit is held against the planar structure.

VII. Measurement of Linear Attitudes with the Pocket Transit

(A) The first component of a linear structure that is measured is usually the bearing. To
measure the bearing one must line up the long axis of the compass parallel to the
projection of the line to the horizontal. There are several methods that accomplish this:

1. Line the feature with the metal pointer while leveling the compass.

2. Align a clipboard or compass plate with vertical and parallel to the linear
structure. Hold the compass against the plate while leveling.
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3. Sight to a distant landmark that lies along the lineation using the peep hole
sight.

4. Hold the compass against or close to the lineation. Level while keeping the
edge of the compass parallel to the lineation. The azimuth read will be parallel to
the structure.

5. Lineations observed on an overhanging surface can be almost impossible to
measure directly. First measure the strike and dip of the surface that contains the
lineation. With a protractor or compass measure the angle that the lineation makes
with the strike line of the surface, carefully noting from which end of the strike
line that the angle was measured. This is the rake angle of the lineation in the
plane. In this case the strike and dip may not correspond to any geological
structure– it is simply a reference plane. The plunge and bearing of the lineation
may be calculated later with stereographic office methods (see Laboratory  2).

(B) After determining the bearing you must measure the plunge angle. To determine the
plunge, arrange the compass edge parallel to the lineation while measuring the plunge
angle with the clinometer. It may be necessary for a partner to hold a pencil parallel to
the lineation for reference while you measure the plunge on that object.

(C) If the lineation lies within a planar structure whose attitude has already been recorded
one may simply measure the rake angle of the lineation or bearing of the lineation (see
section A-5 above). Either of these can later be converted to a bearing and plunge for
plotting on a geologic map. The conversion can be done in the field with a stereonet.

(D) If the lineation has a steep plunge, it may be difficult to visualize the correct bearing.
In this case, if the lineation lies within a plane it is more accurate to measure its rake
angle with a protractor, after first measuring the strike and dip of the plane containing the
linear element.

VIII. Locating Points with a Pocket Transit

(A) The accuracy of a geologic map is totally dependent upon the accuracy of your field
stations. The first job of the geologist is to accurately locate his or her position on the
map. The compass can aid you in several ways.

(B) Pace and Compass: in areas where no suitable topographic map exists, or where
traverses do not follow existing roads or trails on the map, it is necessary to keep track of
position with a pace and compass traverse. The traverse is done by estimating distance
from point to point with pace counts, while bearings are shot from point to point and
recorded. The traverse is later plotted on the map with a protractor and scale. The
traverse must start from a known reference point.
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(C) Triangulation can locate a position by the determination of the bearing to two or
more known landmarks that occur on a map. Plotting the reverse azimuth of the
landmarks will intersect at the current position on the map.

IX. Geologic Time

(A) The geologic time scale must be understood for proper evaluation of geologic
structures. Stratigraphic codes utilize the time scale to indicate the relative ages of strata.
(Figure 1-1)

(B) Stratigraphic codes such as “Oc” on a geologic map may mark the exposed area of
the Ordovician age Chickamauga Formation. The geologic period abbreviation is always
uppercase, whereas the formation name abbreviation is lowercase. Note the special
symbols for Precambrian, Cambrian, Pennsylvanian, and Triassic.

X. Rule of “V” for Geologic Contacts

(A) When inclined beds cross a stream valley the contact will form a “V” pointing in the
dip direction. (Figure 1-2)

(B) The “V” shape is more pronounced with shallow dips, less so as the dip angle
increases.

Geologic Time

Period Symbol

Quaternary Q

Tertiary T

Cretaceous K

Jurassic J

Triassic Tr

Permian P

Pennsylvanian |P

Period Symbol

Mississippian M

Devonian D

Silurian S

Ordovician O

Cambrian ‐C

Precambrian p‐C

Young

Old

Young

Old

Figure 1-1  : Geologic time scale.
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(C) If the contact is vertical (i.e. dip angle =90) the contact will not form a “V” when
crossing a valley. Instead there is no offset therefore the contact remains straight in map
view.

XI. Bedding Strike and Dip
Symbols

(A) Figures 1-3 through 1-6
illustrate various strike and dip
symbols required for different
attitudes of bedding.

(B) Note that in the case of
overturned bedding the strata would
have to be rotated more than 90
degrees to return the stratigraphic
section to its original horizontal
position.

Rule of “V’s” for Geologic Contacts 
Crossing Stream Valleys

5020 90

Figure 1-2 :Rule of “V”s for contacts.

‐Cs Oc Sr Dc

75 75 75 75

‐Cs Oc
Sr Dc

Dc

p‐Ca

75

Figure 1-3 : Steeply dipping strata.
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‐Cs Oc Sr Dc

35 35 35 35

‐Cs Oc Sr

Dc

Dc

Sr

Oc

p‐Ca

35

Figure 1-4 : Moderately dipping strata.

‐Cs Oc Sr Dc

‐Cs Oc Sr Dc

Dc

90

Figure 1-5 : Vertical strata.
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XII. Apparent Dips and Block Diagrams

(A) If inclined stratigraphic contacts intersect the vertical sides of a 3D block diagram
such that the trend of the vertical side is not perpendicular to the strike of the contact the
inclined angle of the strata on the side view will be an apparent dip rather than the true
dip. The apparent dip is always less than the angle of the true dip. 

(B) In block diagrams apparent dips on the side view can constrain the true dip value
used for the strike and dip symbol, as in Figure 1-7. 

   

Sr Oc ‐Cs p‐Ca

35 35 35 35

Sr
Oc ‐Cs

p‐Ca

Dc

35

p‐Ca

‐Cs
Oc

Figure 1-6 : Overturned strata.
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XIII. Non-Plunging Folds and 3D Block Diagrams

(A) Fold structures are most effectively displayed on 3D Block diagrams because they
display the interpretation of the structure in the subsurface. (Figure 1-8)

(B) Remember to use as much information from the map as possible - for example even
though a contact does not intersect a vertical face on the block, it is possible that a
contact may project to the face in the subsurface.

© Anticlinal and synclinal
closures should be used whenever
possible. If a fold hinge projects
above the diagram “ in the air” it
should be dashed. 

(D) Use stratigraphic info- if
the map surface displays a
thickness for a unit make
sure that is displayed on the
vertical faces of the
diagram.

(E) The anticline axial trace
symbol indicates that both
limbs of the fold dip away

Oc Sr

Dc

Mt

Mt

Dc

Sr

Oc

Dc

Sr
Oc

Mt

>35

35

>35

>35

Figure 1-7 : Apparent and true dips in a block diagram.
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Figure 1-8 : Example anticline/syncline pair.
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from the core; syncline symbol indicates limbs dip toward the core of the fold structure. 

(F) Anticlines always contain the older strata in the core of the structure. Synclines
contain the younger strata in the core of the structure.

(G) If a fold structure is concave-down in cross-sectional profile but contains the younger
strata in the core it is termed a antiformal syncline.

(H) If a fold structure is concave-up in cross-sectional profile but contains the older strata
in the core it is termed a synformal anticline.

(I) A concave-down structure with strata of indeterminate age relationships is termed an
antiform. A concave-up structure is a synform.

(J) The fold limb of a fold is considered to be the portion of a fold between adjacent fold
hinges. For example, in Figure 1-8 the area between the synclinal and anticlinal trace is a
single limb. This limb is shared between the adjacent folds marked by the axial traces on
the map. There are 3 limbs displayed in Figure 1-8 on the map view or front-face view of
the diagram.

(K) Note that the strike directions of the strike and dip symbols in Figure 1-8 parallel the
geological contacts, and those contacts are straight lines.

(L) In the map view a non-plunging fold will have straight, parallel contact lines between
stratigraphic units. The only curved contact lines will be along the vertical sides of the
block diagram (Figure 1-8).

XIV. Unconformable Contacts

(A) Unconformable contacts are produced by geologically significant intervals of time
marked by uplift and erosion, or by non-deposition. On geologic maps and/or cross
sections these contacts are recognized by discontinuity in the geologic time scale. For
example, if the upper stratigraphic contact of a Cambrian formation was also the lower
stratigraphic contact of a Devonian formation the contact must be some type of
unconformity.

(B) In map view an unconformity (angular unconformity, disconformity, nonconformity)
is symbolized by placing hachure tic marks on the young side of the contact. (Figure 1-9)

© In cross-section view, or along the vertical sides of a 3D block diagram unconformable
contacts should be a undulating “squiggly” line indicating erosional relief. 
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XV. Domes and Basins

(A) Domes and basins are similar to anticlines and synclines respectively in that domes
contain oldest strata in the core (center) of the structure, whereas basins contain younger
strata in the core of the structure (Figure 1-10).

(B) Unless overturned strata are present strike and dip symbols dip away from the core of
a dome, and dip toward the core of the structure for a geological basin (Figure 1-10).

( C)  The contacts of a basin or dome are generally circular to elliptical in geometry
forming a “bulls-eye” type pattern of contacts (Figure 1-10). 

(D) Note that geological
basins and domes do not
imply any type of
topography. A geologic
basin may in fact be a
topographic “dome” and a
geologic dome may in fact
be a topographic basin. 

(E) Note that the strike line
directions of the strike and
dip symbols in the map view
are always tangent to the
contacts in Figure 1-10.

XVI. Plunging Folds

‐Cs Oc Mf |Pp

35 35 35 35

‐Cs Oc Mf

|Pp

|Pp

Mf

Oc

p‐Ca

35

Figure 1-9 : Example of an unconformity.
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Figure 1-10 : example of a geological basin- younger strata
in core with circular geometry contacts.
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(A) Plunging folds have the same relationships as non-plunging folds with the following
exceptions (Figure 1-11):

1. Contacts in map view are curved rather than straight. (Figure 1-11)

2. The axial trace symbols have an arrow that points in the direction of the plunge of the
hinge of the fold.

3. Strike and dip symbols are tangent to the curved contacts in map view.

4. Vertical sides of the block diagram parallel to axial traces of folds display contact lines
inclined in the plunge direction. (Figure 1-11)

(B) For plunging
anticlines the “V” made
by curved contacts in
map view points in the
plunge direction.

© For plunging
synclines the “V” made
by curved contacts in
map view points away
from the plunge
direction.

XVI. Overturned Folds

(A) Overturned folds have one limb containing overturned strata- otherwise they follow
the rules discussed above for anticlines and synclines.

(B) In an overturned fold both limbs dip in the same direction therefore the axial trace
fold symbol is modified to indicate that fact. (See Figure 1-12).

© In the overturned limb the strike and dip symbols will be the special type indicating
overturned strata. (Figure 1-12).
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Dc Mf
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Dc

p‐Ca

p‐Ca
‐Cs Oc
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Oc

‐Cs

p‐Ca

p‐Ca

‐Cs

Oc

Sr

Oc

Dc

?

Plunging anticline
Axial trace

Plunging syncline
axial trace

Figure 1-11 : Example of a plunging anticline/syncline pair.
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(D) Note that the
overturned anticline and
syncline symbols
indicate that limbs dip in
same direction with
anticline symbol arrows
pointed away from axial
trace line, and the
overturned syncline
symbol having arrows
pointed toward the axial
trace line. (Figure 1-12)

XV. Fault Classification and
Block Diagram Interpretation.

(A) Fault classification is based on the type of movement between the two structural
blocks on opposite sides of the fault contact:

1. Slip parallel to strike of fault: Strike-slip fault.

2. Slip parallel to dip line of fault: Dip-slip fault.

3. Slip component
parallel to both strike
and dip lines: Oblique-
slip fault.

(B) Strike Slip Fault
Classification

1. If a contact that is
offset by the fault is
displaced to the right the
fault is right lateral. 
2. If a contact that is
offset by the fault is
displaced to the left the
fault is left lateral.
(Figure 1-13).
3. On the front vertical
face of the diagram the block that slips toward the observer is labeled with a “+” symbol
and a “-“ symbol for the block that slips away from the observer.

Mf Dc Sr Dc Mf |Pp Mf Dc Sr

?O

SrDcMfMfDcSr

?O

Dc

Mf

|Pp

Overturned anticline
symbol

Overturned syncline
symbol

Figure 1-12 : Example of a non-plunging overturned
anticline/syncline pair.
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Fault Classification:____________________________Left lateral Strike‐slip
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NOTE: 
slickensides in 
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parallel to 
strike of fault.

+ ‐

70
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H F

Figure 1-13 : Example of a left-lateral strike slip fault.
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© Dip Slip Fault Classification

1. The hanging wall is
always the block that
contains the dip
direction tic mark. The
footwall is the other
block.

2. Hanging wall down
slip relative to the
footwall is a normal dip
slip fault.

3. Hanging wall up slip
relative to the footwall is
a reverse dip slip fault.
(Figure 1-14)

(D) Oblique Slip Fault:
oblique slip faults contain both a strike slip and dip slip component. If the relative
magnitudes of the
two components can
be determined the
larger is listed last
when describing the
fault. In Figure 1-15
the strike slip
component was
larger than the dip
slip because the in
the description the
right-lateral strike
slip is listed last.

‐Ca‐Cp
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Sj

Do
Ox

‐Cp

‐Cp

Fault Classification:____________________________Reverse dip‐slip

‐Ca

35

35
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Sj

NOTE: 
slickensides in 
fault zone were 
oriented 
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line of fault.

70
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H F

U D

Figure 1-14 : Example of a reverse dip-slip fault.

Fault Classification:______________________________________

Mf

Dc

Sr

Oc

Qal

Tr Kt

Jl

Trd

Oblique: Normal dip‐slip and rt.‐lat. Strike‐slip

U

D

HW
FW

Mf

Dc

Sr
Oc

Kt
Jl

Trd

Jl

+‐

Figure 1-15 : Example of an oblique slip fault.
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EXERCISE 1A: Geological Attitudes and 3D Block Diagram Interpretation

Problem 1A-1: Using Figure 1-16 fill in the below matching items with the proper planar
attitude.  Use the “Strike azimuth, Dip angle and dip quadrant” format for your answer (ex. 045,
65 SE).

(A) ________________ (B)________________ (C) ________________

(D) ________________ (E) ________________ (F) ________________

(G) ________________ (H) ________________ (I) ________________

Problem 1A-2: Given the below planar attitudes fill in the Figure 1-17 diagram with the proper
bedding symbol. Note that the below planar formats vary:

(A) 090, 34 S (B) N60E, 12 SE (C) 330, 05NE

(D) 060, 07NW (E) Rt. Hand: 210, 35 (F) N30E, 90

(G) Dip trend & angle: 270, 45 (H) 000, 07 W OT  (I) horz. (Dip=0)

Problem 1A-3: Given the below linear attitudes fill in the Figure 1-18 diagram with the proper
lineation symbol. Note that the below linear formats vary:

(A) 210, 15 (B) 330, 05 (C)  65, 060

(D) 120, 40 (E) 030, 00 (F) 000, 90

(G) 23, S60W (H) 72,  N60W (I) 150, 55

Problem 1A-4: Using the block diagram in Figure 1-19 add relevant information to the map
surface portion of the block diagram. Include strike and dip symbols in each stratigraphic unit on
the map surface. Label each stratigraphic unit with the proper abbreviation.

Problem 1A-5: Complete the block diagram in Figure 1-20. Complete all visible sides to the
block diagram, and add strike and dip symbols, abbreviations, and fold axial trace symbols to the
map surface.

Problem 1A-6: Complete the block diagram in Figure 1-21. Complete all visible sides to the
block diagram, and add strike and dip symbols, abbreviations, and fold axial trace symbols to the
map surface. Note the stream on the map surface.

Problem 1A-7: Complete the block diagram in Figure 1-22. Complete all visible sides to the
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block diagram, and add strike and dip symbols to the map surface. Note the stream on the map
surface.

Problem 1A-8: Complete the block diagram in Figure 1-23. Add strike and dip symbols, unit
abbreviations, and fold axial trace symbols to the map surface. Note the stream on the map
surface.

Problem 1A-9: Complete the block diagram in Figure 1-24. Complete all visible sides to the
block diagram, and add strike and dip symbols and fold axial trace symbols to the map surface. 

Problem 1A-10: Complete the block diagram in Figure 1-25. Complete all visible sides to the
block diagram, and add strike and dip symbols and fold axial trace symbols to the map surface.
Note the stream on the map surface. 

Problem 1A-11: Complete the block diagram in Figure 1-26. Add strike and dip symbols, unit
abbreviations, HW/FW, U/D labels to the map surface. Add fault displacement arrows where
appropriate. Note the stream on the map surface. Classify the fault on the diagram.

Problem 1A-12: Complete the block diagram in Figure 1-27. Add strike and dip symbols, 
HW/FW labels, U/D labels, fold symbols, etc.,  to the map surface. Add fault displacement
arrows where appropriate. Complete the vertical sides of the block diagram as completely as
possible and label the units. Classify the fault on the diagram.
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Figure 1-16  : Diagram for problem 1A-1.
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Figure 1-17  : Diagram for problem 1A-2
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Figure 1-18 : Diagram for problem 1A-3.
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Ps Trf

Jfv

Ks

Jfv

Trf
Ps

Ks
35

Figure 1-19 : Diagram for problem 1A-4.

Jo Trx Pa KpTrx Jo Ta Kp Jo Trx

Figure 1-20 : Diagram for problem 1A-5
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So Da Mx Da So Og So Da Mx

Figure 1-21 : Diagram for problem 1A-6.
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Figure 1-22 : Diagram for problem 1A-7.
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Figure 1-23 : Diagram for problem 1A-8.
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Figure 1-24  : Diagram for problem 1A-9.
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Figure 1-25 : Diagram for problem 1A-10.
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Figure 1-26  : Diagram for problem 1A-11.
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Fault Classification:_____________________
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Figure 1-27 : Diagram for problem 1A-12. 

1-27



EXERCISE 1B: Geological Attitudes and 3D Block Diagram Interpretation

Problem 1B-1: Using Figure 1-28 fill in the below matching items with the proper planar
attitude.  Use the “Strike azimuth, Dip angle and dip quadrant” format for your answer (ex. 045,
65 SE) unless otherwise indicated..

(A) ________________ (B)_(quad)__________ (C) ________________

(D) ________________ (E) ________________ (F) ________________

(G) _(rt. hand)___________ (H) ________________ (I) _(dip az.& pl.)_______

Problem 1B-2: Given the below planar attitudes fill in the Figure 1-29 diagram with the proper
bedding symbol. Note that the below planar formats vary:

(A) 270, 64 N (B) N60W, 61SW (C) 030, 05NW

(D) 300, 07NE (E) Rt. Hand: 120, 67 (F) N30W, 90

(G) Dip trend & plunge: 240, 25 (H) 090, 77 N OT  (I) horz. (Dip=0)

Problem 1B-3: Given the below linear attitudes fill in the Figure 1-30 diagram with the proper
lineation symbol. Note that the below linear formats vary:

(A) 120, 15 (B) 300, 05 (C) 15, 210

(D) 030, 50 (E) 060, 00 (F) 000, 90

(G) 03, S60E (H) 32,  N60E (I) 270, 47

Problem 1B-4: Using the block diagram in Figure 1-31 add relevant information to the map
surface portion of the block diagram. Include strike and dip symbols in each stratigraphic unit on
the map surface. Label each stratigraphic unit with the proper abbreviation. If the true dip
amount can be determined use it with the strike and dip symbol.

Problem 1B-5: Complete the block diagram in Figure 1-32. Add the contact lines and unit
abbreviations on all sides to the block diagram, and add strike and dip symbols on the surface
face. Note the stream on the surface face of the block diagram.  

Problem 1B-6: Complete the block diagram in Figure 1-33.Add the contact lines and unit
abbreviations on all sides to the block diagram, and add strike and dip symbols on the surface
face. Note the stream on the surface face of the block diagram.
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Problem 1B-7:Complete the block diagram in Figure 1-34. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Add appropriate fold symbols
and label strata with age labels.

Problem 1B-8: Complete the block diagram in Figure 1-35. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Add appropriate fold symbols
and label strata with age labels. Note the stream on the map surface.

Problem 1B-9: Complete the block diagram in Figure 1-36. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Note the stream on the map
surface. Write the name of the structure in the upper left corner.

Problem 1B-10: Complete the block diagram in Figure 1-37. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Add appropriate fold symbols
and label strata with age labels.

Problem 1B-11: Complete the block diagram in Figure 1-38. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Add appropriate fault symbols
and label strata with age labels. Write the fault classification in the upper left corner.

Problem 1B-12: Complete the block diagram in Figure 1-39. Complete all visible sides to the
block diagram, and add strike and dip symbols to the map surface. Add appropriate fault symbols
and label strata with age labels. Write the fault classification in the upper left corner.
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Figure 1-28 : Figure for problem 1B-1.
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Figure 1-29 : Diagram for problem 1B-2.
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Figure 1-30 : Diagram for problem 1B-3.
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Figure 1-31 : Diagram for problem 1B-4.
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Ma Di Sx Ot
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Figure 1-32 : Diagram for problem 1B-5.
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Figure 1-33 : Diagram for problem 1B-6.
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Ko Tx Qa JrpTx Ko Tra Pp Tra Jrp

Figure 1-34 : Diagram for problem 1B-7.

Do Sa Ox Sa Do Mg Do Sa Ox

Figure 1-35 : Diagram for problem 1B-8.
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Figure 1-36 : Diagram for problem 1B-9.
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Figure 1-37 : Diagram for problem 1B-10
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Figure 1-38 : Diagram for problem 1B-11.

Fault Classification:_____________________
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Figure 1-39 : Diagram for problem 1B-12
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LABORATORY 2: Orthographic Projections for Solving True/Apparent Dips  and Three-Point
Problems.

I. True and Apparent Dip Calculations

(A) Given strike and true dip, calculate the apparent dip in a specific direction. 

Apparent dips are required whenever a cross-section intersects strike at some angle other
than 90 degrees.

(B) Methods

1. Graphical (demonstrated in class with orthographic construction).

Problem 1: Given strike and true dip of 050E, 40E SE, find the apparent dip in a vertical
cliff trending 110E (S70E E).

Answer: 110E, 36E (S70E E,36E)

Problem 2: Given two apparent dips of : 
(1) 200E, 35E (S20EW, 35E)
(2) 130E,25E ( S50EE, 25E)

Find the strike and true dip of the plane that contains these two apparent dips.

Answer: 271E, 36SW  (N89E W,36ESW)

2. Mathematical Solution with Excel Spreadsheet (IntersectingPlanes.xlsm,
CommonPlane.xlsm)

The spreadsheets for calculating apparent dip solutions may be downloaded from: 

http://www.usouthal.edu/geography/allison/GY403/StructureSpreadsheets.html

The spreadsheet “IntersectingPlanes.xlsm” is an Excel spreadsheet that calculates the
plunge and bearing of the line of intersection between 2 given planar attitudes (strike &
dip). Note that the apparent dip direction should be treated as a vertical plane. The
spreadsheet “CommonPlane.xlsm” calculates the strike and true dip of a plane that
contains 2 apparent dip linear (plunge & bearing) attitudes. 
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Figure 2-1  : Example problem 1 solution in spreadsheet form.

Figure 2-2 : Example problem 2 solution in spreadsheet form.

Problem 1:
Given strike
and true dip
of 050E, 40E
SE, find the
apparent dip
along the
trend of 
110E.

The solution
is displayed
in  Figure 2-
1. Note that
the input data is in blue text and the solution is in the green text. The stereographic
diagram in Figure 2-1 will be explained in later lab chapters.

Problem 2:
Given two
apparent dips
of: 

(1) 35E,
S20EW (200)
(2) 25E,
S50EE (130)
Find the strike
and true dip
of the plane
that contains
these two
apparent dips.

Answer: 271E, 37E SW

The solution is provided in the Figure 2-2 diagram.  

II. Three Point Problems

2-2



Figure 2-3  : Diagram of a three-point problem solution.

(A) Graphical Method: 

Given three points of known location and elevation that mark the outcrop of a plane can
always be used to calculate the strike and true dip of the plane. (Demonstrated in
classroom). Figure 2-3 is an example of the graphical method.

Answer: 277E(N83E W), 06E SW

If two of the three points are the same elevation, they will define the strike line directly.
In this variation of the problem only the dip must be calculated.

Remember to convert drill hole data to actual elevations before working the problem (i.e.
subtract the depth from the topographic elevation).

Solve the problem in the below steps.  Refer to Figure 2-3 as the steps to the problems
progress:

1. Plot the three points with elevation values labeled.  These are the points labeled
“High”, “Middle”, and “Low” in Figure 2-3.  Hereafter these points are known as H, M,
and L respectively.

2. Connect all three points with straight reference lines to form a triangle.

3.  Label the distances according to the map scale along each side of the triangle.  For
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instance, the side connecting L and H in Figure 2-3 is 5240 meters.

4. Visualize the side of the triangle that connects L and H. The strike of the structural
plane that passes through L, M, and H  will originate at M and pierce the L-H side at an
elevation equal to M, in this case 500 meters above sea level.  This point on the L-H line
is proportional to the relative elevation differences between L, M, and H. Another way of
visualizing this is to imagine that you could walk along the L-H edge of the structural
plane starting at point L. Since elevation would increase progressively from L to H there
must be a point on the edge equal to M. This point, along with the M apex of the triangle,
gives two points on the plane that have the same elevation.  Therefore, the strike line with
elevation equal to 500 meters must connect these two points.  In Figure 2-3, the distance
from point L to the M elevation on the L-H edge is calculated by solving for the relative
proportion of (M-L)/(H-L).  This distance is 3096 meters. This determines the strike to be
N83W.

5. Draw a line parallel to the strike line that passes through the H and L points. Since you
know the horizontal distance between these two strike lines from the map scale, and you
know the vertical change in elevation (H-L) also, you can solve for the dip angle either
graphically or mathematically.

6. To solve for the dip angle graphically, draw a line perpendicular to the H and L strike
lines such that it passes across both. On the L strike line, mark off a distance equivalent
to the elevation difference between these H and L according to the original map scale
(i.e. no vertical exaggeration allowed) .  In Figure 2-3 you will note the distance equal to
a 500 meter elevation change (H-L) is marked off. On the L strike line, starting where the
elevation difference was measured, connect a line from this point back to where the
perpendicular intersects the H strike line.  This new line will define the dip angle if you
measure the angle inscribed between the new line and the strike perpendicular . The
perpendicular to the two strike lines is, in effect, a fold line that displays the trace of the
dipping plane.  This fold line should be imagined to have an elevation equivalent to strike
line H.  In the Figure 2-3, the dip angle and direction is 6E SW.

(B) Mathematical solution with Excel Spreadsheet (ThreePoint.xls)

The Excel spreadsheet “ThreePoint.xls” may be used to mathematically determine the
strike and true dip of the plane that contains three points of known map position and
elevation. The spreadsheet is designed to use a specific convention when entering the
elements of the three-point problem. If a structural plane passes through the points in
Figure 2-4, the high elevation point (700m) is point “H”, the middle elevation point
(500m) is “M”, and the low elevation (200m) point is “L”. The bearing direction from
“H” to “M” (S67W) and from “H” to “L” (S18W) must be determined with a protractor,
and the map distance from “H” to “M” (4100m) and from “H” to “L” (5160m) also must
be determined with a scale. 
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Figure 2-4 : 3-point problem example in a spreadsheet.

Figure 2-5 : Spreadsheet for intersecting planes problem.

Figure 2-4 contains the above information entered into the “ThreePoint.xlsm”
spreadsheet (blue text). Note that the answer (276.6 [N83W], 5.6SW) is displayed in
green text. Make sure that all values are measured from the map accurately, and are
entered into the spreadsheet
accurately. Also note that
the spreadsheet is set to use
2 decimal places for angles,
therefore, all angles must be
entered with 2 decimal
places. Because of the
mathematical precision of
the spreadsheet the final
answer will be more precise
than the graphical
orthographic method. 

III. Plunge and Bearing of the Line
of Intersection of 2 Planes

A) Given the strike & dip of two non-parallel planes calculate the plunge and bearing of
the intersection of the planes.

Example Problem: Two
non-parallel dikes intersect
each other at an exposure.
Dike 1 is oriented  040E,
(N40E E), 30E SE and Dike
2 is oriented 290E ( N70E
W), 60E NE. What is the
attitude of the line formed
by the intersection of these
dikes?

Answer: 094E, 25E

1. Orthographic method demonstrated in class.

2. Mathematical method demonstrated in Figure 2-5 spreadsheet
(IntersectingPlanes.xlsm).
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EXERCISE 2A: Orthographic apparent dip, strike & true dip, trend & plunge problems.

NOTE: for all of the below problems it is recommended that you check the results of
orthographic or cotangent methods with the following spreadsheets:
1. http://www.usouthal.edu/geography/allison/GY403/CommonPlane.xlsm
2. http://www.usouthal.edu/geography/allison/GY403/IntersectingPlanes.xlsm
3. http://www.usouthal.edu/geography/allison/GY403/ThreePoint.xlsm
4. http://www.usouthal.edu/geography/allison/GY403/ApparentDip.xlsm

Problem 1: A bed has a known strike and dip of  045E, 35ENW. Find the apparent dip in a
vertical cliff trending 090E.

Problem 2: The strike of a bed can be measured on the flat top of an outcrop, but the dip cannot
be determined at this location. The apparent dip of the same bed can be measured on  several
vertical faces that do not trend perpendicular to the strike of the bedding. With the information
given below, determine the complete planar attitude of the bedding in each case (A and B). Do
separate page constructions for (A) and (B).

Apparent Dip Trend of Apparent Dip Strike of Bed

(A) 40E 035E 090E

(B) 15E 310E 345E

Problem 3: Find the strike and true dip of the contact between two uniformly planar beds where
two apparent dips – 053E,37E; 026E, 44E – were obtained.

Problem 4: The Drummond Coal Co. encountered the top of the Blue Creek coal seam with three
different drill holes. The hole depths were: (A) 1100'; (B) 650'; and (C) 850'. Hole (B) is 3300'
N10EE of (A), hole (C) is 2700' N60EW of (A). As you are the geologist on site, you are charged
with finding the strike and dip of the coal seam so that the company can proceed with mine
development. Assume that the drilling of all three holes started on a flat horizontal surface. Scale
1" = 1000 feet. 

Problem 5: Three drill holes were sunk on the map included in Figure 2-6. The drilling at all
three sites encountered the top of a mineralized basaltic lava flow at various depths below the
land surface. Find the attitude of the top of the flow assuming it is planar. The below information
is provided:

(Site A) Depth to top of flow = 550 m.
(Site B) Depth to top of flow = 650 m.
(Site C) Depth to top of flow = 300 m.

Scale: 1" = 1000 m. Contour interval: 100 m.
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Problem 6: A chevron fold has a west limb attitude of 340, 30NE and an east limb attitude of
050, 60NW. If the hinge of the fold is formed by the intersection of these two planar limbs, what
is the trend and plunge of the hinge? 
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Figure 2-6 : Map for problem 5.
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EXERCISE 2B: Orthographic apparent dip, strike & true dip, trend & plunge problems.

NOTE: for all of the below problems it is recommended that you check the results of
orthographic or cotangent methods with the following spreadsheets:
1. http://www.usouthal.edu/geography/allison/GY403/CommonPlane.xlsm
2. http://www.usouthal.edu/geography/allison/GY403/IntersectingPlanes.xlsm
3. http://www.usouthal.edu/geography/allison/GY403/ThreePoint.xlsm
4. http://www.usouthal.edu/geography/allison/GY403/ApparentDip.xlsm

Problem 1: A bed has a known strike and dip of  335E, 65ESW. Find the apparent dip and
bearing in a vertical cliff  section trending 270E.

Problem 2: The strike of a bed can be measured on the flat top of an outcrop, but the dip cannot
be determined at this location. The apparent dip of the same bed can be measured on  several
vertical faces that do not trend perpendicular to the strike of the bedding. With the information
given below, determine the complete planar attitude of the bedding in each case, (A) and (B). Do
separate page constructions for (A) and (B).

Apparent Dip Direction of Apparent Dip Strike of Bed

(A) 30E 055E 025E

(B) 25E 210E 345E

Problem 3: Find the strike and true dip of the contact between two uniformly planar beds where
two apparent dips – 034E, 20E; 334E, 54E – were obtained. Check your results using the
mathematical method discussed in your lab manual. Show the mathematical method in the lower
right corner of your construction, or as an attached  spreadsheet printout.

Problem 4: On the provided Figure 2-7 USA campus map, the top of a clay unit outcrops at the
locations indicated by points A, B, and C (in red) on the map. Calculate the strike and true dip of
the unit assuming that it is a planar structure. Construct the problem at the scale of the map (1
inch = 1000 feet). In addition to reporting the dip in degrees, also list the true dip in feet per mile
units.

Problem 5: Calculate the strike and true dip of the planar stratigraphic contact between the Mdg
and Mh (both Mississippian) formation exposed in the central portion of the Figure 2-8 geologic
map (taken from northeast corner of the Dromedary Peak Quadrangle, Utah). Use the A, B, and
C control points:

(A) contact crosses the 9400 foot contour
(B) contact crosses the 9000 foot contour
(C) contact crosses the 8400 foot contour

Use the provided scale (1 inch = 2,000 feet).
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Problem 6: A high concentration of uranium occurs at the intersection of a 040E, 60E NW fault
and a 350E, 40E NE sandstone bed. The intersection of the bed and the fault crops out in a wash
north of the True Blue Mine in western Arizona. The owners of the mine have decided to explore
the uranium play by drilling it. If they start the drill-hole at the outcrop, what should be the trend
and plunge of the drill-hole such that it follows the intersection. 
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Figure 2-7 : Topographic map of the USA campus with 3 contact points A, B, and C.
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Figure 2-8 : Geologic map of a portion of the Dromedary Quadrangle, Utah.
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EXERCISE 2C: Orthographic apparent dip, strike & true dip, trend & plunge problems.

NOTE: for all of the below problems it is recommended that you check the results of
orthographic or cotangent methods with the following spreadsheets:
1. http://www.usouthal.edu/geography/allison/GY403/CommonPlane.xlsm
2. http://www.usouthal.edu/geography/allison/GY403/IntersectingPlanes.xlsm
3. http://www.usouthal.edu/geography/allison/GY403/ThreePoint.xlsm
4. http://www.usouthal.edu/geography/allison/GY403/ApparentDip.xlsm

Problem 1: A bed has a known strike and dip of 300E, 55ENE. Find the apparent dip trend and
plunge along a vertical cliff  section trending 340E. Solve this using orthographic methods.
Assume a scale of 1 inch per unit.

Problem 2: A bedding plane has an orientation of 077E, 22.6E SE. Find the apparent dip trend
and plunge along a 220E direction. Use the cotangent method for this problem. A scale of 1 inch
per unit should be used.

Problem 3: Two apparent dips have been measured on a bedding plane contact: 1) 220, 35, and
2) 130, 40. Find the strike and dip of the bedding plane. Use the cotangent method and use a
scale of 1 inch per unit.

Problem 4: The strike of an outcropping planar dike has been estimated from aerial photography
and topographic maps to has a strike of 340E. A vertical cliff face trending 140E exposes the
contact inclined at an angle of 15E in the 140E direction. Calculate the true dip of the dike and
report the full strike & dip attitude as the answer for this problem. Assume a scale of 1 inch per
unit. Use the cotangent method for this problem.

Problem 5: Two apparent dips have been measured on the top of a tabular coal seam: 1) 030E,
10E, and 2) 300E, 25E. Find the strike and dip of the top of the coal seam. Assume a scale of 1
inch per 1 unit. Use the cotangent method for this problem.

Problem 6: Two apparent dips have been measured on a planar unconformity surface: 1) 020E,
7E, and 2) 160E, 5E respectively. Find the strike and dip of the unconformity. Because of the low
plunge angles use a scale of 1 inch = 2 units. Use the cotangent method for this problem.

Problem 7: Two apparent dips have been measured on a sandstone bed: 1) 250E, 70E, and 2)
130E, 80E. Find the strike and dip of the planar bed.  Because of the steep plunge angles use a
scale of 1 inch = 0.1 units. Use the cotangent method for this problem.

Problem 8: Using the points A, B, and C in Figure 2-9 that mark the outcrop points of a bedding
plane find the strike and dip of the bedding plane using a 3-point solution. Scale as indicated on
map.
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Figure 2-9 : Map for 3-point problem 8 in exercise 2C.
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LABORATORY 3: Basic Stereographic Projections

I. Stereographic Projections

a) Two types

1. Equal-area (also referred to as a Schmidt net)
2. Equal-angle (also referred to as a Wulff net)

b) Equal-angle stereonets are used in crystallography because the plotted angular
relationships are preserved, and can be measured directly from the stereonet plot.

c) Equal-area stereonets are used in structural geology because they present no statistical
bias when large numbers of data are plotted. On the equal-area net area is preserved so,
for example, each 2E polygon on the net has the same area.

d) In structural geology the stereonet is assumed to be a lower-hemisphere projection
since all structural elements are defined to be inclined below the horizontal. This is
unlike crystallographic projections where elements may plot on either the upper or lower
hemisphere.

II. Elements of the Stereonet

a) The outer perimeter of the stereonet is termed the primitive. The primitive is always a
perfect circle. Usually the diameter of the primitive is some convenient length, such as 10
cm.

b) The north pole of the stereonet is the upper point where all lines of longitude
converge. The south pole is the equivalent lower convergence point.

c) Lines that run from the north to south pole of the stereonet are termed great circles and
are analogous to lines of longitude on a globe. The lines of longitude can be visualized as
forming from planes that strike due north and intersect the lower hemisphere at 2E
increments. The bolder lines are 10E increments. It is possible to measure the true dip of
a plane only along the east-west line. There is one great circle that is a straight line- it
runs directly from the north to south polar position.

d) Circular arcs that run east-west are termed small circles. Small circles can be
visualized by rotating a horizontal line from, for example, N20EE azimuth around a
horizontal and due north azimuth. The path of the end point of the line would describe
the small circle that begins at N20EE and terminates at N20EW. Note that the amount of
rotation would be 180E because we only need inscribe the small circle on the lower
hemisphere. The east-west reference line of the stereonet is the only small circle that is
actually a plane. There is only one small circle that is a straight line- it runs from the due
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east to the due west position.

e) Note that since the plunge of a line is measured in a vertical plane that we can measure
the plunge of a line along the east-west or north-south reference lines.

III. Plotting Planes and Lines on the Stereonet.

a) A plane intersects the lower hemisphere as a great circle. A sheet of tracing paper
should be fixed to the center tack of the net to allow rotation. Rotate until the strike
attitude is attained and then plot the great circle that corresponds to the correct true dip
value. Remember to count the true dip angle from the primitive. Verify the plot by
rotating the north reference back to the north point on the net.

b) A vertical plane plots as a straight line diameter on the stereonet. A horizontal plane is
the primitive.

c) In many situations it is more convenient to plot the pole of a plane rather than the great
circle. The pole represents the line that is perpendicular to the plane. Since the
intersection of a line with the lower hemisphere is a point, the pole will always plot as a
point, and will always have an attitude measured as a plunge and bearing.

d) To plot the pole, find the point along the east-west line where the great circle
representation of the plane crosses. From this point count 90E toward the center- this is
the pole point. Note that the dip angle of the plane and the plunge of the pole are always
complementary angles.

e) A linear structure element will always intersect the lower hemisphere at a point, so,
like the pole to a plane, you will always plot linear data as a point.

f) To plot a linear attitude, rotate the bearing of the structure until it is parallel to either
the north-south or east-west line (it makes no difference). From the primitive, count
toward the center the number of degrees equal to the plunge. Plot the point at this
position.

g) Note that a line with a plunge of 0E will plot as two points on the primitive at each end
of the bearing line. A plunge of 90E always plots at the center of the net.

IV. Solving Problems with the Stereonet.

a) You can think of the stereonet as basically a three-dimensional protractor and, just like
a two-dimensional protractor, it is useful for determining the angular relationships
between three-dimensional lines and/or planes.

b) True and apparent dip problems that can be solved graphically or mathematically can
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also be solved on the stereonet. In fact, the stereonet is usually the tool of choice for
solving these problems because of its speed.

1. Given strike and true dip solve for apparent dip.
2. Given two apparent dips solve for strike and true dip.
3. Given strike and one apparent dip find the true dip angle.

c) The line of intersection of two planes can be found by simply plotting both planes. The
point where the two great circles intersect defines the line contained by both planes.

d) The angle between two lines can be determined by plotting both points on the
stereonet that represent the two linear elements. Rotate the paper until both points fall on
the same great circle. The great circle represents the plane that contains both lines.
Counting the number of small circle angular divisions between these two points yields
the angle between the two lines. 

e) The angle between two lines in a common plane - the rake angle is one example -  can
be determined easily with the stereonet. The angle is measured by counting the amount of
angular arc between the two points along the great circle representing the plane.

f) Example problems from Orthographic projections laboratory

Problem 1: Given strike and true dip of N50E E, 40E SE, find the apparent dip along the
bearing of S70E E.

Manual Stereonet Method:
1. Using a plotted stereonet grid with NETPROG place a tracing paper overlay on the
grid and label the cardinal directions and the center point. 
2. Plot the given strike and true dip, N50E E, 40E SE, as a great circle. 
3. With the overlay “North” mark aligned with grid north mark the apparent dip bearing 
S70E E on the primitive circle. Rotate this mark to either the east or west end of the
stereonet grid. Count from the primitive inward along the E-W line until the great circle
line is encountered. This angle is the apparent dip amount. 

NETPROG Stereonet Method:
Make sure NETPROG is installed on your computer. You can download and setup the
NETPROG program from the below web site:

http://www.usouthal.edu/geography/allison/w-netprg.htm

1. With NETPROG active go the  “Draw” > “Great Circle” menu item. In the dialog
make sure that the attitude format is “QuadPlanes” and enter the attitude “N 50 E 40 E”.
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Figure 3-1 : Example apparent dip problem
worked with NETPROG.

Select the “OK” button and NETPROG
will then draw the great circle. 

2. You wish to find the apparent dip along
the S 70 E bearing, and that is essentially
the same as “slicing” the N 50 E 40 E plane
vertically along a S70E - N70W direction
and then measuring the plunge angle of the
line produced by these intersecting planes.
Therefore, select the “Draw” > “Great
Circle” again, and then enter “N 70 W 90
E” and select “OK”. NETPROG will draw
the 2nd great circle (this great circle is
vertical so it is in fact a straight line).
3. Using the mouse right button, or the
annotation grid window, select both of the
great circles. You will see the great circles
appear in a gray color when selected.
Choose the menu sequence “Solve” >
“Intersecting planes”. In the dialog select
the “Solve” button, which will then
calculate the linear attitude of the
intersection of the selected planes (S 70.0 E
36.0). The plunge angle of this attitude is
the apparent dip (36.0). Selecting the “OK”
button will also plot a marker symbol at the intersection point. The stereonet diagram is
displayed in Figure 3-1.

Problem 2: Given two apparent dips of : 
(1) 35E, S20EW
(2) 25E, S50EE
Find the strike and true dip of the plane that contains these two apparent dips.

Manual Stereonet Method:
1. Mark the cardinal directions and the center of the stereonet on the overlay.
2. Plot both of the apparent dips as linear points on the overlay.
3. Rotate the overlay until you can find a single great circle that passes through the 2
apparent dip points. Trace the great circle on the overlay. The strike and dip of this great
circle is the answer (N89W, 36.5SW).

NETPROG Stereonet Method
1. With NETPROG active use the “Draw” > “Marker” menu to draw two markers at the
attitudes of (1) S 20 W 35, and (2) S 50 E 25 (make sure the format is “QuadLines”).
2. Select both marker points with right-clicks, and then use the menu item “Solve” >
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Figure 3-2 : Example Strike and Dip Problem
worked in NETPROG.

“Common Plane”. In the dialog
window click on the “Solve” button
to determine the attitude of the
plane that passes through the two
marker points (N89W, 36.5W). The
great circle will be drawn on the
diagram after selecting “OK”.

Figure 3-2 contains the NETPROG
solution to the above example problem.

Problem 3: Two non-parallel dikes intersect
each other at an exposure. Dike 1 is
oriented N40E, 30SE and Dike 2 is oriented
N70W, 60NE. What is the attitude of the
line formed by the intersection of these
dikes?

Manual Stereonet method

1. Plot each strike and dip as a great circle.

2. Where the great circles intersect (Figure
3-3) indicates the plunge and bearing of the intersection

NETPROG Stereonet Method

1. Plot both strike and dip attitudes using the “Draw” > “Great Circle” menu options. Note that a
“handle” cross symbol appears at the pole relative the each great circle.

2. Right-click with the mouse on both great circle “handles” to select both great circles. Both
should “highlight” in a gray color. 

3. Choose the “Solve” > “Intersecting Planes” option and click on the “Solve” button. The
bearing and plunge will appear in the edit box labeled “linear attitude”. The position of the
intersection will be plotted as a marker symbol (S 85.7 E 25.1). 
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4. Note that you can highlight the
marker and then double-left click on
the highlighted symbol to bring up a
properties window that will have
the attitude indicated.

Figure 3-3 : Example intersecting planes problem.
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EXERCISE 3A: Stereographic Projections I

When you construct your plot make sure that you use a compass to draft the perimeter of
the stereonet. Always include a tic mark with an "N" to indicate the north reference. Label all
great circles and points on the plot. Construct a "+" in the center of the stereonet where the tack
hole was located during construction of the problem.

You should use a stereonet with a radius of 3.5 inches to plot the below problems. The
windows program "NETPROG" can be used (and will be demonstrated in lab) to plot a net of
this size. You should use an equal-area projection (Schmidt).

Problem 1: A bed has an attitude of 040E, 60ESE. What is its apparent dip trend and plunge in a
vertical plane trending 090E?

Problem 2: The vertical faces of a strip mine trend 270E and 000E respectively. A coal seam has
apparent dip of 20E in the 000E wall and 40E in the 270E wall. What is the strike and true dip of
the coal seam?

Problem 3: Two dikes with orientations of:

 (1) 060E, 30ESE
 (2) 350E, 60ESW

intersect. What is the bearing and plunge of the line of intersection between these two planar
structures?

Problem 4: A thin planar bed (348E, 35ESW) intersects a vein (027E, 57ENW). If we assume that
both structures are essentially planar geometries, what is the trend and plunge of the line of
intersection of the two planes? What is the apparent dip trend and plunge of the vein and the bed
in the 270E direction?

Problem 5: A formation which strikes 050E displays an apparent dip of 35E in the 000E direction.
What is the true dip trend and plunge?

Problem 6: A planar coal seam has an attitude of 065E, 35ENW. Find the apparent dips along
vertical cuts trending:

(1) 010E
(2) 340E
(3) 270E
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Problem 7: Given two apparent dips (12E, N57EW; 11E, S20EE) for a pegmatite dike, and two
apparent dips (78E, N90EE; 13E, S32EW) for a carbonaceous schist layer, find the orientation of
both planar structures (quadrant strike and dip format). The presence of graphite in the schist
caused a reaction in the pegmatite that produced cassiterite (SnO2). Starting at the point where
the mineralized zone is exposed, along what bearing and plunge would you instruct your mining
engineer to sink a mine shaft to mine this ore?

Problem 8: A polydeformed metamorphic rock contains two different mineral lineations that lie
within the plane of S1 foliation:

Mineral lineation (1):  14E, N10EE
Mineral lineation (2): 58E, S58EE

Find the following:

(a) Attitude of the S1 foliation plane containing the two mineral lineations (quadrant
strike and dip).
(b) Rake of each lineation relative to the S1 plane.
(c) What is the angle between the two lineations as measured within the S1 plane?

Problem 9: A planar fault contact contains slickenside lineations that trend N60EW. The fault
contact has an attitude of N10EE,80ENW. Find the following:

(a) What is the bearing and plunge of the slickenside lineation?
(b) What is the rake angle of the slickenside lineation in the fault plane?
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EXERCISE 3B: Stereographic Projections I

When you construct your plot make sure that you use a compass to draft the perimeter
(primitive) of the stereonet. Always include a tic mark with an "N" to indicate the north
reference. Label all great circles and points on the plot. Construct a "+" in the center of the
stereonet where the tack hole was located during construction of the problem.

You should use a stereonet with a radius of 3.5 inches to plot the below problems. The
windows program "NETPROG.EXE" can be used (and will be demonstrated in lab) to plot a net
of this size. You should use an equal-area projection (Schmidt).

Problem 1: A bed has an attitude of 040E, 40ESE. What is the apparent dip trend and plunge in a
090E vertical plane?

Problem 2: The vertical faces of a strip mine trend 290E and 010E respectively. A coal seam has
apparent dip of 24E in the 010E wall and 46E in the 290E wall. What is the strike and dip of the
coal seam (azimuth strike and dip format)?

Problem 3: Two dikes with orientations of:

 (1) 070E, 20ESE
 (2) 340E, 70ESW

intersect. What is the trend and plunge of the line of intersection between these two planar
structures?

Problem 4: A thin, planar bed (338E, 45ESW) intersects a vein (037E, 37ESE). If we assume that
both structures are geometric planes, what is the trend and plunge of the line of intersection of
the two planes?

Problem 5: A  formation that strikes 070E displays an apparent dip of 25E in the 000E direction.
What is the trend and plunge of the true dip?

Problem 6: A planar coal seam has an attitude of 035E, 35ENW. Find the trend and plunge of
apparent dips along vertical cuts trending:

(1) 010E
(2) 340E
(3) 270E
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Problem 7: Given two apparent dips (12E, N57EW; 11E, S20EE) for a pegmatite dike, and two
apparent dips (78E, N90EE; 13E, S32EW) for a carbonaceous schist layer, find the orientation of
both planar structures. The presence of graphite in the schist caused a reaction in the pegmatite
that produced cassiterite (SnO2). Starting at the point where the mineralized zone is exposed,
along what bearing and plunge would you instruct your mining engineer to sink a mine shaft to
mine this ore? For your answer list the following:
a) Attitude of pegmatite dike (quadrant strike and dip format)
b) Attitude of schist layer (quadrant strike and dip format)
c) Attitude of mineralized zone (plunge and bearing format)

Problem 8: A polydeformed metamorphic rock contains two different mineral lineations that lie
within the plane of S1 foliation:

Mineral lineation (1): 24E, N15EE
Mineral lineation (2): 44E, S48EE

Find the following:

(a) Attitude of the S1 foliation plane containing the two mineral lineations (quad. strike
and dip).
(b) Rake of each lineation relative to the S1 plane.
(c) What is the angle between the two lineations as measured within the S1 plane?

Problem 9: A planar fault contact contains slickenside lineations that trend N50EW. The fault
contact has an attitude of N20EE,60ENW. Find the following:

(a) What is the bearing and plunge of the slickenside lineation?
(b) What is the rake angle of the slickenside lineation in the fault contact?
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Figure 3-4 : Equal-area (Schmidt) stereographic lower-hemisphere projection.
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LABORATORY 4: Rotational Problems with the Stereonet.

I. Plotting the Pole to a Plane.

a) Any planar attitude may be represented instead as the perpendicular line to the pole-
this is referred to as the pole. 

b) The pole is useful in rotation problems precisely because we can directly rotate it
about any specified rotation axis. This cannot usually be done with a plane plotted as a
great circle. Therefore, the first step of many rotational problems is to plot planar
attitudes as a pole. Since the pole represents the attitude of a line its orientation is
described by a plunge and bearing, and it plots as a point on the stereonet.

c) Steps for plotting the pole:

1. Arrange the tracing paper on the net as you would for plotting the great circle
for the planar attitude. Plot the great circle at this time for reference. Do not rotate
the tracing paper from this position yet.

2. With the tracing paper still in (1) position, count 90E along the east-west line
from the point where the plotted great circle intersects the east-west line. The
direction to count this angle should always be toward the center of the net.

3. After counting 90E plot a point at this position on the east-west line. This
represents the attitude of a line perpendicular (i.e. pole) to the plotted plane. After
some practice, you will not need the great circle reference for plotting the pole.

II. Fold Geometry Elements

a) Many type of rotation problems consist of undoing the deformational effects of
folding- i.e. "unfolding" the fold. To understand the problem you must have a clear
understanding of the terminology used to describe folds:

1. Fold Hinge: the line formed by connecting points of maximum curvature
within a specific folded surface. The hinge is a physical entity that you can
actually see and touch.

2. Fold Axis: the imaginary line that, if moved parallel to itself, could sweep out
the folded surface of a fold. Unlike the fold hinge this is an imaginary line,
however, it is always parallel to the fold hinge.

3. Axial Plane: the imaginary plane that cuts the fold symmetrically, and which
also contains the hinge lines of all affected surfaces.
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4. Fold Limb: the part of a fold contained between adjacent axial planes.
Although these elements are rarely perfect planes, we can often approximate their
geometric relationships by assuming that they are planes over short distances. 

5. Overturned Limb: an overturned limb is a limb of a fold that has been rotated
past the vertical during deformation. To put such a limb back to its unfolded
position it must sweep past the vertical.

6. Interlimb Angle: the angle between the fold limbs measured within the plane
perpendicular to the hinge line. This angle is always in the range 0 to 180E and,
therefore, can be either acute or obtuse. The interlimb angle of a fold is always
cut by the axial plane, and, in the case of a kink or chevron fold, will bisect the
interlimb angle.

7. Axial Trace: the axial trace of a fold is simply the strike of the axial plane. The
axial trace of a fold can always be measured from a geologic map if the map is
relatively flat. In that case, the axial trace is simply the line on the map that
connects points of maximum curvature between folded contacts.

III. Finding Paleocurrent Direction from Crossbed Data.

a) The trend of the true dip vector of crossbedding indicates the unidirectional 
paleocurrent trend when the bed was deposited if it is retro-deformed back to its original
position. If stratigraphy containing crossbeds has been tilted from folding or faulting one
can "undo" the deformation by rotating the primary bedding around its strike line back to
its original horizontal position. In this undeformed position the true dip vector trend of
the foreset beds is the paleocurrent direction.

b) Note that a simple one-step rotation to "undo" deformation is only applicable if the
kinematic model for deformation indicated that the tilting of strata was done by rotation
about a horizontal axis. It is appropriate to unfold the limb of a fold in this manner only if
the plunge of the hinge is 0E.

c) Steps for finding the paleocurrent direction:

1. Plot primary (topset / bottomset) bedding as a great circle on the net. Plot the
crossbed (foreset) attitude as a pole since it is this entity that we wish to track
through a rotation.

2. Move the strike line of primary bedding great circle to the N-S position and
visually imagine the rotation necessary about the horizontal N-S axis to move this
plane to the horizontal. This angle is always equal  to the true dip angle of
primary bedding. It is helpful to pick one end of the strike line as the rotation axis
and mark it with a “dot” and label it as “R”. Carefully note the sense of rotation as
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looking in the trend direction of “R”.

3. Move the pole to crossbedding along whatever small circle that it falls upon,
the same number of degrees and in the same rotational sense as in step 2. At this
position, the pole represents the attitude of the pole to crossbedding before
deformation.

4. The paleocurrent direction is the bearing of the true dip of the plane
represented by the new pole position. This bearing is always 180E to the bearing
of the rotated pole position. It may be helpful to visualize this by plotting the
plane perpendicular to the rotated pole position. The true dip line in this plane is
the paleocurrent direction.

5. If, during rotation of the pole, the primitive is encountered remember that the
pole reflects to the diametrically opposed position on the net and continues to
move in the same sense to accommodate the rest of the rotation

d) Example 1A: Paleocurrent direction from primary and crossbed attitudes.

1. Given primary bedding of N-S, 35E, find the paleocurrent directions from
crossbed attitudes (1) N69E, 44 SE and (2) N28E, 80NW.

Note: the pole to N69E,44SE is N21W (339), 46, and the pole to N28E,80NW is
S62E (118), 10. Because you are rotating the pole instead of the great circle, it
saves time to make the mental conversion and just plot the pole. The below rules
accomplish the task:

1. The bearing quadrant of the pole is always the opposed quadrant (180
degrees) from the dip quadrant. The quadrant bearing angle is the
complimentary angle to the strike quadrant angle.

2. The plunge angle is always the complimentary angle of the true dip
angle.

Manual Solution Steps

1. In crossbedding paleocurrent problems the primary bedding attitude should be plotted
as a great circle and the crossbedding attitude should be plotted as a pole. Do this as a
first step labeling the pole to the crossbedding as “P”. 
2. The rotation needed to retro-deform the bedding back to its original horizontal attitude
occurs about the strike of the primary bedding, and equals the true dip angle. 
3. To find the retro-deformed position of the pole (P’) move the strike line of the primary
bedding great circle to the north position. Imagine the sense of the rotation needed to
rotate the primary bedding to the horizontal. Find the small circle that P falls upon. Move
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Rotations: Example 1A

Answers:

Paleocurrent 1: S17.8W,42.9

Paleocurrent 2: S60.2E,69.0

Figure 4-1 : Example 1A crossbedding paleocurrent
problem.

it in the same sense and angular amount (true dip angle) along the small circle. This is the
P’ position. Note that during the rotation if the small circle path encounters the primitive
you must continue on the diametrically opposed small circle.
4. To determine the depositional attitude of the crossbedding convert the P’ pole to its
strike and dip equivalent. The paleocurrent direction is in the true dip bearing of this
planar attitude. 

NETPROG Solution Steps

1. Plot the primary bedding as a great circle, and the two crossbeds as poles “P1" and
“P2" respectively. An easy way to plot the poles from the given strike and dip is to use
the “Draw” > “Great Circle” menu dialog and manually type in the strike and dip to
construct the planar great
circle. In addition to the
great circle arc NETPROG
also draws the selection
handle “blip” at the pole to
the plane. Use the “Edit” >
“Selection Mode” menu
dialog to turn on object
snap. Any left-click near the
pole “blip” will snap to the
exact pole point to set the
draw anchor. Use the
“Draw” > “Marker” dialog
with the default anchor to
plot the pole “P1". Use the
same method to plot “P2".
2. Draw the rotation axis
with “Draw” > “Marker”
and manually type in the
attitude as “N 0 E 0". Set the
label to “R”.  You can now
use the “Solve” > “Project
by Rotation” to construct the
retro-deformed position of
the two poles. Pre-select the
anchor points with object
snap on by left-clicking on
or near the “R” point, and
then the “P1". Then use the “Solve” > “Project by Rotation” with the rotation angle of
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+35 (i.e. true
dip). This new
point should be
labeled “P1'”.
Use the same
methods to
construct “P2'”.
Snap to “P1'”
and then use
“Draw” >
“Great Circle”
to draw the
depositional
attitude of the
(1) crossbed
(red). Use the
same method for
crossbed (2)
(green). The
rotated positions are:

P1' =N17.8E (17.8),47.1
P2' = N60.3W (299.7), 20.9

3. Use the “Draw” > “General Arc” to construct the rotation path of each pole. For the (1)
crossbed the axis attitude, start attitude, and rotation angle  should be the “R” point, “P1"
point, and
+35 degrees
respectively.
For crossbed
(2) use axis
point “A”,
start attitude
point “P2",
and a rotation
angle of +35
degrees.
4. Note that
the
paleocurrent
directions are
the two
crossbed
retro-
deformed
true dip

Figure 4-2 : Crossbed example 1A 1st crossbed  rotation with Excel
“rotation.xlsm”.

Figure 4-3 : Crossbed 1A example 2nd crossbed rotation problem with
Excel “rotation.xlsm”.
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bearings:
(1) S 17.8 W (197.8)
(2) S 60.2 E (119.8)

Note that the stereographic grid is displayed in Figure 4-1 to show that the rotation path
tracks along a small circle on the grid because the rotation axis is horizontal and is
trending due north. In general this will not be the case as demonstrated in the following
1B example

Spreadsheet Solution 

For the spreadsheet solution the rotation axis = 000, 0; amount sense of rotation is +35E
(counterclockwise). The pole to (1) crossbed = 339, 46; (2) crossbed = 118, 10. 

The rotated pole for crossbed (1) = 017.8E, 47.1E, therefore the down-dip paleocurrent direction
is 197.8E(S17.8E W). The rotated pole for crossbed (2) = 299.7E, 20.9E, therefore the down-dip
paleocurrent direction is 119.7E(S60.3E E). See Figures 4-2 and Figure 4-4.

 e) Example 1B: Paleocurrent from primary and crossbed attitude.

1. Given primary bedding of 310, 58 SE, find the paleocurrent directions and the
original depositional orientation from crossbed attitudes (1) 300, 66 NE and (2)
078, 60 SE.

2. Using rules discussed earlier the P1 and P2 poles to crossbeds 1 and 2 plot as:
(1) 210, 24
(2) 348, 30

NETPROG Solution Steps (Figure 4-3):

1. Plot primary bedding as a great circle, and the poles to both crossbeds as P1 and P2 at
210, 24 and 348, 30 respectively.
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2. Plot a marker
point “R” at the
north end of the
strike of bedding at
attitude = 310, 0.
Note that if viewed
from the center of
the lower hemisphere
toward “R”, to
remove the dip on
primary bedding the
amount and sense of
rotation would be 58
degrees
counterclockwise.
Counterclockwise
rotation angles in
NETPROG are input
as positive values
(i.e. +58 degrees).

3. Rotate both P1
and P2 in separate
steps, each time
selecting “R” first
with a right-click,
and then either P1 or
P2. Leave the “plot rotation path” checkbox as “checked” to plot the small circle trace of
the rotation. Label the rotated poles as “P1'” and “P2'” respectively.

4. With the rotated poles snap with object snap to P1' and P2' and then draw the
perpendicular great circle to each pole in red. If you highlight either of the red great
circles and then double left-click the popup window will indicate the original deposition
attitude of the crossbed. The paleocurrent is indicated by the true dip trend.

Crossbed 1 original attitude: 079.7, 11.9 NW; paleocurrent = 349.7
Crossbed 2 original attitude: 086.0, 79.2 NW; paleocurrent = 356.0

IV. Unfolding a plunging fold to find the original attitude of a lineation.

a) These types of problems always involve the determination of the bearing of a lineation
before it’s original depositional attitude was changed by a later phase of folding. The
solution involves unfolding the fold limbs about the hinge line of the fold until both
limbs are coplanar. Then, as a last step, the unfolded plane is brought to the horizontal by

N

P1

P2

Rotation Example 1B
Xbed1 depo. attitude: 079.7, 11.9 W

Xbed2 depo. attitude: 086, 79.2 W

R

Primary Bedding

310, 58 NE

P1'

P2'

Xbed1 paleocurrent: 349.7

Xbed2 paleocurrent: 356

Figure 4-4 : Example 1B crossbed rotation problem.
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rotating about the strike line of the unfolded plane until the dip is removed. If the
lineation is a primary sedimentary feature, it will then be in it’s original attitude. As the
limb attitudes are rotated, any lineation that is contained in a limb is moved with the
limb, the angle that it makes with the hinge always being preserved.

b) At this point it helps to visualize the elements of the problem. If two limb attitudes are
plotted, they intersect at the hinge of the fold. Move the hinge line to the E-W line of the
net. If both limbs could be rotated such that they merged with the great circle that runs
through the hinge point, you would have "unfolded" the fold- this is the “unfolded
plane”. If one of the limbs sweeps past the vertical during the unfolding rotation,  it must
be an overturned limb. The axial plane is simply the great circle plane that contains the
hinge point and the axial trace point. The axial trace is the strike of the axial plane so it
always plots on the primitive (i.e. the plunge of the axial trace line is 0). It is helpful to
plot the axial plane great circle when visualizing the unfolding process because each limb
must move away from the axial plane as it rotates towards the unfolded plane. The
interlimb angle can be visualized as the angle that would form when both limb great
circles intersect the fold profile plane (i.e. the plane perpendicular to the hinge). The axial
plane great circle always bisects the interlimb angle measured along the fold profile.

c) Steps of the problem:

1. Plot one or both limbs and the hinge of the fold, depending on the specific
problem. You must know the hinge attitude before continuing.

2. Plot the lineation that will be rotated as a point. The lineation will always fall
on one of the limb great circles. The limbs, by definition, will intersect at the
hinge point of the fold.

3. Move the tracing paper so that the limb containing the lineation falls on a great
circle. Measure the angle between the lineation and the hinge line of the fold. This
angle must be preserved through any subsequent rotation steps.

4. Now move the hinge line to the E-W line. Imagine how the limb containing the
lineation moves to the "unfolded" position- the great circle on the stereonet grid
that passes through the hinge point. Trace this great circle and label it as the
“unfolded” plane. Plot the rotated position of the lineation by using the angle
between the hinge line and lineation measured in step (3) above. Plot the new
position of the unfolded sole mark by measuring the same angle from the hinge
point along the unfolded plane. Note that there are always two possible directions
to measure the angle from the hinge so you must be sure you have correctly
visualized where the sole mark moves during the unfolding process.

5. If the lineation is a primary sedimentary structure it must be rotated to the
horizontal. Move the great circle representing the unfolded fold to the primitive
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through its true dip angle and rotating around the strike line of the unfolded plane.
The lineation will track along a small circle until it encounters the primitive. The
bearing of the lineation at this position is the answer. If this is a sole mark
remember that the reverse bearing is also a possible paleocurrent direction. If the
primary sedimentary lineation is a ripple mark crest the paleocurrent direction is
bi-directional and perpendicular to the trend of ripple mark.

6. If you are given an axial trace attitude you can determine the axial plane
attitude by finding the great circle that passes through the hinge and axial trace
points.

7. If you are asked to determine the interlimb angle you must plot the fold profile
plane great circle. This is always the great circle that is perpendicular to the hinge
of the fold. The correct interlimb angle will be the angular arc measured along the
fold profile plane between the limbs that is bisected by the axial plane.  

d) Example problem- given two limb attitudes (1) N72W, 40NE and (2) N70E, 80NW,
the axial trace (N80E) of the fold from a geologic map, and a sole mark  that trends N0E
on the overturned limb,  find:

1. The hinge attitude. (30, N64E)

2. The original bearing of sole marks. The sole marks currently trend along a
bearing of N0E in the overturned limb. (S60E-N60W)

3. The attitude of the axial plane. (N80E, 65NW)

4. The interlimb angle of the fold. (51)

Remember that a sole mark is a primary sedimentary structure that has a linear geometry,
therefore, it should have an original plunge angle of 0 and its bearing should be parallel
to the paleocurrent direction.

Manual Stereonet Solution
1. Plot the 2 limb attitudes as great circles. The intersection of the great circles is the
hinge of the fold. (N64E, 30)
2. Draw the axial trace as a marker labeled “AT”. Rotate the overlay so that this point
and the hinge point can be aligned along a unique great circle  to construct the axial plane
(N80E, 65NW).
3. The sole mark is on the overturned limb so you must identify which of the limbs is
overturned. Rotate the hinge to the East-West line of the stereonet. Whatever great circle
the hinge falls on is the “unfolded” plane. Trace this great circle on the overlay. 
4. Now imagine the path that each limb would follow as they are rotated around the hinge
point to merge with the unfolded plane. Remember that the limbs cannot pass through
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each other, and that they must each move away from the axial plane and toward the
unfolded plane. The limb that must pass through the vertical (center of the stereonet)
must be the overturned limb. The point on this limb that trends N0E is the present
attitude of the sole mark. Measure the angular arc between this sole mark and the hinge
point in the overturned limb.
5. Align the unfolded plane with its matching great circle on the stereonet grid. Imagine
the path that the sole mark would travel along if the overturned limb merged with the
unfolded plane. Using the angle measured between the sole mark and hinge in (3),
measure this same angle from the hinge along the unfolded plane in the direction
indicated by the unfolded path. This is the new position of the sole mark.
6. The unfolded plane must now be rotated to the horizontal. Move the strike line of the
unfolded plane to the stereonet grid north. Trace the small circle path of the sole mark to
the primitive. This is the depositional attitude of the sole mark (S61E and N61W).

7. To solve for the interlimb angle you need to draw the great circle 90 degrees to the hinge-
known as the fold profile plane. Note the position of the points on this plane created by the
intersection of the two limbs. The interlimb angle is the arc of the great circle bisected by the
axial plane (51).

NETPROG Stereonet Solution
1. Use the “Draw” > “Great Circle” to draw the 2 limbs as great circles. Select both limbs
and use the “Solve” > “Intersecting Planes” to calculate the hinge attitude. This point is
labeled as “Hinge” in Figure 4-4.
2. Next plot the “unfolded plane” that results from rotating both limbs into a single plane.
This plane will have the hinge point as the down-dip linear vector. Highlight the “Hinge”
point with a right-click, and then double-click on the highlighted point to determine the
attitude of the hinge point (N 64.1 E 30.2). The strike of the unfolded plane will be the
north quadrant bearing 90 degrees to this bearing (N 25.9 W). The true dip is the same as
the plunge (30.2 E). Use the “Draw” > “Great Circle” menu to plot the unfolded plane
attitude of N 25.9 E 30.2 E and label the unfolded plane (see Figure 4-4).
3. At this point plot the axial plane to help decide if a limb is overturned. The axial plane

must pass through the hinge and axial trace points. Use the “Draw” > “Marker” menu selection
to draw the axial trace point at N 80 E 0 and label it as “AT”. Use 2 right-clicks to select the
hinge and axial trace points (“Hinge” and “AT”), and then use “Solve” > “Common plane” to
plot the Axial Plane great circle (see Figure 4-4). Label the axial plane great circle as “Axial
Plane”.

4. Observe the diagram. Note that during the “unfolding” of the two limbs they both must
rotate around the hinge point and move away from the axial plane until “merging” with the
unfolded plane. The overturned limb is the limb that passes through the vertical (i.e. center of
stereonet) during this process. Label the limbs as “Limb1" and “Limb 2" with a following “(O)”
on the overturned limb (Limb 2). The sole mark trends N0E in the overturned limb, therefore, the
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Figure 4-5 : Example unfolding fold problem.

most exact way to fix this point is to draw a
vertical great circle with attitude of N 0 E
90 E, and
then intersect this great circle with the
overturned limb great circle using the
“Solve” > “Intersecting Planes” menu item.
Erase the vertical plane after solving, and
label the sole mark position as “S”.

5. With two right-clicks select the
“S” and “Hinge” points and then use the
“Solve” > “Angle between Points” option
to determine the angle between the hinge
and sole mark lineation (55.7 ).  This angle
is maintained during the unfolding rotation,
therefore, the position of the sole mark will
be at the location measured from the hinge
point along the unfolded plane at this same
angular distance (55.7). The direction from
the hinge is deduced by imagining the path
that “S” would move along as the
overturned limb is unfolded. You should be
able to verify that the unfolded position of
the sole mark (S’) will be in the southeast quadrant of the stereonet on the unfolded plane. To
plot the S’ position use two right-clicks to select the unfolded plane and then the hinge point.
Use the “Solve” > “Project by Angle in Plane” option to project the S’ point at a specific angle
from the hinge in the unfolded plane. The angle should be -55.7 because the S’ point is
clockwise from the hinge point in the unfolded plane. Select the new marker and double left-
click to add the label “S’”. 

6. A small circle arc can be constructed to display the path of “S” as it is rotated to “S’”
as the fold is unfolded.  This path is a small circle arc with an axis at the hinge, start point at “S”,
and ending point at “S’”. Turn on the object snap mode via the “Edit” > “Selection Mode”
dialog. When the object snap mode is on a left click will set a “blip” (small black cross) at the
mouse pointer position, but if the left-click is within a certain threshold distance to an existing
annotation geometry a larger red cross will appear on this object. The coordinates used for the
anchors, and therefore in later draw operations, will be set by the red cross position. In this way
you can snap exactly to previously drawn annotation elements. In sequence left-click on or close
to the hinge, “S”, and “S’” points to set three anchor positions. Select the “Draw” > “Small
Circle Arc” menu item. The dialog will automatically use the hinge, “S”, and “S’” positions as
the axis, start, and end points of a small circle arc. The resulting small circle arc should connect
the “S” to “S’” points.

7. To finish retro-deforming the sole mark to its depositional attitude the dip must be
removed from the unfolded plane by rotating around the strike of the plane. Therefore the axis
would be N 25.9 W 0,  with a rotation of +30.2. Use the “Solve” > “Project by Rotation” to
construct the “S’‘” point, and “Draw” > “Small Circle Arc” to construct the 2nd-step rotation
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path. See Figure 4-4 for the results (S’‘ paleocurrent = S 60.9 E 0.0 or N 60.9 W 0.0).
8. To determine the interlimb angle you must draw the plane perpendicular to the hinge

(Fold Profile). Do this by snapping to the hinge point and then selecting “Draw” > “Great
Circle”. Label the fold profile plane, then select the fold profile and limb 1 planes and then draw
the intersection point with “Solve” > “Intersecting Planes”. Do the same for Limb 2 and the fold
profile. The angle between these two points is the interlimb angle (50.8).

V. Rotational fault problems.

a) A rotational fault has displacement that is characterized by motion of one fault block
relative to another about a rotational axis perpendicular to the fault surface. Usually the
problem will ask you to predict the attitude of a planar structure, such as bedding, after
some amount of rotation within one block.

b) The rotational axis must always be perpendicular to the fault surface, therefore, if you
are given the attitude of the fault you can then plot the rotational axis as the pole to the
fault.

c) Since you are to rotate a planar structure in one of the fault blocks, you must plot this
structure as a pole.

d) Before actually plotting the solution on the net, make sure that you are clear about the
sense of the rotation. Usually the problem specifies a specific orientation in which to
visualize the rotations, such as "... as viewed from the southeast looking northwest the
motion of the southeast fault block is clockwise".

e) Problem solution steps:

1. Plot fault surface as a great circle. Plot rotational axis as pole to the fault
surface. Label rotational axis point with an "R" for reference.

2. Plot the pole to bedding. Label this as point "P".

3. Plot the great circle that contains both "R" and "P", but only between the points
"R" and where the great circle intersects the fault. Label the intersection point
with the fault as point "L".

4. While visualizing the sense of rotation, move point "L" along the fault surface
the amount of the rotation. Label this new point as point "L prime". 

5. Plot the great circle that contains both "R" and "L prime". While maintaining
the original angle between "R" and "P", plot the "P prime" position along the
great circle containing "R" and "L prime". Be careful when plotting this position
since it is always possible to count the angle from "R" in two directions- only one
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position will be correct.

6. The "P prime" position represents the rotated position of the pole to the planar
structure. The answer is the attitude of the plane represented by "P prime".

f) Example problem: given a planar fault N30E, 60SE; bedding within the northwest fault
block N90E, 40S (pole = N0E, 50); and that the southeast block has been rotated 120
degrees anticlockwise as viewed in the bearing direction of the rotational axis, find the
rotated attitude of bedding in the southeast block.

Manual Solution Method

1. Plot the planar fault attitude as a great circle. Label the great circle with “Fault”. Plot
the pole to this plane and label it as “R” for the rotation axis.

2. Plot the pole to the bedding as a “P” point. Plot the great circle arc that extends from
“R” to “P” to the fault plane great circle. Where the arc intersects the fault label the point
as “L”. Measure the angle between “R” and “P” in the arc and label that portion of the
arc with the angle value.

3. During rotation of the fault the angular relationship between “R” and “P” and “L”
remains constant. Although you can’t directly trace the path of “P” during rotation
because of the plunge of the rotation axis, you can track the rotation of “L” because it is
perpendicular to “R” and travels along the fault plane great circle during rotation. If you
can determine where the new position of “L” is located after rotation, you can also find
the new position of “P”.

4. Visualize the rotation of “L” around the “R” rotation axis. Mark off the rotation angle
from “L” to “L’” being careful to take into account the sense of rotation. To measure the
angle between “L” and “L’” you need to have the fault plane aligned with a great circle
on the stereonet. Use the crossing small circle grid lines to mark of the degrees.

5. When “L’” is determined, trace the full great circle that passes through “L’” and “R”.
This is the plane that contains “R” and “L’” after rotation, therefore, “P’” must lie in this
plane at the same angle from “R” that was measured in step (2). Unfortunately there are
always two possible directions to measure and plot “P’” relative to “R”.

6. To determine the correct “P’” position from the two possibilities, carefully visualize
the path of “P” as it rotates around “R” and moves to “P’”. Remember that if the path
encounters the primitive the path will “reflect” to the diametrically opposed position on
the stereonet.

7. Once the correct position of the “P’” rotated pole is determined (see Figure 4-5), the
new pole should be converted to a strike and dip for the answer (N 40 E 72 W).
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NETPROG Solution Method 

1. Plot the fault surface (N30E, 60SE) as a great circle with the “Draw” > “Great Circle”
menu command. The rotational axis is the pole to this plane, so turn on the object snap
mode, and left-click near the pole blip mark to snap to the pole attitude. Use the “Draw”
> “Marker” to draw a marker at this position. Label this rotational axis marker “R”.

2. To plot the pole to the bedding, first plot the bedding great circle (N90E, 40E), turn on
the snap mode, and then snap to the pole position and use “Draw” > “Marker” to plot the
pole. Label the pole marker  “P”.

3. Select the “P” and “R” marker points with right-clicks, and then use the “Solve” >
“Common Plane” to construct the great circle plane that contains those two points.
Leaving those two points selected, use “Solve” > “Angle between lines” to calculate the
angle between “R” and “P”. Label the arc of the great circle between “R” and “P” with
this angle (48.6). Unselect the “P” and “R” points.

4. Select the fault plane and the plane constructed in (3) by right-clicking on the pole
handles (small crosses). Use “Solve” > “Intersecting Planes” to construct the marker
point at the intersection of these two great circles. Select and edit this new marker and
label it “L” (see Figure 4-5).

5. Select the great circle that passes through “R”, “P”, and “L”. Use the “Edit” > “Delete
Selected” in the Annotation child window to delete the great circle. You want to show
just the great circle arc that passes through “R”, “P”, and “L”, so turn on the object snap
and left-click close to “L” and then “R”. Use the “Draw” > “Great Circle Arc” to
construct the arc. The default attitudes will work if the snap to “L” and “R” work
correctly.

6. You now need to visualize the 120 degree rotation of “L” around “R”. Remember that
as viewed down-plunge of the “R” axis, a positive rotation is counterclockwise as
specified by the problem. During rotation the “L” point would therefore move northeast
along the fault plane great circle until it encounters the primitive, at which point it would
jump to the diametrically opposed end of the great circle and continue northeast to point
“L’” in Figure 4-5 for the full 120 degrees. Select in order with right-clicks the “R” and
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Rotational Fault Example
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Figure 4-6 : Rotational fault example.

“L” marker points. Use the
“Solve” > “Project by
Rotation” menu item. The
rotation axis should by set to
the “R” attitude, and the
start point should be the “L”
attitude. Type in “120" for
the rotation amount. This
will construct the “L’”
marker point. Edit and label
it “L’”.

7. The correct position for
“P’”, the rotated pole to
bedding, lies 48.6 degrees
from “R” on the great circle
that passes through “L’” and
“R”. Select these two points
with right-clicks and then
use “Solve” > “Common
Plane” to construct this great
circle. 

8. You now
need to
visualize the
rotation of
“P” around
“R” to the
new “P’”
position.
Note that are
two
directions
along which
you can mark
off 48.6
degrees from
“R” along the
“R” - “L’”
great circle.
Convince
yourself why “P’” in Figure 4-5 is correct. This point can be constructed by projecting
from “R” along the “R” - “L’” plane by -48.6 (clockwise) rotation angle. Select the “R”-

Figure 4-7 : Example rotational fault problem solution using
“rotation.xlsm”.
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“L’” great circle, and then “R” with right-clicks, and then use “Solve” > “Project by
Angle” to construct “P’”. Edit and label the new marker point “P’”. This is the rotated
bedding pole- convert this to a strike and dip for the answer (N 39.5 E 72.3 W).

9. To prove that you solved the problem correctly, and to show the rotation path of “P” as
it moves to “P’” you can use “R” and “P” as the axis and start point of a small circle arc.
Turn on object snap and left-click near “R” and then near “P”. Use “Draw” > “General
Arc” to open the dialog window. The axis and start point should be pre-filled with the
“R” and “P” attitudes. Type in 120 for the rotation angle. The small circle arc should start
at “P” and extend to “P’” as in Figure 4-5.

Spreadsheet Solution: the “Rotation.xlsm” spreadsheet can be utilized to solve the
rotational fault problem. Figure 4-6 Contains the solution that corresponds to the above
example problem.

Alternative Manual Solution Method: this method requires more steps but allows you to
use the small circles on the stereonet to trace the movement of the pole in each step. This
leaves less room for error relative to “seeing” the sense of rotation in 3D. However, you
are more likely to have an error because you forget one of the “steps” in the multi-step
process.

1. Plot the fault attitude as a great
circle. Label the great circle with “Fault”.
Plot the pole to this plane and label it as
“R” for the rotation axis. Plot the pole to

the bedding as a “P” point.

2. Note that the small circles on the
stereonet are produced by rotating
lines about a horizontal N-S axis.
To use these small circles to track
the rotation you need to remove the
plunge from the rotation axis “R”.
Move R to the east-west line of the
stereonet and trace the shortest path
along the line to the primitive.
Count the angle (i.e. it is always the
plunge of R), and label the new
point on the primitive as R’. Move
P along whatever small circle it
falls on the same amount and sense
of the angle. Label this new point
P’. See the paths R-R’ and P-P’ in
Figure 4-7.

Figure 4-8 : Alternative manual rotational fault
example.
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Figure 4-9 : Example Drill Core problem.

3. Move R’ to the North position of the stereonet. Rotate P’ around R’ by 120 degrees
anticlockwise as described in the problem. P’ will track along a stereonet small circle to
P’‘. If the rotation path encounters the primitive remember to project through the center
of the stereonet to the diametrically opposed small circle and continue. Always trace the
rotation path so you can check the results later. (See the path P’ to P’‘ in Figure 4-7).

4. Now you must add the original plunge back to R’ and  move P’‘ accordingly. Move R’
back to the East point of the stereonet and find the small circle P’‘ falls upon. Imagine the
sense of rotation needed to move R’ back to the original R position. Move P’‘ in the same
angular sense and magnitude along a small circle to P’‘’. This is the rotated position of
the pole to bedding. Convert this to a strike and dip for the answer (N39.5E, 72.2W).  

VI. Drill Core Rotational Problems

a) Drill cores are rarely if ever perfectly vertical, therefore, if an oriented core is taken (as
is usually the case) an index mark will record the plunge and bearing of the core. If the
trace of planar bedding is visible in the core, the “apparent” strike and true dip could
theoretically  be measured by standing the core up vertically, rotating the index mark
toward the bearing of the core, and measuring the apparent bedding orientation with a
pocket transit. Unfortunately, an actual drill core is usually much to long and heavy to
stand up and rotate. Therefore, what is usually done is the angle that the apparent strike
makes with the bearing mark (φ in Figure 4-8) of the core is measured, and the
inclination that the apparent
bedding plane makes with the
core axis is measured (μ in
Figure 4-8).  These angles are
then used to calculate a
“relative” strike and dip. For
the Figure 4-8 example the
relative apparent strike and dip
would be reported as N20E,
70SE because φ was measured
20 degrees clockwise from the
line AB (bearing trace of index
mark), and the 20 degree μ
angle was measured from the
dipping plane toward the
vertical axis of the core, an
angular direction that is
clockwise as viewed toward
the B end of the index line.
Note that positive μ angles
always plot on the “right-
hand” side of D’E’, so the
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Drill Hole Rotation Example Problem
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Figure 4-10 : Example drill core problem
stereonet.

relative inclination is 90-μ = 70SE.  If the μ angle had been -20 the dip direction would have
been 70NW. When the elements of the problem are plotted on the stereonet the apparent strike
and dip are plotted by first plotting the vertical plane that contains the actual plunge and bearing
of the core axis. Because the example core axis bearing is 40, 220, this vertical plane is 040, 90.
This plane should then be rotated to the North position, and then the “N20E, 70SE” great circle
should be plotted relative to this mark, and then labeled D’E’ on the stereonet. Note that the E’
end of the D’E’ line is the north quadrant end.  

The apparent strike and dip should then be
plotted as a pole (P). The plunge and bearing of the
drill core is then plotted as a lineation point (DC’),
and this point is rotated from the vertical about a
horizontal rotation axis oriented perpendicular to
the core bearing by an amount necessary to move
the drill core point to the actual core attitude (DC’)
. The pole to the apparent strike and dip plane is
rotated in the same manner to the pole to the true
strike and dip (P’). The attitude of bedding is

extracted from the rotated pole. 

B) Example Problem: Given a drill core
with orientation marks indicating a drilling
attitude of 40, 220, and φ=+20 (clockwise
or NE quadrant) and μ=+20 (right-hand
side or SE dip quadrant), find the actual
“real-world” attitude of the bedding in the
core.

Stereonet Solution (Figure 4-8 and 4-9):

Step 1: Plot the core axis attitude used to measure the apparent strike and dip as point DC
(vertical) and the actual attitude of the core (40, 220) as point DC’. Plot the vertical plane
that contains the core axis and label the ends as AB as in Figure 4-9. Rotate the AB
plane to the North reference, and then draw in the great circle that would be N20E, 70SE
“relative” to AB. This plane is N60E, 70SE in real-world orientation. Label the ends of
this great circle as D’E’ as in Figure 4-9, and the interior of the great circle as “Apparent
Bedding”. Plot the pole to this attitude as point “P”. 

Step 2: Determine the orientation of the rotation axis that is the horizontal line
perpendicular to the bearing of the core axis. In this example this is azimuth is 220+90 =
310 (but it could also be 130) and is labeled “R”. 

Step 3: Visualize the rotation of point DC to DC’ about the point R rotation axis. The
amount of rotation is 50 degrees (i.e. 90-plunge), and the sense of rotation as viewed
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from the center of the stereonet toward point R is clockwise. Note that if the rotation axis
had been 0, 130 the sense of rotation would have been counterclockwise instead. Move
point “R” to the North point and mark off the small circle arc starting at P and moving
clockwise 50 degrees about “R”. At the end of the arc plot point P’ (Figure 4-9). As a
check use the same method to trace the small circle arc starting at DC and moving
clockwise. The end of this arc should correspond to the location of DC’ (i.e. the given
attitude of the core axis 40,220.

Step 4: Plot the great circle 90 degrees from the P’ point and then measure the strike and
dip of this great circle. This is the actual “Real-World” attitude true strike and dip (N36E,
62SE) of the bedding in the core.
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EXERCISE 4A: Rotations with the Stereonet

This laboratory exercise will test your knowledge of rotation operations with the equal-
area stereonet. Use a 3.5 inch radius equal area stereonet to solve the below problems.

Problem 1: Given a mineral lineation  attitude of 030, 60, and a rotational axis attitude of 000, 0, 
find the new attitude of the mineral lineation after rotations of: 90, 180, 270, 360 degrees. Label
the original and rotated attitudes as  L1(90), L1(180), L1(270), and L1(360) respectively. Label
the rotation axis “R1". As part of the answer list the linear attitudes for L1(90), L1(180), and
L1(270). Also list the angle measured  between  R1 and L1(0). Draw in the small circle that
passes through all of the L1 points.

Also plot a mineral lineation attitude at 160, 33, and label it “L2(0)”. Plot a marker at
056,21, and label this rotation axis as “R2". Rotate L2 around R2 for the following angular
amounts: -45, -90, -120. Label these new linear attitudes L2(-45), L2(-90) and L2(-120)
respectively. List the attitudes of  L2(-45), L2(-90) and L2(-120) as part of your answer. Also
calculate the angle between R2 and L2(0). Draw in the “small circle” that passes through all of
the L2 points.

Problem 2. A planar limb of a fold (053E, 50ESE) contains a crossbed with orientation 022E,
72ENW. Assuming that the plunge of the fold hinge is 0E, find the original orientation of the
crossbed, and the trend of the paleocurrent.

Problem 3. Given the axis of a rotational fault (42E, S48EE),  bedding orientation (N37EW,
66ESW) in the undeformed southeast fault block, and that the northwest fault block was rotated
70E clockwise  (as viewed down-plunge)  about the fault rotational axis, find the rotated attitude
of bedding in the northwest fault block.

Problem 4. Given two planar limbs of a syncline (N8EE, 56ESE and N32EW, 80ENE), find the
orientation of the fold axis. If there is presently a N90EE bearing ripple-mark lineation on the
overturned limb, find the original bearing of this lineation, assuming that it was originally
horizontal. How many degrees must the overturned limb be rotated about the fold axis to
"unfold" this fold?

Problem 5. The planar limbs of an upright chevron fold (axial plane dip > 45E) have the
following attitude:

1. 023E, 57ESE
2. 348E, 71ESW

With this data, and assuming that the axial plane bisects the interlimb angle, find:

(a) Plunge and bearing of the fold hinge.
(b) Interlimb angle of the fold.
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(c) Axial plane attitude of the fold.

Problem 6. An inclined drill core has an orientation mark indicating a plunge and azimuth for the
drill core axis of 62, 210.  The angles φ=-30 and μ=+30 (remember positive angles are
clockwise; refer to the Figure 4-5 diagram) were measured by the drilling engineer. Find the
real-world strike and dip attitude of the vein.
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EXERCISE 4B: Rotations with the Stereonet

This laboratory exercise will test your knowledge of rotation operations with the equal-
area stereonet. Use a 3.5 inch radius equal area stereonet to solve the below problems.

Problem 1. The limb of a fold (053, 50SE) contains a crossbed with orientation of 022, 72NW.
Find (a) the original attitude of the crossbed, and (b) the paleocurrent direction bearing.

Problem 2. Given the axis of a rotational fault (132, 42), and that the SE fault block originally
containing bedding (323, 66SW) has rotated about the rotational axis 70 degrees
counterclockwise as viewed down-plunge of the rotational axis, find the new attitude of bedding
(azimuth strike and dip format).

Problem 3. Given two limbs on a syncline (008, 56SE and 328, 80NE), find (a) the orientation of
the fold hinge. If there is an east trending ripple mark lineation on the overturned limb, find (b)
the original depositional trend of this primary lineation. How many degrees (c) was the
overturned limb rotated about the hinge line to “unfold” the fold?

Problem 4. Given a fault (N90E, 90) and the attitude of bedding in the south fault block of
N49E,42SE, find the attitude of the same bedding in the north block if it has been rotated 150
degrees counterclockwise relative to the south block as viewed toward the north block.

Problem 5. A fold has an axial trace of N44W and a hinge attitude of N30E, 56. What is (a) the 
axial plane strike and dip (quadrant strike and dip format)? Assuming that the fold is
symmetrical and that the interlimb angle is 26 degrees, find (b) the attitude of the two limbs. A
flute cast lineation trends N08W on the overturned fold limb. What is (c) the paleocurrent
direction(s) indicated by this primary lineation?

Problem 6.  An inclined core has a logged attitude of 40, 310. The angles φ=-40 and μ=-35 were
measured by the drilling engineer (refer to Figure 4-5) relative to a bedding contact that cuts
across the drill core.  Find the attitude of bedding.
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LABORATORY 5: Contoured Stereographic Diagrams

I. Types of Stereonets

a) Equal-angle stereonet

1. Also termed Wulff net.

2. Maintains angular relationships within the projection plane of the stereonet. For
example, if the small circle intersection of a cone with the lower hemisphere is
plotted, on an equal-angle net the shape of this surface will project as a perfect
circle.

b) Equal-area stereonet

1. Also termed Schmidt net.

2. Maintains the proportion of the lower hemisphere surface projected to the plane
of the net. In other words, no preferred alignment of data will be apparent if the
data are truly random.

c) For the plotting of a large number of structural data elements, we must use the equal
area net to remove any bias when interpreting the average trend of the data. For this
reason most structural geologists will carry the equal area net with them in the field.

d) Note that the types of problems worked in previous laboratory exercises can be solved
with either net. In effect, both nets preserve the angular relationships between lines and
planes in three dimensional space, however, when these elements are projected to the two
dimensional plane of the net diagram they are somewhat distorted on the equal area
stereonet.

e) Be aware that you cannot plot data with one type of net, and then measure angular
relationships or rotate data with the other type.

II.  Constructing contoured stereonets.

a) A typical detailed structural analysis of an area will often yield hundreds if not
thousands of attitude measurements on a variety of planar and linear structures. This is
particularly true of deformed metamorphic terranes that may display several generations
of structural elements at a given exposure.

b) If large numbers of data are plotted on a net, the diagram may become overwhelmed
by the number of plotted data, making it difficult to interpret for structural trends. In this
case it is necessary to contour the data rather than plot individual points or great circles.
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c) The point at which it becomes necessary to contour structural data depends not only on
the number of observations, but also on other factors such as the degree of clustering, etc.
In practice most geologists contour the data when more than 50-100 data are plotted.

d) Since constructing a contour diagram requires a great deal of repetitive plotting, it is
an excellent task for a computer. Although you will initially construct several diagrams
by hand to learn the fundamentals, in future labs the actual construction of the diagram
will be a task for the computer.

e) Steps for constructing a contoured stereogram

1. Plot all of the data on the stereonet. Planar data should be plotted as poles.

2. Transfer the plot constructed in (1) to the Kalsbeek counting net. Use of the
counting net will be demonstrated in class.

3. Count the number of points or poles that fall within a given six-sided polygon
on the counting net. Write this number at the center point of the polygon. The
center point is termed the counting node point.

4. Remember to count points near the primitive at the diametrically opposed
counting nodes. Note that a given point may be counted up to three separate
times.

5. On a separate sheet of paper the count node values are recalculated as a
percentage of the total number of data:

percentage = (count node value)/(total number of points) x 100

For example, if the total number of data is 233, and a count node tally was 15, its
recalculated percentage would be:

percentage = (15)/233 x 100
percentage = 6.4

Usually the percentages are rounded to the nearest whole number. This value
represents the percentage of the total data that fell within the one percent area of
the lower hemisphere centered around the counting node point.

6. After calculating the percentage values for every node on the counting net, the
percentages are contoured as you would contour any other distribution of values.
There are no specific rules for contouring stereograms, however, you should
follow the below general guidelines:
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a. Pick a contour interval that produces at least 5 distinct contour levels on
the stereogram.

b. If several types of data are plotted on separate stereograms for
comparison, use the same contour interval for each, otherwise, it is not
valid to compare structural trends.

c. Always indicate the contour interval levels below the stereogram.

d. If poles to planar data are contoured, make sure that this is mentioned in
your legend or title on the stereogram.

7. The student should note that if a contour line intersects the primitive, the same
contour line should intersect the primitive at the diametrically opposed position
on the primitive.

III. Interpretation of Stereograms

a) The plotting of data on the stereonet has as a goal the determination of structural trend.
For example, the attitude of the fold hinge of a large structure may be evident when
regional data is plotted.

b) Plotting data on the stereonet may have a purely statistical goal. For example, a
geologist may know from experience that bedding in a region generally strikes NE, and
generally dips at a moderate angle to the SE, but what is the best single estimate of the
average attitude of bedding?

c) Stereograms are used to determine the attitude of these basic structural orientation
distributions:

1. Uniform or Random Distribution: this distribution proves that there is no
preferred orientation of data. This would be represented by points or poles
uniformly distributed on the stereonet.

2. Point maximum: this is a tight grouping of points about a particular point on the
net. If the data plotted is linear, the center of gravity of the point maxima is
considered to be the average attitude of linear data. If the data is poles to planes,
the center of gravity of the point maximum is 90E from the great circle
representing the average attitude of the planar data.

3. Great circle girdle: if the plotted points tend to line up along a great circle, the
vectors representing the plotted points tend to lie within a plane. If the data
plotted are poles to planes, the great circle along which the poles align is 90E
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from the hinge of the fold.

4. Small circle girdle: if plotted points align along a small circle girdle, the
vectors that represent the points lie within a conical surface that intersects the
lower hemisphere along a small circle.

IV. Analysis of Folding with Stereograms

a) There are two fundamental types of fold geometries:

1. Cylindrical: produced by moving a line parallel to itself so as to sweep out the
surface. This line is termed the fold axis, and is parallel to the hinge of the fold. 
Cylindrical folds produce great circle girdle distributions when poles to planar
structures are plotted on the stereonet.

2. Conical: conical fold geometry can be modeled by rotating a line about a
rotational axis. The line that is rotated is at some angle other than 90E from the
rotational axis. The surface thus formed is a cone, and this conical surface
intersects the lower hemisphere along a small circle.

b) Properties of Cylindrical Folds

1. If planar readings from a cylindrical fold surface are plotted on the stereonet,
where the great circles tend to intersect defines the hinge attitude. This is rarely
done with large data sets because the large number of intersections is difficult to
interpret. This type of diagram is referred to as a Beta (&) diagram.

2. If poles to the folded surface are plotted, the great circle along which they align
is the plane perpendicular to the hinge line of the fold. In addition, the two point
maxima that occur along this great circle trace can be considered to be the poles
to the limbs of the fold. This type of stereogram where poles to the folded
cylindrical surface are plotted is termed a Pi (π) diagram.

3. If a lineation existed within a surface, ripple marks within bedding for example,
and that surface is later folded into a cylindrical surface, the lineation will have an
attitude that keeps a constant angle with the hinge of the fold. This is true if the
fold was produced by a flexural-slip mechanism. If the mechanism was instead
passive-slip, the pre-existing lineations would be deformed so as to lie within a
plane. They would then plot along a great circle.

c) Properties of Conical Folds

1. If poles to the folded surface of a conical fold are plotted, they fall along a
small circle. The apical angle of the cone containing the poles is the
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supplementary angle of the folded conical surface. The axis of the cone will be
the center of the small circle trace on the stereonet.

2. Remember that the trace of the intersection of a cone with the lower
hemisphere on the equal area net is not a circle but is instead an elliptical
geometry.

V. Problems Associated with Fold Analysis on the Stereonet.

a) Always remember that it is impossible to determine whether or not a fold structure is
an antiform or a synform. This is only possible when the data is plotted on a geologic
map.

b) Although you can plot the limb attitudes from a fold girdle, you cannot directly
measure the interlimb angle until you have additional information that describes the
attitude of the axial plane. If the fold is described as upright you may assume that the
axial plane dips steeply. A recumbent fold has a horizontal or nearly horizontal axial
plane.

c) An isoclinal (both limb are parallel) fold will plot as a point maxima.

d) The pattern produced by a parallel fold as compared to a chevron fold is different even
if they both have the same hinge and axial plane attitudes, and the same interlimb angle.

e) The symmetry of the pattern of contours on the stereogram is correlated to the actual
symmetry of the fold limbs.
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EXERCISE 5A: Contoured  Stereograms and Interpretation of Folded Data

Generate all stereonet diagrams with a radius of 3.5 inches.  Label all interpreted and/or
calculated geometries on the stereonet, as well as reporting attitudes in the upper left corner of
page.

Problem 1: The below data were measured along the limbs of a fold:

286E, 36ESW 040E, 60ESE

330E, 45ESW 357E, 65ESW

079E, 40ESE 053E, 50ESE

plot the following on separate stereonet diagrams:

(1A) β-diagram (great circles) and estimated hinge attitude
(1B) π-diagram (poles) and estimated hinge attitude

Problem 2: With the map in Figure 5-1, and the below data:

ATTITUDE OF FOLIATION RAKE OF MINERAL LINEATION

(A) 037E, 30ESE 42ESW

(B) 000E, 40EE 11ES

© 337E, 60ENE 04ENW

(D) 305E, 70ESW 07ENW

(E) 275E, 40ESW 87ESE

Determine the following on separate plots:

(2A) Determine the plunge and bearing of mineral lineations at stations (A)-(E) with the
stereonet.

(2B) Using appropriate structure symbols for foliation and mineral lineation, plot the
above data on the Figure 5-1 map. Plot the axial trace of the fold on the map and report
its attitude.

(2C) With the stereonet, find the attitude of the fold hinge and the full axial plane
attitude. Do this by plotting a π-diagram. Determine the angle between the hinge and
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each mineral lineation.  Of the following possibile types, flexural-slip or passive-slip, is
the most likely deformational mechanism?

Problem 3: Below are several attitudes for poles to bedding from a fold structure. Using a
stereonet to plot a π-diagram, determine the axis of folding, and whether the fold is conical or
cylindrical.

010E,16E 344E, 47E 285E, 37E

358E, 38E 311E, 50E 278E, 24E

Problem 4: With the foliation data from the below web link construct a contoured stereonet.

www.usouthal.edu/geography/allison/GY403/GY403_lab5A_prob4.xlsx

The foliation data were obtained from a large mesoscopic fold. This problem should be
completed manually with a counting net or with NETPROG. You should turn in the following
plots:

(4A) Construct a plot of the poles to the below planar data, including the number of poles
per one percent area of the lower hemisphere as calculated from the counting net.

(4B) Construct a plot of the poles per one percent area converted to a percentage of the
total number of poles. Also include the contours of density percent on this plot. Label the
contour interval and total number of observations on the bottom center of the plot. Use
your own discretion in determining the contour interval, but strive for 4-6 discreet levels.
Label the point that represents the hinge of the fold with a π, and plot the great circle
girdle perpendicular to the π point. Report the hinge attitude as estimated with the π
method.

Problem 5: The below  data in the web link are foliations collected in the Blue Ridge of north
Georgia:

www.usouthal.edu/geography/allison/GY403/GY403_lab5A_prob5.xlsx

Use NETPROG to process the data. Note that the data are listed in azimuth and dip format. With
these data:

(5A) Plot the poles to foliation and raw number of poles per one percent area. Visually
estimate the "best-fit" great circle girdle that passes through the poles.

(5B) Plot contours of the percent density of data, including the percent density values used
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for contouring on the plot. Label the contour interval, and the number of data used for the
plot, centered below the stereonet. Determine the attitude of the hinge of the fold affecting
this data by plotting the great circle girdle, and label the pole to this great circle as "HINGE"
on the net. Indicate whether or not this fold is symmetrical or asymmetrical.

Problem 6: Given the data in the below web link, find attitude of the lower Ordovician Mascot
Dolomite before deposition of the middle Ordovician Chickamauga Limestone. An angular
unconformity separates the two lithologies. You may use the computer program to help solve this
problem. "Eyeball" an average orientation (center of gravity) to poles for the Chickamauga to
determine the rotation for the Mascot formation. Then rotate the Mascot data to its pre-unconformity
orientation by moving each pole about the rotational axis, and then re-plot the pole. The attitude of
the Mascot data prior to deposition of the Chickamauga can be determined from the center of gravity
of the rotated Mascot poles. It is recommended that you use the NETPROG computer program to
accomplish the above rotation step. You should turn in on separate plots:

www.usouthal.edu/geography/allison/GY403/GY403_lab5A_prob6.xlsx

(6A) The poles to the Chickamauga data along with the visually selected center of gravity
of the data.  Using a great-circle arc  indicate the path that the center of gravity pole would
follow if the plane it represents were rotated to a horizontal attitude. Report the attitude of
the axis of rotation, and the amount of rotation necessary.

(6B)  The poles to the Mascot data in their present-day attitude, and the rotated pre-
unconformity attitude (Use the “solve > rotate data” menu in NETPROG and save the results
to a separate file). Use a cross for attitudes before rotation, and a triangle for attitudes after
rotation.

(6C) Plot the rotated pre-unconformity poles determined in (6B), and the center of gravity
of the poles. Convert the center of gravity pole to a strike and dip and report that as the final
answer. Also plot the great circle 90E from the center of gravity pole.
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EXERCISE 5B: Contoured Stereograms and Interpretation of Folded Data

Problem 1: With the below bedding data (see web link)  construct a contoured stereogram with the
computer application “NETPROG”. Find the following:
(a) Hinge attitude (use NETPROG statistics)
(b) Axial plane attitude given that the axial trace is N50E. 
(c) Fold interlimb angle.

Data web link:
www.usouthal.edu/geography/allison/GY403/GY403_lab5B_prob1.xlsx

After plotting the poles to bedding (NETPROG), turn in on a single stereonet sheet containing:
1. Percent concentration node values.
2.  % concentration contours - play around with contour intervals to get 4-8 levels that plot.
3. Hinge attitude labeled on the stereonet and reported in the upper left answer section
4. Axial plane attitude labeled on the stereonet and reported in answer section
5. Fold limbs plotted as great circles and the interlimb arc angle labeled along the fold girdle.

Problem 2: The below web link contains data that have been collected from folded Paleozoic rocks
in the Picuris Range of North New Mexico. Using the stereonet application “NETPROG” plot the
data as poles to bedding along with the percent concentration node values. Contour the diagram at
a contour interval of 2% using a Gaussian calculation scheme. Given that the axial trace of folds has
been measured from geologic maps to be N19W in this region, calculate the following and plot on
the stereonet:

(a) Hinge attitude (statistical)
(b) Axial plane attitude
(c) Fold interlimb angle
(d) Describe the symmetry of the fold (Asymmetric or Symmetric).

Data web link:
www.usouthal.edu/geography/allison/GY403/GY403_lab5B_prob2.xlsx

Problem 3: The below web link  contains foreset bedding readings from the Red Mt. Formation near
Birmingham, AL. The Red Mt. Formation is a Silurian sandstone unit affected by folding. Assume
that all of the readings were taken from the same outcrop where primary bedding has been measured
as 038, 44SE. Construct the following diagrams using NETPROG:

(a) Plot the poles to foreset beds as a contoured stereonet plot with contour interval of 4%, beginning
at 2%. Also plot the percent concentration node values, and the great circle representing the primary
bedding attitude. Use the least-squares vector fit to calculate the mean attitude of the foreset poles.
Convert the average foreset pole to a strike and dip, and report the answer as the average foreset
attitude in the current (deformed) state. 
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Figure 5-1 : Map for problem 2B.

(b) Determine the rotation axis, amount of rotation, and sense of rotation assuming that primary
bedding should be put back to its original horizontal position. Use the rotation option in NETPROG
to process the rotation, save the results to a different file, and then load this file into NETPROG.
You should then see the rotated poles to foresets. In addition to the rotated poles to foresets, plot the
following:
1. Percent concentration nodes
2. Contours of rotated data starting at 2%, with a 4% interval (same as in (a))
3. Least-squares vector fit to the rotated foreset poles representing the average attitude of the poles
to foresets during deposition.
4. The great circle representing the actual strike and dip of the average foreset attitude during

deposition.
5. Plot the point representing the true dip trend and plunge of the rotated average foreset, and report
the bearing as the paleocurrent direction.

Data web link:
www.usouthal.edu/geography/allison/GY403/GY403_lab5B_prob3.xlsx
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Figure 5-2 : Counting net (equal area).
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LABORATORY 6: Campus Geologic Mapping Project

I. Mesoscopic Structure Symbols (outcrop scale)

(A) Bedding/compositional layering (S0)

 Bedding contacts are primary sedimentary structures. They may be associated with other
primary sedimentary structures such as crossbedding, graded bedding, and ripple marks. An
outcrop may contain multiple layers that differ in composition, however, is the layers have
been recrystallized by metamorphism you cannot assume that this represents bedding unless
you recognize primary features. In this case you should use the term compositional layering.

(B) Foliation or Cleavage (S1) 

Foliation is a preferred alignment of mineral grains in a rock.  The microscopic occurrence
of this property is termed cleavage because it will impart a pronounced parting to the rock
if struck by a hammer.

(C) Lineation (L1)

 Mineral lineation is the  parallel alignment of mineral grains.

Intersection lineation is a streaky lineation caused by the intersection of cleavage or foliation
with compositional layering (S0)

(D) Fold Hinge (F1)

The hinge consists of the points of maximum curvature along a single folded surface.

 Fold symmetry relates to the shape of an asymmetric fold viewed in the down plunge
direction of the hinge.  The shape will appear as a  "Z", "S", or "M", and should be noted.
The symmetry  is related to megascopic folding of same generation

(E) Axial plane (AP1)

The axial plane is the plane that contains multiple hinge line  points along the fold profile. 
Typically this is measure by aligning a clipboard with the imaginary plane that contains
several hinge lines in a fold profile.  You must be able to see significant three-dimensional
relief on the outcrop surface to be able to accurately measure the axial plane attitude.

(F)  Joints

The number of joint surfaces exposed at a given outcrop is often a very large number so it
is not usually possible nor desirable to measure every single occurrence.  Instead you should
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look for joint sets- two or more joints with similar orientation.  Often there are only two or
three sets at a given exposure.  The orientation pattern of joint sets can often delineate the
orientation of the principal components of the stress field that caused the fracture system to
develop.

II. Megascopic Structure Symbols (map scale)

(A) Depositional contacts and igneous contacts

For depositional contacts use a  normal line width (i.e.  #0 rapidograph pen).

An Unconformity may be indicated by hachures on the young side (upper) of the
unconformable surface, however, since unconformities are depositional contacts you must
use a normal width line (i.e. #0 rapidograph) for the contact.

(B) Fault Contacts

Use a thick line width (#2 rapidograph) to distinguish faulted contacts from other contacts.
In general, any symbols used with a fault contact are placed on the hanging wall side of the
fault. Fault contacts with teeth on the hanging wall traditionally represent low-angle reverse
fault (thrust) contacts.

 Normal fault (hanging wall down) contacts should have  hachures on hanging wall side of
the contact. A "U" and "D" is often used to distinguish the upthrown and downthrown fault
blocks. Most normal faults dip steeply. If the fault dips 90E, use the "U" and "D", and put
hachures on the downthrown block.

Reverse fault (hanging wall up) contacts are plotted with the teeth symbols on the hanging
wall block. If a reverse fault dips at a low-angle it is termed a thrust fault.

A strike-slip fault is plotted with  arrows on opposite sides of the fault contact, and these
arrows should accurately describe the sense of motion on the fault.

(C) Megascopic Folds

The axial trace of a fold should be plotted as a thick line (i.e. a 0.7mm or similar pen) weight
with a large arrow indicating the general plunge direction . If the fold hinge is not parallel
to the axial trace (strike of axial plane), an  arrow indicating the hinge attitude should be
drawn off of the axial trace line. Symbology on the axial trace should indicate the difference
between an antiform and a synform. The dip of the axial plane should be represented with
a tic mark in the dip direction and a number indicating the angle value.

An  Asymmetric fold is a fold where one limb is significantly longer than the other.  This
produces a “Z” or “S” symmetry when viewed in profile.  A symmetric fold, one with equal
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length limbs appears as an “M” shape.  These folds are also termed neutral folds.

An Overturned fold contains a limb which has been rotated more than 90 degrees from the
original horizontal attitude.  If the limb is composed of bedding, the bedding is overturned
on the overturned limb (i.e. younger beds are encountered at depth).

A Recumbent fold is a fold with a horizontal axial plane.

Dome and Basin fold structures are indicated by circular contacts.  Domes will have older
strata in the core of the structure, whereas basins will contain younger strata in the core.

A Doubly-plunging fold contains a hinge line that gradually changes attitude.  The map
pattern of contacts will be elliptical in this case.  An elliptical pattern of contacts with older
strata in the core of the structure is a doubly-plunging anticline; younger strata in the core
indicates a doubly-plunging syncline.

(D) Antiform, Synform, Anticline, and Syncline

 Remember that the term antiform and synform describe the geometry indicated by structure
data- and nothing more.  An antiform is a structure in which the limbs of the fold dip away
from the axial trace on the map.  A synform contains limbs which dip toward the axial trace. 
In cross-section profile an antiform is concave down, and synform is concave up. 

Anticline and syncline terminology can be used only when age relationships are known. 
Anticlines have older strata in the core of the structure (map or cross-section view), whereas
a syncline must have younger strata in the core of the structure.

Note that it is possible for there to exist an antiformal syncline, a structure which is concave
down in profile, but contains younger material in the core of the structure.  The opposite
structure, a synformal anticline, can and does exist in highly deformed terranes.

(E) Several deformational phases may produce complex "superposed" folding that produces
fold structures such as an antiformal syncline or synformal anticline.

III. Pace and Compass Traverse

(A) Pace length calculation

1. Make multiple pace counts over known distance measured with tape measure.
2. Average the pace count values and divide into the known distance to give a distance per
pace value (usually feet per pace).
3.  Calculate the average of the pace count trials and standard deviation.  Use the average for
subsequent distance calculations and the standard deviation as a confidence limit on your
estimate.
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4. Write the pace count average down in your field notebook and use it to calculate distances
from pace totals along traverse legs.

(B) Traverses are made to mark the progress of moving across a map area. If the scale of the
map is not sufficiently large, or a map area lacks landmarks, a traverse will be made to locate
stations. Each leg of a traverse is made along a constant azimuth. The distance is calculated
using a pace count.

(C) A closed traverse is made when the end of the traverse is at the same point as the
beginning. Since the error inherent to azimuth and pace measurements inevitably cause the
closed traverse to not "close" when plotted on paper, these traverses must be corrected using
the vector defined by the starting and ending points as plotted on the map. The correction
should be calculated as below:

1. Determine the magnitude and direction of the vector described by the "gap" between the
first and last point of the closed traverse. The direction of this error vector should be in the
sense of travel from the endpoint of the last leg, to the start of the traverse.

2. Divide the magnitude of the error vector by the number of legs of the traverse. For
example, if the error magnitude was 75 feet, and there were three legs to the closed traverse,
then this increment value would be 25 feet.

3. Starting with the end of the first leg of the traverse (station 2), displace the plotted position
of the station in the direction of the error vector by a distance equal to the leg # times the
increment calculated in (2). For leg #1 this distance would be 25 feet, leg #2 50 feet, etc.

4. When (3) is applied to the last leg of the traverse the new position of the last station of the
traverse should be directly on the origin point (station 1) of the traverse. This, in effect,
"closes" the traverse. Attitude data that was collected at the various stations should now be
plotted at the corrected station positions.

NOTE: If you have already completed the pace length calculation and statistics in a
previous course you can use that value for this exercise.
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EXERCISE 6: Geologic Map and Structural Analysis General Instructions

General Instructions for Lab 6 (6A=Gold course & 6B=White course)

In this exercise you will collect field data with which you will construct a geologic map. In addition
to the geologic map, you will analyze the attitude data with the stereonet. You may want to review
the use of the Brunton Compass (Pocket transit), and the organization of field notes  in your lecture
text.

The class will meet outside the Life Sciences building  near the parking lot for orientation.  Marked
on the campus property adjacent to the Life Sciences building will be several stations that are the
targets for the pace and compass traverse.  At each station will be a model that simulates a bedding
plane.  Your team will measure the attitude of bedding with a pocket transit at each station and
record that information into a notebook.  On the bedding plane surface will be a pebble lineation
simulated by a strip of masking tape.  You are to measure that attitude as a plunge and
bearing/azimuth.  As your team moves from station to station, you are to measure the azimuth of the
direction of travel, and record the pace count.  This allows you to later plot and correct a closed
traverse of all stations.  At the beginning of the lab period I will give a brief lecture on the use of the
pocket transit and the calculation of a pace count.  Make sure that you understand the below steps
before beginning the problem:

1.  Calculation of your pace count including percent error for distance measurement (you may have
already completed this step in a prior course).
2.  Setting of magnetic declination on the Brunton compass.
3.  Measurement of azimuth direction from station to station with Brunton compass.
4.  Calculation of distance between two points with pace count.
5.  Measurement of strike and dip of bedding.
6.  Measurement of plunge and bearing of pebble lineation.
7.  Determination of plunge and bearing of pebble lineation on steeply-dipping surface with a rake
angle.
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EXERCISE 6A Geologic Map and Stereonet Analysis

Problem 1: Plot the structure data collected at each station on the closed traverse.  Use the adjusted
position of the stations- not the original position.  The following geologic information was collected
at stations 1 through 8 along the campus traverse.  You can assume that no exposure was
encountered along the traverse between stations (but that does not mean that contacts cannot project
between stations!):
(Gold Course)
Station 1: Contact between the Cambrian siltstone to the southwest and Ordovician limestone to the
northeast.
Station 2: Contact between the Ordovician limestone to the southwest and the Silurian sandstone to
the northeast.
Station 3: Contact between the Silurian sandstone to the southwest and the Devonian shale to the
northeast.
Station 4: No formation contact observed.  Bedding measured was in the Silurian sandstone.
Station 5: Contact between Cambrian siltstone to the northwest and Precambrian schist to the
southeast.
Station 6: Contact between Cambrian siltstone to the southwest and Precambrian schist to the
northeast.
Station 7: Contact between Silurian sandstone to the southwest and Ordovician limestone to the
northeast.
Station 8: Contact between Ordovician limestone to the southwest and Cambrian siltstone to the
northeast.

Use the following information for plotting the geologic map and constructing a legend:

Formation Lithology Pattern Color
Devonian shale dashed brown
Silurian sandstone dotted red
Ordovician limestone blocked blue
Cambrian siltstone dotted & dashed orange
Precambrian schist “use your imagination” green

You should try to project contacts so that the entire map area is covered by one of the above color
and pattern combinations. Use a dashed contact line to indicate approximate contacts. If a fold
structure is indicated by the exposure pattern, draft the axial trace and antiform/synform megascopic
structure symbols appropriate for the structure (don’t forget about overturned bedding symbols). Use
a #0 rapidograph pen for depositional or igneous contacts, and a #2 rapidograph pen for fault
contacts and megascopic fold structural symbols. Your geologic map should contain all of the
elements that are discussed in your lecture text (i.e. scale, title, geographic and magnetic north, and
explanation). Scale: 1 inch = 100 feet.

Problem 2: For the stereonet portion of problem one, plot bedding as great circles (Beta diagram). 
Plot pebble lineations as filled triangles.  If a fold structure is indicated by the data, also plot the
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following:

C Best “visual” or statistical fit (NETPROG) of hinge point labeled “hinge” as a filled circle.
C Axial plane of the fold as a great circle labeled as “axial plane”.
C Interlimb angle of the fold plotted as measured along the great circle perpendicular to the

hinge point.  Plot this great circle and the two points used for measuring the interlimb angle.
Label the angular arc as the “interlimb angle”.

Report the attitude of the hinge, axial plane, and the interlimb angle value as answers.
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EXERCISE 6B Geologic Map and Stereonet Analysis

Problem 1: Plot the structure data collected at each station on the closed traverse.  Use the adjusted
position of the station on the closed traverses- not the original position.  The following geologic
information was collected at stations 1 through 9 along the campus traverse.  You can assume that
no exposure was encountered along the traverse between stations (but that does not mean that
contacts cannot project between stations!):
(White Course)
Station 1: Contact between the Cambrian siltstone to the northwest and Ordovician limestone to the
southeast.
Station 2: Contact between the Precambrian gneiss to the northwest and the Cambrian siltstone to
the southeast.
Station 3: Contact between the Precambrian gneiss to the north and the Cambrian siltstone to the
south.
Station 4: Contact between the Precambrian gneiss to the northeast and the Cambrian siltstone to
the southwest.
Station 5: Contact between Silurian sandstone to the northeast and Devonian shale to the southwest.
Station 6: Contact between Precambrian gneiss to the east and Cambrian siltstone to the west.
Station 7: Silurian sandstone bedding encountered.
Station 8: Contact between Devonian shale to the northwest and Mississippian chert to the southeast.
Station 9: Contact between Silurian sandstone to the northwest and Devonian shale to the southeast.

Use the following information for plotting the geologic map and constructing a legend:

Formation Lithology Pattern Color
Mississippian chert triangles gray
Devonian shale dashed brown
Silurian sandstone dotted red
Ordovician limestone blocked blue
Cambrian siltstone dotted & dashed orange
Precambrian schist wavy lines green

You should try to project contacts so that the entire map area is covered by one of the above color
and pattern combinations. Use a dashed contact line to indicate approximate contacts. If a fold
structure is indicated by the exposure pattern, draft the axial trace and antiform/synform megascopic
structure symbols appropriate for the structure (don’t forget about overturned bedding and/or limb
symbols). Use a #0 rapidograph pen for depositional or igneous contacts, and a #2 rapidograph pen
for fault contacts and megascopic structural symbols such as a fold. Your geologic map should
contain all of the elements that are discussed in your lecture text (i.e. scale, title, geographic and
magnetic north, and explanation). Scale: 1 inch = 100 feet.

Problem 2: Plot bedding as great circles (Beta diagram).  Plot pebble lineations as filled triangles. 
If a fold structure is indicated by the data, also plot the following:
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C Best visual fit of hinge point labeled “hinge” as a filled circle
C Axial plane of the fold as a great circle labeled as “axial plane” in red color
C Interlimb angle of the fold plotted as measured along the great circle perpendicular to the

hinge point.  Plot this great circle and  the two points used for measuring the interlimb angle
in blue.

Report the attitude of the hinge, axial plane, and the interlimb angle value as answers.
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LABORATORY 7: Geologic Map & Cross Section Field Project

In this lab you will be transported to a interesting geological site for a mapping project where you
will collect basic geological structure data and turn that data into a geologic map and cross section.
Below are some helpful hints to guide you to a successful conclusion.

Items required for the day of the field exercise

1. Notebook for taking notes. It should be able to survive getting wet if it does rain.
2. Lead and color pencils.
3. Clipboard or similar planar item to use for measuring strike and dip. Your notebook may serve
for this purpose if it has a stiff backing. You will also use this as a backing for plotting symbols on
your map so try to get a clipboard that is larger than your 8.5 x 11" base map.
4. Tracing paper for stereonet.
5. Stereonet.
6. Marker for samples.
7. One backpack or rucksack per group for samples
8. One rock hammer per group for samples.
9. If a Brunton has been assigned to you please do not forget to bring it with you to the field exercise
site!
10. Make sure that you bring some type of rain gear for protection from inclement weather.

Guidelines for Collecting Field Data

(1) KNOW WHERE YOU ARE! Before you get into the details of collecting data at the exposure,
mark your location on the map and label it with the station number. Use the GPS, topographic
contours, stream drainage, roads, etc., to estimate where you are. If you don't plot you position on
the map accurately, your data may be worthless. If necessary, use pace and compass techniques to
determine your position on the base map.

(2) Inspect all of the outcrop before taking measurements. You will need to guard against becoming
so involved with making measurements and writing them down that you forget to investigate all of
the exposure.

(3) Use teamwork. You will be in groups of two or three. There will be one Brunton compass per
group. One person makes measurements with the Brunton while the other takes notes. If there is a
third person, he/she stands over the person making measurements to make sure that the
measurements are done correctly. The third person should also read over the notes taken to make
sure that everything was taken down correctly. At 2:00PM you can copy each others notes for the
day (i.e. data is copied to one notebook during data collection).

(4) Systematically record the following outcrop characteristics, if present, at the exposure:

a. Lithologic type and mineralogy. Is it sedimentary, igneous, or metamorphic? What is the
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mineralogy, and proportions of minerals? Describe any distinctive textures.

b. Primary features should be described. If bedding is present, describe the thickness. Does
the texture change up or down in the section? Are ripple marks or crossbeds present? Do any
of these features indicate a facing direction? If the rock is metamorphic, is there a preferred
alignment of minerals? If so, is a foliation or lineation defined?

c. Are there identifiable units present at the exposure that are thick enough to plot on the map
scale? If so, try to walk along the contact as far as you can. Trace the contact on the map as
you go.

d. After all primary and secondary structures have been identified and noted, systematically
measure the attitude of each and record these readings in your notebook. Remember to use
the correct format for planar versus linear structures. If you can identify outcrop-scale folds,
measure the hinge and axial plane attitudes. Don't forget to measure primary sedimentary
structures such as crossbedding or ripple marks. When you measure a planar structure, don't
forget to note the dip direction quadrant.

e. If a contact is present at the exposure, carefully note its relationship with other contacts.
Does it offset or truncate other contacts? What relative age relationships are suggested at the
exposure? Are there slickensides or cataclastic textures associated with the contact?

f. Before leaving the exposure, think about any possible geometric relationships between
structural elements. Is the foliation axial planar to folds? Does bedding always dip steeper
than foliation? Are mineral lineations and fold hinges parallel? If these types of relationships
are discovered, note them in your notebook.

g. If you think that you need more time to fully describe the texture and/or mineralogy of the
lithology, take a hand sample. Label the hand sample with the station label.

(5) As you collect data and  if you have time, roughly sketch in structure symbols and contacts on
your base maps. You can plot these more accurately with a protractor at the end of the day. As you
collect data through the day, periodically look at you map. Try to recognize any systematic pattern
to the structure data and/or contacts.
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EXERCISE7A: High Fall Branch Geologic Map & Cross-Section

Problem 1: Collect data within the High Fall Branch map area with you assigned group.  Do not split
up during the course of the project. You will have from approximately 8:00AM to 2:00PM to collect
data. You must have a minimum of 12 stations to sample the map area adequately, so this gives you
an average of 30 minutes per station. You must also disperse the station locations so that they are
not grouped at one location on the map. The exposure is very good in this area so there is a danger
that you might spend too much time in one location. I suggest that you make sure that the first 12
stations cover the map area, then come back to exposures that interest you. The following structures
may be found at a any given station:

Bedding and crossbedding (S0)
Cleavage or Foliation (S1)
Pebble lineation or intersection lineation (L1)
Fold Hinge (F1)
Axial Plane (AP1)

It is important that you accurately determine the location of a station by recognizing topographic
features and relating them to your base map.  The road, hiking trail, and stream are particularly
useful for this.  If you finish collecting data before other groups, use that time to plot the structure
data on the stereonet.  You can also qualitatively plot the structure symbols on your map to see if
any fold or fault structures are apparent.  Since only one of the group should be recording notes, the
other members should use this time to make copies of the data. 

The formal designation for the lithology that outcrops throughout the exercise area is the Siluro-
Devonian Cheaha Quartzite (S-Dtcq).  It is actually a metasandstone since primary depositional
features such as bedding, crossbedding, channel lag deposits, and ripple marks can be found in this
formation. At each data station describe to the best of your ability what occurs at the location.  Look
for primary features such as bedding, cross-bedding, graded beds, etc. Also describe secondary
structures related to deformation such as stretch pebble lineation. Also outcropping in the study area
is the Devonian Erin Slate (Dtes) which actually is a phyllite in this particular area. The phyllite will
contain a strong rock cleavage which should be recorded as a planar S1 reading. A major goal of the
mapping will be to discover the contact between the quartzite and phyllite. Also exposed in the
mapping area is the Jemison metachert, a papery quartzite and phyllite (Dtjc), the Hillabee
Greentstone (D(?)hgs, and the Ashland mica schist (p-Ca). The Dtjc and D(?)hgs display a planar
rock cleavage (S1) that can be measured as strike and dip. The p-Ca has a coarse schist foliation
defined by muscovite preferred alignment that can be recorded also. Any of these metamorphic
rocks may contain a mineral lineation (L1) that may be measured as azimuth and plunge.

The following list defines the various products that you should turn in for this exercise: 

Geologic Map

1. Prepare a clean base map by tracing  the base map given to you for the project onto paper or
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vellum with a 0.35mm  pen. You do not need to trace the topographic base map features.

2. Plot all contacts and structure symbols (bedding, S1, L1, etc.) on the map. You do not have to plot
the station labels used in your notes on the map. All elements are to be plotted with a 0.35mm pen
unless a fault contact is discovered, in which case use a 0.70mm pen. Dash uncertain contacts. Place
the lithologic code abbreviations (i.e. S-Dtcq) inside the appropriate exposure area.

3. Include in a legend along the right margin the explanation of lithologic symbols, structure
symbols, and contacts. Trace the legend information given on the field map used for this project.

4. If any large fault or fold structures are discovered, plot them on the map with appropriate symbols
and line width. Fault contacts and megascopic folds should be plotted with a 0.7mm pen. Hinge and
axial plane attitude information should be added to the axial trace of the fold (attitude information
will be derived  from the stereonet).

5. Use the following color code

1. D(?)hgs: Olive green
2. Dtjc: Pink
3. Dtes: Light gray
4. S-Dtcq Lavender
5. p-Ca Ruby red

Cross-Section

Use the provided cross-section grid to construct the geologic cross-section. Remember to use
apparent dips where necessary. The V.E. is equal to 1- no vertical exaggeration.  Use the same color
coding as per the geologic map. Fault contacts should use a 0.7mm pen, otherwise use a 0.35mm
pen. 

Stereonet

With the structure data collected during this exercise, plot each structure element on separate  
stereograms. Fold hinges and lineations may be combined on a single diagram. Plot all planar
structures as poles, except axial planes which are plotted as great circles. Because you have variety
of structures on one stereogram, you must use symbol coding:

C Poles to bedding filled circle
C Poles to Cleavage/Foliation (S1) Open circle
C Lineation (pebble, intersection, etc.) filled triangle
C Fold hinge filled square
C Axial Plane great circle
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If your geologic map suggests that there may be a large fold or series of folds controlling the
structure in the map area, calculate the hinge point on the stereogram and label this point with a "π"
point. Plot the fold girdle great circle as a dashed line. From the axial trace on the map, construct
the great circle representing the axial plane. Label it as "megascopic axial plane" on the stereogram.
With the above elements plotted, calculate the interlimb angle of the fold.  Indicate the arc measured
for the interlimb angle with a brace along the fold girdle.
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EXERCISE 7B: Tannehill Historical S.P. and Vicinity Geologic Map & Cross-section

Problem 1: You will be provided with a topographic base map with the mapping area indicated by
a magenta rectangular area. The cross section will be marked by an A-A’ line cutting across the map
area. The scale of the map will be 1:24,000 (1 inch = 2000 feet). You will be mapping in an area that
is affected by the Birmingham Anticline, and thrust faulting is a definite possibility in this region.
You will begin mapping the southeast limb of the anticline along the Tannehill S.P. exit road, which
at the entrance is close to the core of the anticline, and work your way into the park itself is on the
southeast flank of the fold. Along the way you should note any recognizable formations that range
in age from Cambrian to Mississippian. A handout describing the various formations will be given
to each group before mapping begins. Each group should measure the orientation of bedding
whenever good exposures are encountered even though these exposures may not correspond to the
contact between 2 formation. A quick inspection of your topographic base will confirm that some
formations are ridge-formers whereas others are valley-formers. Therefore, you should suspect the
presence of a contact whenever you encounter a distinctive topographic break that is recognizable
on the topographic map. When you take bedding readings and/or find contacts using topographic
breaks use the GPS receiver to mark a waypoint and make sure that you describe what is found at
the waypoint in your notebook. 

After mapping the southeast limb you will be transported to the northwest limb in vans where
another transect will be run near the A-A’ cross section line. From your data construct the following
products:

I. Geologic Map (1:24,000 scale) on 24 x 36 inch vellum/paper (ink with a rapidograph, color with
color pencils)

a. Use a #0 (.35mm or similar) for plotted contacts, strike and dip data symbols, plunge & 
bearing data symbols; Use #2 (.7mm or similar) for faults and/or megascopic fold structure
symbols
b. Geographic North Arrow with declination
c. Explanation (structures and lithology symbols- see example in textbook)
d. A-A’ cross section line
e. Formation abbreviation (e.g. Oc, Mf, etc. ) inside each lithologic polygon
f. Graphical scale in metric units and RF
g. Thrust faults should have teeth on hanging wall block
h. Megascopic fold axial trace should have hinge and AP attitude information calculated
from the stereonet
i. Use topographic ridges and valleys to extrapolate the geology to cover the entire map area.
Use dashed contacts for areas far from data control.
j. Label the latitude and longitude at map corners.
k. Lithologic Symbols

1. |Ppv (Pottsville Fm) color = Lt. Blue (sandstone & shale pattern on x-section)
2. Mpw (Parkwood Fm) color = purple (sandstone & shale pattern on x-section)
3. Mf (Floyd Fm.) color = dark blue (shale pattern on x-section)
4. Mh (Hartselle Fm) color = yellow (sandstone pattern on x-section)
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5. Mpm (Pride Mt. Fm.) Color = tan (shale pattern on x-section)
6. Mtfp (Fort Payne Fm) color = green (chert pattern on x-section)
7. Srm (Red Mt. Fm) color = heliotrope (lavender) (sandstone & shale pattern on x-
section)
8. Oc (Chickamauga Fm.) Color = pink (limestone pattern on x-section)
9. -COk (Knox Group) color = orange (dolostone pattern on x-section)
10. -Cc (Conasauga Fm.) Color = brown (dolostone pattern on x-section)

II. Geologic Cross Section (1:24,000 horz. scale; 1:24,000 vert. Scale; VE=1) constructed below
map 

a. Use #0 for contacts, #2 for faults
b. Label ends with A and A’, and the azimuth directions of the cross-section.
c. Topographic profile constructed from topographic base map.
d. If necessary, account for apparent dips when A-A’ is not perpendicular to strike of
contact.

III. Stereonet
a. Plot Bedding as poles to define fold girdle. Calculate the hinge and AP attitude from the
stereonet and map, and add the appropriate symbols to the axial trace on the map. Estimate
and report the interlimb angle using the pole concentrations.  
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LABORATORY 8: Thickness and
Outcrop Width Problems

I. Thickness of Strata

a) True Thickness (t)-
d i s t a n c e  m e a s u r e d
perpendicular to the upper
and lower contact of a
tabular unit.

b) Apparent Thickness-
vertical distance between an
upper and lower contact in a
non-horizontal unit. The
apparent thickness is equal
to the true thickness only
when the attitude of the unit
is horizontal.

c) Outcrop Width (w)- distance on the map between the bounding contacts of a tabular unit
measured along an azimuth perpendicular to strike.

d) Apparent Width (‘w)- distance on
the map between the upper and lower
contacts of a tabular unit measured in a
direction other than perpendicular to strike.

e) Special attitudes:

1. Vertical strata: if the map
surface is relatively
horizontal, the distance
measured perpendicular to
the contacts is the true
thickness.

2. Horizontal strata: the
elevation difference between the upper and lower contacts is the thickness.

f) Inclined strata on a horizontal map surface, traverse taken perpendicular to strike (Figure
8-1).

Figure 8-1 : Relationship of outcrop width (w) to
stratigraphic thickness (t).

Figure 8-2 : Relationship between apparent (w’)
and true (w) outcrop width.

8-1



1. Map outcrop width (w) is greater than the true thickness (t). The lower the dip
angle the greater the difference between (w) and (t).

2. Trig equations

sin(δ) = (opposite side)/(hypotenuse) = t/w (1)
t = sin(δ) * (w)

Note that for the
above cross-section
the solution may be
d i a g r a m e d
graphically using a
specific scale, rather
than using the trig
equations. This is
also true of all of
t h e  f o l l o w i n g
examples in this
chapter, although
graphical solutions
may require more
t h a n  o n e
construction.

g) Inclined strata below a
horizontal topographic
surface; traverse taken oblique to strike:  

1. First step must correct the apparent outcrop width (w') to the true outcrop width
(w):

cos (β) = (w) / (w’) (2)
w = cos(β) * (w’) (see Figure 8-2)

where beta is equal to an angle less than 90E between true dip direction bearing and
traverse direction.  The true outcrop width = (w), whereas (w’) represents apparent
outcrop width. This step can also be solved graphically using the map scale and a
diagram equivalent to Figure 8-2.

2. Second step may be solved graphically by constructing a cross-section using the
calculated true map outcrop width (w) as in Figure 8-1, or mathematically using
equation (1).

Figure 8-3 : Cross-section of thickness with slope 
problem.
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h) Inclined strata on sloping
map surface, traverse taken
perpendicular to strike.

1.  Graphical ly
c o n s t r u c t  t h e
sloping map surface
profile on the cross-
section view. Then
plot the dipping
upper and lower
contacts according
to the outcrop width
(w) obtained from
the traverse. Note
that (w) is the
distance actually
traveled on the
sloping surface- not
the distance between traverse endpoints measured from a map.

2. Trig formula will vary according to the relationship of the slope and dip directions.
The best way is to inspect your graphical cross-section and decide whether the dip
and slope angles are added or subtracted to form the correct geometry.

3. As an example, given that the dip and slope are inclined in opposite directions:

δ = dip angle
σ = slope angle
Sin(δ + σ) = thickness / (w) (3)
Thickness = sin(δ + σ) * (w) (See Figure 8-3)

If the dip and slope angles are inclined in the same direction

Sin(δ - σ) = thickness / (w) (4)
Thickness = sin(δ - σ) * (w) (See Figure 8-4)

4. Note that in the special case where the slope surface is perpendicular to the
stratigraphic contacts, the sum of the dip angle and slope angle will equal 90,
therefore the outcrop width is equal to the true thickness.

i) Inclined strata on a sloping ground surface, traverse taken oblique to strike (this is the
most general case).

Figure 8-4 : Scenario where dip and slope directions are
the same for thickness calculation.
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Figure 8-5 : Cross-section of depth problem.

• The first step is to plot traverse on map, and then plot the strike of the upper and
lower contacts on the map. The slope distance component (w) is then calculated by
measuring the line perpendicular to the contacts.

w = cos(β) * (w’) (See Figure 8-2)

• After the outcrop width (w) is calculated, a cross section view is constructed 
perpendicular to strike using the measured slope and true dip angles along with the
(w) value calculated in the above step. The true thickness can then be solved
graphically or trigonometrically as described in previous steps above. Note that one
should measure the slope angle in the direction of (w), or estimate it from the
topographic map before using it in the cross-section.

II. Apparent thickness in a drill hole (Vertical apparent thickness or Depth)

a) It is often desirable to calculate the apparent stratigraphic thickness encountered in a
vertical drill hole. In these calculations it is often assumed that the drill hole is perfectly
vertical. The graphical value is then found by measuring on the cross-section the vertical
distance between the upper and lower contacts. 

b) Trigonometric
cos(δ) = t / d (5)
d =t / (cos (δ))
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EXERCISE 8A: Thickness and Outcrop Width Problems

You may want to review the fundamentals of sin, cos, tan, etc. before reading the above pages in the
lab manual. When you construct a cross-section for any of the below problems make sure that you
label the direction of the line of cross-section (ex. NW-SE). These problems should be completed
using graphical methods but check your answer with trigonometric equations.

Problem 1: A bed possesses a true dip amount and direction of 55E, N0EE. The surface of the ground
is level, and the distance between the upper and the lower contacts of the bed measured
perpendicular to strike is 250'. Find the thickness of the bed.
SCALE: 1" = 50 feet.

Problem 2: Find the thickness of a bed if the outcrop width between the upper and lower contacts
is 175', as measured perpendicular to the strike direction. The ground surface slopes 15E opposite
the true dip direction. The bed possesses a true dip amount and direction of 35E, N90EE. Find the
true thickness of the bed.
SCALE: 1"=50 feet.

Problem 3: The attitude of a sandstone unit is N55EE, 30ESE. A horizontal traverse with a bearing
of S20EE, taken from the lower stratigraphic contact to the upper stratigraphic contact, measured
106 meters. What is the true thickness of the unit? Assume that the unit is not overturned by
deformation.
SCALE: 1" = 75 meters.

Problem 4: A limestone formation is exposed along an east facing slope. Its attitude is N25EW,
36ESW. The traverse length from the lower contact to the upper contact along a bearing of N80EW
was 623 meters. The slope angle measured perpendicular to strike was 15E. Determine the true
thickness of the limestone.
SCALE: 1" = 400 meters.

Problem 5: The width of the Red Mountain sandstone near Birmingham, Alabama, was found to be
175' measured along an S67EE direction from a lower elevation to a higher elevation. The slope
measured 20E perpendicular to the strike of bedding. The slope face exposed Red Mountain
formation with the ends of the traverse being the contacts with an underlying limestone unit and an
overlying shale unit. A strike and true dip of bedding are not available, but two apparent dips along
bedding planes have been measured: 33E, N47EE and 46E, S56EE. Find the true thickness of the Red
Mountain unit. Use any preferred method to solve for the strike and true dip of the unit.
SCALE: 1" = 100 feet
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EXERCISE 8B: Thickness and Outcrop Width Problems

You may want to review the fundamentals of sin, cos, tan, etc. before reading the above pages in the
lab manual. When you construct a cross-section for any of the below problems make sure that you
label the direction of the line of cross-section (ex. NW-SE). These problems should be completed
using graphical methods but check your answer with trigonometric equations.

Problem 1: A bed dips at an angle of 35 degrees east. The surface of the ground is level, and the
distance between the upper and lower contacts of the bed measured at right angles to strike is 200
feet. Find the thickness of the bed. SCALE: 1 inch = 50 feet.

Problem 2: Find the true thickness of a bed if the width of the outcrop between the upper and lower
contacts is 150 feet, as measured at right angle to strike. The ground surface slopes 20 degrees
opposite the dip. The bed dips 45 degrees east. SCALE: 1 inch = 50 feet.

Problem 3: The attitude of a sandstone unit is N65E, 35SE. A horizontal traverse with a bearing of
S10E, taken from the lower to the upper contact, measured 126m. What is the true thickness of the
sandstone bed? SCALE: 1 inch = 75m.

Problem 4: A limestone formation is exposed along an east-facing slope. It has an attitude of N15W,
26SW. The traverse length from the lower contact to the upper contact along a bearing of N90W
measures 653m. The slope angle was +15 degrees (ascending) measured in the true dip direction.
What is the true thickness of the limestone formation? SCALE: 1 inch = 400m.

Problem 5: The width of the Silurian Red Mt. Formation sandstone near Birmingham, Alabama, was
found to be 150 feet measured in the S70E directional bearing beginning at the lower stratigraphic
contact and terminating at the upper stratigraphic contact. This west-facing slope was found to have
a topographic slope of 20 degrees. Also discovered along the traverse was an older limestone unit,
the Ordovician Chickamauga limestone, and the younger Devonian Frog Mt. Sandstone. Although
exposure was not sufficient for a direct strike and dip measurement, two apparent dips were recorded
on the Red Mt. - Chickamauga contact: 24, N47E and 36, S26E. Find the thickness of the Red Mt.
Formation. SCALE: 1 inch = 100 feet.
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Figure 9-1 : Example of horizontal
contacts exposed in a valley.

LABORATORY 9: Outcrop Prediction

I. Outcrop Prediction

(a) Based on the assumption that contacts are perfectly planar, and are unaffected by
faulting.

b) To use this method you must be given the attitude of the planar surface, and at least one
place where it is exposed in the map area. You must also have an accurate topographic base
map. A 3-point problem can be solved for the attitude.

c) The outcrop prediction method allows one to plot the location of the planar contact on the
map if the above conditions are met.

d) The procedure works by orthographically calculating the intersection of the plane with
the ground surface as described by the contour lines.

II. Special Cases

a) Horizontal attitude: In this case the geological
contacts are parallel to topographic contours (Figure
9-1). A geologic map can be constructed from the
singular occurrence of exposed contacts if the area is
unaffected by faulting.

b) Vertical attitude: Topography has no effect; the
contact line is drawn as a straight line parallel to the
strike and passing through the position where it
outcrops. In this attitude the outcrop width on the
map is the same as the true thickness.

c) Rule of V (Geologic): Inclined strata will form a
"V"-shape outcrop pattern that points in the dip
direction if the contacts are cut by a stream valley
(Figure 9-2; a, c, d).

The development of the “V” shape is inversely proportional
to the dip angle, with a vertical (90 degree) dip producing no
“V” offset (i.e. contacts remain straight regardless of
topography; Figure 9-2b). Note that the rule of V’s holds
true only when the dip of the strata is greater than the slope
of the valley, however, topographic relief is rarely so large
that stream gradients are greater than true dip. Unless
regional dip is very small and topographic relief is large so
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Figure 9-2 : Example of geologic Rule of
“V’s”.

that the valley slope is greater than the dip (as in Figure 9-2e), it is safe to assume the geologic rule
of V’s. 

NOTE: It is important to distinguish the topographic “Rule of V’s” from the geologic “Rule
of V’s”:

1. Topographic: topographic contour lines will form a “V” when they cross a valley
that point in the uphill direction of the valley. A corollary to this is that the “V” of
contours must point in the upstream direction of a stream valley.

2. Geologic: planar geologic contacts
form a “V” geometry when they
cross a topographic valley that points
in the true dip direction of the
contact. Shallow true dips form
exaggerated “V” patterns, whereas
steep dips form a barely recognizable
“V” pattern. Vertical dips will have
no “V” pattern because contact lines
remain perfectly straight regardless
of topography. Horizontal contacts
(dip=0) remain parallel to
topographic contacts.   

III. General Solution for Outcrop Prediction

a) Given topographic map with location of
exposure, and the attitude of the exposed
contact. Assuming that the contact is planar
we can proceed with the outcrop prediction.

b) Steps for solving problem:

1. Construct a fold line (FL)
perpendicular to the strike of the
contact and located to one side of the
map. Below the fold line construct a grid to scale that conforms to the topographic
contour interval. The grid lines are parallel to the original fold line. The grid lines
have been constructed in Figure 9-4 below the map. Note that the grid lines are
labeled 100-140 because these values represent the elevation range of the map.

2. The elevation of the exposed contact should be taken from the contour map. This
point is projected parallel to the strike of the contact until it intersects the fold line.
At the fold line, continue the projected line downward until it intersects the matching
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grid elevation.  Plot this point. In the Figure 9-4 example, the position and attitude
of the exposed outcrop is indicated by the strike and dip symbol.

3. Through the point identified in step (2) above, plot the trace of the contact dipping
at the true dip angle in the grid profile.  Make sure that the dip direction is correct.
Note those locations where the contact intersects an elevation grid line. The
projections of these intersections parallel to strike and to the map view represent
structure contour lines of a specific elevation. Label these lines (which have a
constant spacing) with the appropriate elevation number. 

4.  From each intersection of an equivalent structure contour and topographic contour
from step (3), plot points that represent the outcrop geometry for that surface. Mark
these locations with dots as has been done in Figure 9-4. Note that a certain amount
of interpolation can be done to get better resolution of the contact position.

5. Using the pattern of dots trace the contact of the layer on the map surface.
Remember the rule of "V" when constructing the contact. This has been done in
Figure 9-4.

c) Note that if the thickness of the layer is given, the entire outcrop belt can be plotted for
that particular unit since both the upper and lower contacts can be plotted.  This, of course,
works correctly only if the assumption that the unit is tabular is valid. Use the map scale to
plot the other contact on the cross-section grid. This line will be parallel to the first contact
plotted. Wherever the contact crosses elevation grid lines yields a position where the strike
line of the contact is at the same elevation as one of the contour intervals. As in steps (4) and
(5) these strike lines (structure contours) of known elevation can be projected to the map and
therefore define points where the contact outcrops. Figure 9-5 displays the outcrop
prediction for the above example if the stratigraphic thickness was 12.8 meters. The structure
contours for the lower stratigraphic contact are plotted as dashed lines to distinguish them
from those of the upper contact.

D) As with most graphical solutions to structural problems, the outcrop prediction problem
can also be managed mathematically. Consider the cross-sectional view of the problem in
Figure 9-4. The spacing between adjacent structure contours is always the same, and is
controlled by the equation:

Tan (Dip angle) = (Contour Interval) / (Structure Contour Spacing)

(Structure Contour Spacing) = (Contour Interval) / Tan(Dip Angle)

Using the example in Figure 9-4 would yield:

(Structure Contour Spacing) = (10 m) / (Tan 40E)
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Structure Contour Spacing = 12 m

You would then draw parallel lines to the initial strike line spaced at 12 meter intervals
perpendicular to strike. These structure contours would decrease in elevation in the dip
direction, just as they do in  Figure 9-4. Using this method you can avoid the time-
consuming task of constructing the cross-sectional grid. 

Structure contours for the bottom of the bed in the example can be constructed
mathematically also. The spacing between adjacent structure contours for the bottom of the
bed is exactly the same as the top because both surfaces have the same dip (see Figure 9-5).
The unknown value is the offset of structure contours of the same elevation for the top and
bottom of the bed. In the Figure 9-5 example this value was calculated graphically be
constructing the cross-section to scale. However, the problem can also be solved with trig:

(Offset) = (Thickness) / (Sin (Dip Angle))

Therefore, for the Figure 9-5 example:

Offset = (12.8 m) / (Sin 40)

Offset = 19.3 m

The 110 meter bottom structure contour is offset 19.3 meters from the 110 meter top
structure contour in the “up-dip” direction. In this case the offset is to the west. You may
need to sketch the problem in profile to verify the direction of the offset when solving
mathematically. With the initial 110 meter structure contour plotted, the other structure
contours on the bottom contact are spaced 12 meters apart with the elevation decreasing in
the dip direction, just like the structure contours for the top of the bed. The spacing between
structure contours is the same because both the top and bottom surfaces of the bed dip at the
same angle. 

If the outcrop of the structural plane occurs at a topographic elevation equal to a contour
interval, the structure contour  spacing can be used from that point to construct all necessary
structure contours as a set of parallel lines (see Figure 9-4). If a contact can be traced on a
map surface from aerial photography or from a geological map the "starting" structure
contour can be set to where a topographic contour crosses the contact line. However, this
may not be possible so the relationship:

Tan (Dip Angle) = (Δy)/(Δx) 

Can be used to calculate the exact offset from the control point to start the structure contour.
For example, assume that the map topographic contour interval is 20 feet, and a bedding
plane contact with attitude 330, 55 SW is discovered at 707 feet elevation. A 720
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topographic contour is near the outcrop so the offset from the outcrop to the 720 structure
contour on the contact is needed. First you should realize that the offset direction from the
outcrop is in the 030 direction because that is perpendicular to strike and in the "up-dip"
direction (i.e. elevation is gained from 707 to 720). The amount of map distance between the
outcrop and 720 structure contour is calculated from:

Tan(55) = 13/x   
x = 13/Tan(55) = 9.1 feet

Where x is the offset distance from the outcrop to the 720 structure contour. From this offset
point the 720 structure contour can be drawn as a straight line striking 330. Where this line
intersects the 720 topographic contour would generate outcrop control points.

E) Another geometrical quantity that may prove useful in outcrop prediction is the vertical
distance between the upper and lower contacts in Figure 9-5. You may recall this geometry
from the chapter on thickness calculations (see Figure 8-5):

d = t / (cos (δ))

Where d is the vertical distance between the upper and lower contacts, t is the thickness of
the unit, and δ is the dip angle. For the example problem the “d” value would be:

d = 12.75m / (cos(40)) = 16.6m

Therefore, because in Figure 9-5 we know that the given strike and dip control point on the
top planar contact exists at an elevation of 110m, there must also be exist a point on the
bottom contact directly below this map location at an elevation = 110m - 16.6m = 93.4m.
This value can be important- for example if you have the equation for the upper contact
plane in the form:

z = c0 + x * c1 + y * c2

where z is the elevation of the plane, and x and y are the map coordinates. If the upper
contact plane in this example conformed to the equation:

z = 419798.3 + x * -0.8391 + y * -1.490e-8

 then the equation for the bottom contact must be:

z = 419781.7 + x * -0.8391 + y * -1.490e-8

Note that the only difference in the bottom contact equation is the 16.6m subtracted from the
constant term (c0) in the equation for the top contact - i.e. an elevation shift along the z axis.
The c1 and c2 coefficients don’t change because the top and bottom contacts have the same
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attitude.    

IV. GIS Generated Outcrop Prediction

A) Modern GIS systems are capable of calculating the intersection of structural planes with
a DEM of a topographic surface to produce the geological trace of contacts, and ultimately
geologic maps and/or cross-sections.

B) Refer to this online document for a step-by-step procedure for using QGIS and the plugin
qgSurf to construct the example outcrop prediction in Figure 9-5.
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Figure 9-3 : Initial setup of outcrop prediction example problem.
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Figure 9-4 : Final solution of example outcrop prediction problem.
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Figure 9-5 : ArcGIS generated version of example outcrop prediction.
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EXERCISE 9A: Outcrop Prediction

When constructing your problem, you should copy the base map contours, map boundary,
etc., onto a sheet of your drafting paper with a rapidograph, or by xeroxing onto drafting paper.  Be
aware that reproduction of this laboratory manual often distorts the scale of maps used for problems. 
You should check for this eventuality, and if the distortion is significant use the scale bar of the map
for the problem construction. Those of you who have had training with CAD or GIS applications
can generate final maps with software. In the below problems it is important to remember the
following definitions:

M Stratigraphic Contact: refers to the original stratigraphic sequence and, therefore, gives
relative age information. For example, if the contact of a sedimentary or volcanic unit is
referred to as the upper stratigraphic contact, then you can be sure that the contact is the
original top of the unit and that rocks adjacent to that contact are younger that those adjacent
to the other contact of the unit.

M Structural Contact: refers to the present position of the contact. For example, the upper
structural contact is simply the present contact that is vertically uppermost in the current
structural position. Note that in an overturned sequence of strata that the upper structural
contact of a unit is the stratigraphically lower (oldest) contact. Also note that if a sequence
of sedimentary strata is vertical (dip = 90), there is no structural upper and lower contact,
however, there is still a stratigraphic upper and lower contact. 

Problem 1: The stratigraphic upper (younger) contact of a geological formation outcrops at points
X, Y, and Z on the map in Figure 9-6. The thickness of the bed is 50 feet. Assume that the formation
is not overturned and is planar. Draw both the upper and lower stratigraphic contacts on the map.
Color the formation red, the stratigraphically older formation green, and the stratigraphically
younger formation blue.

Contour Interval = 50 feet

Problem 2: The upper stratigraphic contact of a sandstone bed crops out at points A, B, and C, on
the map in Figure 9-7. The lower stratigraphic contact of the sandstone outcrops at point D.
Determine the strike and dip and draw in both stratigraphic contacts on the map. Color the sandstone
red, the stratigraphically older unit green, and the younger unit blue. What is the thickness of the
sandstone bed?

Contour Interval = 10 feet
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Problem 3: The outcrop pattern of the stratigraphic top contact of a Cretaceous formation is
displayed on the map in Figure 9-8. Find the strike and dip of the contact. Copy the map boundary
and contour information onto your paper so that it is included with your solution. On this base map
plot the structure contours using the contour interval of 200 feet. Assume that the Cretaceous is 200
feet thick and that the lower contact of the cretaceous is parallel to the upper contact. Calculate the
position of the lower Cretaceous contact based on this thickness. Plot the structure contour lines for
the lower stratigraphic contact and label with a contour interval of 200 feet. Use continuous structure
contour lines for the top of the formation, dashed contour lines for the bottom contact.

Contour Interval = 200 feet

Problem 4A: Copy the base map and contacts from Problem 3 onto a separate sheet of paper. Fossils
collected several feet structurally above the upper Cretaceous contact are Tertiary. Fossil data
collected from all sedimentary rocks structurally  below the Cretaceous strata are Triassic. Points
1,2, and 3 on the map in Figure 9-8 are outcrops of the upper structural contact of a basalt flow, and
point 4 is the outcrop of the lower structural contact of the same flow. At point 4 the basalt flow was
vesicular. At points 1,2, and 3, the strata structurally above the basalt flow appears to have been
affected by contact metamorphism. What is the attitude of the basalt flow? What is the thickness of
the basalt flow?  Color the outcrop area of all Triassic volcanic rocks black. Color all Tertiary
sedimentary rocks blue, Cretaceous sedimentary rocks red, and Triassic sedimentary rocks green.

Problem 4B: On a separate sheet of paper describe in order of oldest to youngest all of the geological
events represented on your map. Label each event sequentially with a number, starting with (1) for
the oldest. Be sure to use all time constraints available in the above problem description. If you must
explain any contacts on your map with a fault or unconformity, use a thick line for fault contact
(suggest your #2 pen), and a hachured line of normal thickness (#0 pen) for an  unconformable
depositional contact. Hachures on an unconformable contact always lie on the side of the contact
occupied by relatively younger strata.
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EXERCISE 9B: Outcrop Prediction

For this exercise we will use QGIS 3.x to process the outcrop prediction given some
beginning digital map data. You will need access to a GIS lab with QGIS installed on it, or have the
QGIS 3.x  application installed on your own computer. In addition, you will need to have the
“qgSurf plugin” installed on the QGIS application that you are using. Currently QGIS applications
are installed on all of the workstations in the GIS lab rooms LSCB 333. The starting files are located
at:

http://www.usouthal.edu/geography/allison/gy403/ExProb.zip

http://www.usouthal.edu/geography/allison/gy403/OPprob1.zip

http://www.usouthal.edu/geography/allison/gy403/OPprob2.zip

Review the lab  lecture presentation of the example problem in the above section before attempting
the below problems 1 and 2. The documentation for the example problem and problems 1 and 2 are
contained in the ZIP archive files. Note that different versions of QGIS may present somewhat
different screen displays as compared to the documentation, however, the basic logic behind solving
the problems are the same for any GIS application. For those students with training with ArcGIS,
if you want to use ArcGIS for the problems you can certainly do so, however, there is no equivalent
to the qgSurf  plugin for ArcGIS that I am aware of so you will need to use QGIS for the step that
calculates the intersection of a planar surface with the topographic DEM.

Problem 1: (see “Problem 1 documentation” file). In addition to producing the geologic map, answer
the problems at the end of this document. 

Problem 2: (see “Problem 2 documentation” file). The USA campus topographic contour map in
Figure 9-9 is included for reference. Answer problems at the end of the document in addition to
constructing the geologic map.
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Figure 9-6 : Topographic map for problem 1.
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Figure 9-7 : Topographic map for problem 2.
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Figure 9-8 : Topographic map for problems 3 and 4.
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Figure 9-9 : USA campus topographic map.
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LABORATORY 10: Stereographic Statistical Techniques

I. Introduction

a) Statistics can be used with the stereonet as a predictive tool. Usually the structural
geologist is most interested in patterns on the stereonet that indicate a type of structure, such
as a fold. In addition statistics can define a confidence region on the stereonet that contains
a probability value that predicts how likely future measurements would fall inside the region.

b) There are several types of geometric patterns that are indicative of structures:

1. Point cluster: a cluster of points indicate that most of the data have approximately
the same attitude. This is true of linear data or poles to planes. Solving for the least-
squares or best-fit vector to the data set gives the "center of gravity" of the data (i.e.
mean vector)

2. Cylindrical girdle: points that are aligned along a great circle represent vectors
that are contained within a common plane in three dimensions. Since poles to a
folded surface, such as bedding, have this property this type of distribution is termed
cylindrical because the folded surface is approximated by a section of a cylinder. The
pole to the girdle plane is the hinge attitude of the fold. The girdle is also the great
circle arc along which the interlimb angle can be measured since it represents the
plane perpendicular to the hinge. A statistical least-squares solution will yield the
attitude of a geometric plane that minimizes the deviations of the data from the girdle
great circle.

3. Conical distribution: a conical distribution is representative of vectors which fall
along a small circle. These distributions can be produced by several different
mechanisms. Some folds are not cylindrical but are instead inherently conical in
shape. Conical folds will "die out" along the axial trace. Originally cylindrical folds
may become conical after being re-folded by later deformation. Lineations that exist
in a rock mass that is later affected by cylindrical parallel folding will be deformed
into a small circle distribution if, as is likely, there original attitude was not
perpendicular to the later fold axis. Solving for the least-squares conical surface for
data that has been affected by this type of deformation yields a conical axis and a K
angle. The K angle is also termed the ½ apical angle. This is the angular arc from
the cone axis to the least-squares conical surface.

c) The mathematical equations that calculate statistical parameters must use data in the form
of directional cosines. The attitude of geometrical least-squares elements are also solved for
in the form of directional cosines. Note that any directional cosine can be checked for
validity by the following relationship:

cos(α)2 + cos(β)2 + cos(γ)2 = 1.0
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where α, β, and γ are the directional angles of the vector.

II. Least-squares Vector of Ramsay (1968)

a) Equations for the least-squares vector solve for the directional cosines of the vector:

 F i i i
i

n

  

 (cos ) (cos ) (cos )  2 2 2

1

where αi, βi, and γi are the directional angles for the data set with summation from i = 1 to
the “nth” data element.
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where [αv, βv, γv] represent the attitude of the least-squares vector.

III. Least-squares Cylindrical Plane of Ramsay (1968)

a)  Equations for the least-squares cylindrical plane are necessarily more complex than those
for the vector, therefore, to simplify the below equations let:

l = cos(αi)
m = cos(βi)
n = cos(γi)

therefore, whenever [l, m, n] are present in the below formulae they actually represent
[cos(α), cos(β), cos(γ)] for the “ith” data vector element respectively:

let E = E(l2)E(m2) - E((lm)2)

A
lm mn nl m

E


  ( ) ( ) ( ) ( )2

B
lm nl mn l

E


  ( ) ( ) ( ) ( )2
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where [ αp, βp, γp ] represent the directional angles of the hinge of the cylindrical fold, which
is also the pole to the least-squares plane. All of the summation symbols above are for i =
1 to n data. This is also true for all following summation symbols.

IV. Least-squares Conical Surface of Ramsay (1968)

a) Solving for the least-squares conical surface requires the extraction of determinants form
the below matrices. The notation of (l, m, n) is equivalent to that used in Ramsay’s method
for a cylindrical fit. “N” is equivalent to the number of data observations:

E(l2) E(lm) E(l)
D = E(lm) E(m2) E(m)

E(l) E(m) N

E(ln) E(lm) E(l)
DA = E(mn) E(m2) E(m)

E(n) E(m) N

E(l2) E(ln) E(l)
DB = E(lm) E(mn) E(m)

E(l) E(n) N

E(l2) E(lm) E(ln)
DC = E(lm) E(m2) E(mn)

E(l) E(m) E(n)
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NOTE: most current computer spreadsheet programs have a function that extracts the
determinant from a square matrix of values.  For example, Quattro for Windows has a
@MDET(range) function where “range” would represent the cell range of the diagonal cells
of the matrix.

D = E(l2)E(m2)(N) + E(lm)E(m)E(l) + E(l)E(lm)E(m)
- E(l)E(m2)E(l) - E(lm)E(lm)(N) - E(l2)E(m)E(m)

DA = E(ln)E(m2)(N) + E(lm)E(m)E(n)) + E(l)(E(mn))E(m)
-E(l)E(m2)(E(n)) - E(lm)(E(mn))(N) - (E(ln))E(m)E(m)

DB = E(l2)(E(mn))(N) + (E(ln))E(m)E(l) + E(l)E(lm)(E(n))
- E(l)(E(mn))E(l) - (E(ln))E(lm)(N) - E(l2)E(m)(E(n))

DC = E(l2)E(m2)(E(n)) + E(lm)(E(mn))E(l) + (E(ln))E(lm)E(m)
- (E(ln))E(m2)E(l) - E(lm)E(lm)(E(n)) - E(l2)(E(mn))E(m)

where (l, m, n) have the same symbolic meaning as in the previous discussion. (N) refers to
the number of data. From the determinants the following coefficients may be calculated:

A
D

D
A B

D

D
B C

D

D
C

and from these coefficients the directional cosines are calculated:

Cos
A

A B
C( ) 

 1 2 2

Cos
B

A B
C( ) 

 1 2 2
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1

1 2 2

Cos K
C

A B
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Figure 10-1 : Examples of eigenvector axial lengths.

where [αC, βC, γC] represent the directional angles of the conical axis, and Kc is the ½ apical
angle of the least-squares conical surface.

V. Eigen Vectors

a) Eigenvectors are mathematically calculated using matrix algebra in a way that is different
than the Ramsay (1968) procedures described before. The eigenvectors are mutually
perpendicular in three dimensions, and are related to the mean attitude of the structure data
set.

B) The eigenvectors are also the three axes of an ellipsoid. This ellipsoid should be imagined
as the best-fit surface to the data set if each data is a vector of unit length (either linear
structure elements or poles to planes), and the surface best-fits the end points of the vector.
The midpoint of each unit vector would be at the center of the stereographic projection

sphere. In this regard, the eigenvector method makes no distinction between the upper and
lower hemisphere as does the Ramsay method. Thus, the three eigenvectors are the three
axes of the best-fit ellipsoid. Vector clusters produce a prolate ellipsoid, while cylindrical
fold distributions yield oblate ellipsoids.
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C) The Ramsay method suffers from the “double-plunge” effect because of the lower-
hemisphere projection. For example, if an equal number of low-plunge lineations are doubly
plunging north and south, the calculated average vector using the Ramsay method yields a
vertical mean vector! The eigenvector method instead yields the correct horizontal north-
south oriented vector. 

D) To calculate the eigenvectors, the structure data must be converted into directional
cosines, with which the below summations can be made:

cos(α) = l
cos(β) = m
cos(γ) = n

l m n “check” lm ln mn l2 m2 n2

Data #1
Data #2

.

.

.
Data #N

Summations:

When the summations are accumulated, the values can be processed by an eigenvector
procedure to derive the magnitude and attitude of the three eigenvectors. Note that while the
eigenvector 3x3 matrix contains 9 summation elements, some are equivalent, therefore, only
6 summations are actually required:

3l2 3lm 3ln
A    = 3ml 3m2 3mn

3nl 3nm 3n2

 Where “A” is the eigenvector solution. The results are best categorized graphically by
Figure 10-1 (Woodcock, 1977). The results from this graph fall in to one of three categories:

1. Uniaxial Cluster: this distribution indicates that data varies only slightly in attitude.
A typical example would be mineral lineations in a metamorphic rock that have not
been folded by later deformation. The dominant magnitude eigenvector is the mean
attitude of this distribution

2. Uniaxial Girdle: this distribution is typically the result of cylindrical folding of a an
original planar structure. When poles to this planar structure are plotted, a girdle
distribution falls about the great circle that is perpendicular to the hinge of the fold.
In this case the two dominant eigenvectors will fall on the girdle great circle. The
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hinge is the vector perpendicular to this great circle, and this of course will be the
attitude of the small eigenvector. This eigenvector is the best-fit hinge attitude.

3. A third possibility is that the three eigenvectors have different values but are 
different magnitudes. This equivocal situation may be caused by uniformly random
data, or conical folding. If conical folding is suspected, the Ramsay method should
be used to evaluate the structure.

V. Goodness of Fit Measures

a) In addition to calculating the least-squares geometry, one must also quantify the
"goodness of fit" and whether or not the data is normally distributed about the least-square
geometry.

b) If the data are normally distributed about the least-square geometry a standard deviation
calculation can be used to quantify a confidence region about the least-squares fit. For
example, if data from a point cluster can be demonstrated to be normally distributed about
the least-squares vector then a conical confidence with an apical angle of four standard
deviations (±2 standard deviations) should include approximately 95% of present and future
measurements. The equation for the standard deviation is listed below:

S
n

i ideal
i

n






 ( )  2

1

1

where θi is the actual angular arc between the axis of the geometry and the ith data vector,
and θideal is the angular arc between the surface of the least-squares geometry and the axis of 
the least-squares geometry, measured in the same plane as θi. The variable “n” is the number
of data elements. For a vector, cylindrical, and conical fit θideal is equal to 0, 90, and the cone
apical angle degrees respectively. To calculate the angle theta between any two vectors the
following relationship may be used:

cos(θij) = (cos(αi))(cos(αj)) + (cos(βi))(cos(βj)) + (cos(γi))(cos(γj))

where θij is the angle between the two vectors i and j that have directional angles (αi,βi,γi) and
(αj,βj,γj).

c) R2 (Coefficient of Determination) can be calculated to measure the degree to which the
covariance of the data is explained by the least-squares geometry. The value of R2 ranges
from 0.0 (no relationship) to 1.0 (perfect relationship). An R2 value of 1.0 could only be
attained if every data vector falls perfectly on the least-squares surface. A purely random
data set would produce an R2 value of 0 for a least-squares plane or cone. It is not possible
to calculate R2 for a least-squares vector because there is no surface fit to the data. The
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Figure 10-2 : Example of data set that is normally distributed about a
least-squares cylindrical surface according to the chi-square statistic.

equation for the calculation of R2 is listed below:
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where θE (“expected”) represents the angle between the geometric mean vector of the data
set (equivalent to a least-squares vector fit) and the fit surface (cylindrical or conical)
measured in the plane that contains the mean vector and axis of the least-squares surface.
The θO (“observed”) angle is the arc between the geometric mean and the “ith” data vector
measured in the plane common to both. Note that if the least-squares conical or cylindrical
surface passes perfectly through each data vector the value of (θE)2 and (θO)2 are equivalent,
therefore, R2 would equal unity. As the deviations of data vectors from the fit surface
become larger, the denominator of the equation becomes larger, causing R2 to become lower
in value. The θE angle is equivalent to 90 degrees if the fit surface is cylindrical, the ½ apical
angle if the fit surface is conical. R2 cannot be calculated for a vector fit.

d) A test for normal distribution can be accomplished with the χ2 statistic. A full discussion
of this method is beyond the scope of this text (see Davis, 1992), however, the below
equation is given as for reference:
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θO and θE are defined as described above. As can be verified from the above equation, as the
data deviate from a normal distribution the χ2 statistic grows larger in magnitude. Standard
statistics texts contain tables for this statistic that requires the degrees of freedom (df) and
the desired confidence level. Since data must be converted to z scores before plotted as a
frequency distribution, the df is the number of categories (bars) on the frequency histogram
minus the number of calculated values necessary for the z scores (mean + standard deviation
= 2). If the χ2  statistic is larger than the critical value given in tables, the data fail the test
and cannot be considered a normal distribution. The Figure 10-2 example above is an
example of a data set that is normally distributed about a least-squares geometry according
to the χ2 statistic of 2.33 (critical value = 27.7, same as used by the stereonet analysis
program NETPROG).
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EXERCISE 10A: Stereograms and Statistical Techniques

Refer to your class notes relating to statistical analysis of orientation data.

In this lab you will apply statistical techniques discussed in class to actual orientation data. In the
below exercise you will use NETPROG to calculate best-fit statistics on 3 separate problems
demonstrating vector, cylindrical and conical data distributions. A measure of the “goodness-of-fit”
will be calculated and plotted, and a χ2 statistic will be used to evaluate whether the data distribution
is “normal” or “non-normal”.

Problem 1. Below is a set of measured orientations of a linear platinum-bearing zone collected by
a mining company. The company wants to sink a mine shaft along the zone and therefore needs an
average orientation determined from the data. You are a geologist employed by a consulting firm
and your supervisor has  assigned  to you the task of analyzing the data for the mining company. The
head of the mining company - a person well versed in statistics, but not in structural geology -
informs you that contouring the data and "eyeballing" an average orientation is not good enough;
he wants a statistical determination of the average orientation of the data,  a statistical measure of
the goodness of fit, and a measure of whether or not the data is normally distributed. Determine the
best-fit (mean) vector to this data set using the eigen vector method, and determine the standard
deviation about the best-fit vector in degrees. Plot the data as points on a stereonet, and plot the
position of the best-fit vector. Assuming that the data is normally distributed about the  mean vector,
plot on the stereonet a "cone of confidence" that should contain 95% of the data (i.e. 2 standard
deviations) if the data is normally distributed. 

Table 1- Mineralized zone linear attitudes for Problem 1.

S 40 W 39 S 38 W 25 S 36 W 21 S 23 W 30

S 42 W 41 S 36 W 29 S 33 W 26 S 17 W 35

S 36 W 47 S 34 W 35 S 32 W 29 S 15 W 34

S 29 W 50 S 28 W 38 S 26 W 30 S 26 W 22

S 44 W 29 S 25 W 40 S 24 W 34 S 25 W 25

S 36 W 33 S 21 W 43 S 19 W 38

S 34 W 41 S 15 W 44 S 36 W 15

S 28 W 43 S 28 W 36 S 32 W 20

S 17 W 50 S 23 W 38 S 30 W 25

S 33 W 38 S 14 W 40 S 26 W 28

Make sure the following appear on the stereonet for Problem 1:
1. Data and Eigen vectors plotted correctly (10 points).
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2. Orientation of best-fit vector (plotted as a dot plus cross)  with trend and  plunge listed (10
points).
3. Two-Standard Deviation cone of confidence plotted and listed (10 points).
4.  χ2 listed with histogram plotted (10 points).

Problem 2. Below are strike and dip measurements of bedding taken from a cylindrical fold system.
Determine statistically the orientation of the hinge using the Eigen vector method. Determine the
standard deviation of the fit relative to the data. Plot the data as poles to bedding, and plot the
best-fit hinge on the stereogram. Plot the great circle at 90E to the best-fit  hinge. Also plot the pair
of conical surfaces that lie at two standard deviations on either side of the least-squares cylindrical
girdle– this describes the 95% confidence belt.

Table 2- Bedding attitudes for Problem 2.

N 73 W 64 W N 45 W 90 E N 56 W 77 W N 00 E 50 E

N 21 W 68 E N 03 E 42 E N 55 W 74 W N 15 W 54 E

N 75 W 53 W N 06 W 56 E N 54 W 82 W N 25 W 61 E

N 76 E 43 E N 17 W 57 E N 81 W 51 W N 88 W 51 W

N 83 E 52 E N 28 W 66 E N 10 W 50 E N 69 W 64 W

N 88 E 46 E N 25 W 72 E N 16 W 68 E

N 73 E 49 E N 81 W 60 W N 43 W 80 E

N 70 W 66 W N 71 W 59 W N 38 W 76 E

N 15 W 62 E N 64 W 65 W N 33 W 80 E

N 85 W 58 W N 66 W 70 W N 30 W 73 E

Make sure the following appear on the stereonet for Problem 2:
1. Data and Eigen vectors plotted correctly (10 points).
2. Orientation of best-fit fold girdle (great circle) and fold hinge (plotted as a dot plus cross)  with
trend and  plunge listed (10 points).
3. Two-Standard Deviation cone of confidence plotted and listed (10 points).
4.  χ2 listed with histogram plotted (10 points).
5. R2 goodness of fit listed (10 points).

Problem 3. Below are foliation measurements from the eastern Blue Ridge of Alabama. The data
come from a terrane that has experienced more than one folding event, therefore, the folding of
foliation is conical in nature rather than cylindrical. Plot the data as poles to foliation on the
stereonet, and calculate the best-fit conical axis. Determine the standard deviation of the conical
surface. Plot and label the conical surface and cone axis on the stereonet. Plot the pair of conical
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surfaces that lie at ± two standard deviations relative to the least-squares conical surface.

Table 3- Foliation attitudes for Problem 3.

N 38 W 40 W N 08 E 68 W N 19 W 62 W N 06 W 64 W

N 34 W 51 W N 10 W 78 W N 01 E 76 W N 02 W 74 W

N 24 W 53 W N 54 W 34 W N 16 W 57 W N 12 W 68 W

N 12 W 60 W N 06 E 80 W N 27 W 56 W N 19 W 65 W

N 08 W 70 W N 26 W 64 W N 29 W 45 W N 40 W 50 W

N 09 E 75 W N 07 W 56 W N 47 W 44 W

N 17 E 72 W N 22 E 24 E N 44 W 37 W

N 30 E 85 W N 65 E 18 E N 31 W 49 W

N 41 E 80 W N 88 W 30 W N 58 W 40 W

N 14 E 80 W N 58 W 30 W N 43 W 32 W

Make sure the following appear on the stereonet for Problem 3:
1. Data and Eigen vectors plotted correctly (10 points).
2. Orientation of best-fit conical surface (small circle) and cone axis (plotted as a dot plus cross) 
with trend and  plunge listed (10 points). Apical angle (K) should be listed.
3. Two-Standard Deviation cone of confidence plotted and listed (10 points).
4.  χ2 listed with histogram plotted (10 points).
5. R2 goodness of fit listed (10 points).
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EXERCISE 10B: Stereograms and Statistical Techniques

In this lab you will apply statistical techniques discussed in class to actual orientation data. In the
below exercise you will use NETPROG to calculate best-fit statistics on 3 separate problems
demonstrating vector, cylindrical and conical data distributions. A measure of the “goodness-of-fit”
will be calculated and plotted, and a χ2 statistic will be used to evaluate whether the data distribution
is “normal” or “non-normal”.

Problem 1. Below is a set of measured orientations of a linear platinum-bearing zone collected by
a mining company. The company wants to sink a mine shaft along the zone and therefore needs an
average orientation determined from the data. You are a geologist employed by a consulting firm
and your supervisor has  assigned to you the task of analyzing the data for the mining company. The
head of the mining company - a person well versed in statistics, but not in structural geology -
informs you that contouring the data and "eyeballing" an average orientation is not good enough;
he wants a statistical determination of the average orientation of the data, and a statistical measure
of the goodness of fit. Determine the best-fit (mean) vector to this data set using the eigen vector
method, and determine the standard deviation about the best-fit vector in degrees. Plot the data as
points on a stereonet, and plot the position of the best-fit vector. Assuming that the data is normally
distributed about the  mean vector, plot on the stereonet a "cone of confidence" that should contain
over 90% of the data (i.e. 2 standard deviations).

Table 1- Mineralized zone linear attitudes for Problem 1.

N 51 E 45 N 59 E 42 N 66 E 35 N 57 E 43

N 48 E 42 N 60 E 36 N 64 E 25 N 62 E 33

N 47 E 35 N 59 E 36 N 84 E 53 N 64 E 27

N 48 E 25 N 58 E 29 N 79 E 48 N 73 E 40

N 58 E 52 N 59 E 24 N 71 E 40 N 71 E 43

N 60 E 44 N 62 E 35 N 68 E 30

N 53 E 41 N 75 E 51 N 70 E 28

N 55 E 33 N 70 E 46 N 79 E 38

N 68 E 50 N 67 E 48 N 76 E 40

N 65 E 45 N 69 E 38 N 53 E 23

Make sure the following appear on the stereonet for Problem 1:
1. Data and Eigen vectors plotted correctly on stereonet (10 points).
2. Orientation of best-fit vector (plotted as a dot plus cross and list the plunge and bearing) (10
points).
3. Two-Standard Deviation cone of confidence plotted and labeled (plotted as a conical surface on
stereonet) (10 points).
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4.   χ2 statistic listed on stereonet with histogram (10 points).

Problem 2. Below are strike and dip measurements of bedding taken from a cylindrical fold system.
Determine statistically the orientation of the hinge using the Eigen vector method. Determine the
standard deviation of the fit relative to the data. Plot the data as poles to bedding, and plot the
best-fit hinge on the stereogram. Plot the great circle at 90E to the least-squares  hinge. Also plot the
pair of conical surfaces that lie at two standard deviations on either side of the least-squares
cylindrical girdle– this describes the 95% confidence belt.

Table 2- Bedding attitudes for Problem 2.

N 44 W 80 E N 13 W 71 W N 20 W 77 W N 48 E 43 W

N 17 E 54 W N 57 E 37 W N 24 W 86 W N 30 E 42 W

N 42 W 72 E N 32 E 44 W N 23 W 78 W N 18 E 49 W

N 64 W 59 E N 26 E 44 W N 47 W 70 E N 53 W 69 E

N 65 W 66 E N 10 E 50 W N 42 E 44 W N 38 W 83 E

N 55 W 64 E N 11 E 57 W N 23 E 55 W

N 68 W 64 E N 54 W 83 E N 09 W 61 W

N 39 W 85 E N 39 W 78 E N 03 W 58 W

N 29 E 55 W N 33 W 84 E N 02 W 59 W

N 51 W 76 E N 35 W 89 E N 06 E 56 W

Make sure the following appear on the stereonet for Problem 2:
1. Data and Eigen vectors plotted correctly (10 points).
2. Orientation of best-fit cylindrical hinge and girdle great circle (hinge plotted as a dot with a cross
and list the plunge and bearing) (10 points). 
3. Two-Standard Deviation cone of confidence plotted and value listed on stereonet (10 points).
4.  χ2 statistic listed on stereonet with histogram plotted (10 points).
5. R2  listed on stereonet (10 points).

Problem 3. Below are foliation measurements from the eastern Blue Ridge of Alabama. The data
come from a terrane that has experienced more than one folding event, therefore, the folding of
foliation is conical in nature rather than cylindrical. Plot the data as poles to foliation on the
stereonet, and calculate the best-fit conical axis using Ramsay’s method. Determine the standard
deviation of the conical surface. Plot and label the conical surface and cone axis on the stereonet.
Plot the pair of conical surfaces that lie at ± two standard deviations relative to the least-squares
conical surface.
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Table 3- Foliation attitudes for Problem 3.

N 24 W 23 E N 64 E 39 W N 70 W 29 E N 85 E 34 W

N 42 W 27 E N 89 W 40 E N 76 E 46 W N 79 E 44 W

N 60 W 25 E N 03 E 20 E N 77 W 27 E N 89 W 42 E

N 84 W 30 E N 70 E 51 W N 58 W 35 E N 74 W 36 E

N 83 E 35 W N 64 W 36 E N 47 W 24 E N 33 W 28 E

N 65 E 46 W N 86 E 26 W N 16 W 27 E

N 54 E 45 W N 76 E 50 E N 06 W 21 E

N 44 E 62 W N 59 E 38 E N 45 W 20 E

N 34 E 66 W N 33 E 31 E N 00 W 25 E

N 60 E 52 W N 18 E 24 E N 05 E 18 E

Make sure the following appear on the stereonet for Problem 3:
1. Data and Eigen vectors plotted correctly (10 points).
2. Orientation of best-fit conical hinge and conical small circle (hinge plotted as a dot with a cross; 
 trend and plunge, and conical angle listed on stereonet (10 points).
3. Two-Standard Deviation cone of confidence plotted and listed on stereonet (10 points).
4. χ2 listed on stereonet along with histogram (10 points).
5. R2 listed on stereonet.  (10 points)
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LABORATORY 11: Stress Analysis

I. Stress Field Ellipsoid

A) Any state of stress can be fully represented by the stress ellipsoid. The stress ellipsoid is a triaxial
ellipsoid that is defined by three axes of different length:

1. σ1: maximum normal stress axis.
2. σ2: intermediate normal stress axis.
3. σ3: minimum normal stress axis.

For conditions of lithostatic stress, the above stress axes are equal in magnitude and therefore no
plane that passes through a body subjected to a lithostatic stress will have a shear stress.

B) Note that all three axes are mutually perpendicular. Also there are unique directions of normal
stress for σ1 and σ3 (maximum and minimum normal stress) but there are an infinite number of
normal stress directions equal to σ2 that are arrayed in the two circular sections of the stress
ellipsoid.  The total condition of stress affecting a rock mass can be described as the stress tensor,
which is a second-order tensor.  An single instance of a force acting on an area can be described as
a stress traction.  Both the stress field tensor and stress tractions are second-order tensors, which
means that they cannot be resolved as simple vector quantities.

C) A plane that passes through a body under a stress field that is also perpendicular to one of the
principal normal stress directions will have no shear stress (τ) on it. Any other plane will have some
value of shear stress upon it.

D) The stress ellipsoid is extremely useful in predicting fault and joint formation in real rocks under
a stress field. A graph termed the Mohr Circle Diagram has been developed to determine the
magnitude of normal stress and shear stress on any plane that passes through the rock mass
subjected to a stress tensor. The orientation of the principal axes of the stress ellipsoid and the
fracture planes can be tracked on the stereonet.

E) The development of a fracture plane to form a fault or joint will occur in a rock mass when the
ratio of τ/σ reaches a critical value. The locus of these critical values is termed the Mohr fracture
envelope that can be empirically determined for any rock by experimental means.

II. Mohr Circle Diagram

A) The Mohr circle is a circle plotted on a (X, Y) graph defined by normal stress values (σ) along
the x axis and shear stress (τ) along the y axis. The diameter of the Mohr circle is defined by the
position of σ1 and σ3 on the x axis. Note that σ2 is essentially ignored on this diagram since fractures
are parallel to the intermediate axis.

B) The below diagram is an example of a Mohr circle graph with the fracture envelope plotted. The
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Figure 11-1 : Example of the Mohr stress circle with fracture envelop.

two fracture planes labeled A and B are termed the conjugate fractures because, if the rock is
mechanically homogenous, the two fractures will form simultaneously and symmetrically about the
maximum normal stress direction.

C) The perimeter of the circle represents all of the possible stress states on planes passing through
the center of the stress field. The center of the circle is fixed by the lithostatic stress value which is
dependent on the burial depth. The angle along the perimeter of the circle from σ3 to the point of
interest is termed the 2θ angle. For fracture (A), 2θ is +60E, whereas for fracture plane (B), 2θ is
-60E.

D) The conjugate fracture planes (A) and (B) have equivalent σ and τ magnitudes, however, (A) has
dextral (+) sense of shear, while (B) has sinistral (-) sense of shear. Also note that on the Mohr
Circle diagram in Figure 11-1 that the 2 theta (2θ) angle  is  measured clockwise from σ3 for
positive values of τ.

E) The below Figure 11-1 diagram displays the relationship of the principle stresses and shear
planes with respect to an actual physical specimen that is deformed under laboratory conditions.
Note that the shear plane has a dextral sense of shear and therefore a positive value of τ. This means
that if the angle measured from the shear plane to σ1 is clockwise, then τ is positive and the sense
of shear must be dextral. Likewise, an anticlockwise angle measured from the fracture plane to σ1
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Figure 11-2 : Actual physical test specimen for
Mohr circle example.

defines a negative τ shear plane. Remember that this rule is used when viewing the actual physical
sample. Also noteworthy is the fact that within in the physical specimen if two conjugate shear
planes from, that  σ1 will bisect the acute angle and  σ3 the obtuse angle.

III. Constructing the Mohr Circle Graph

A) The construction of the Mohr Circle graph assumes that σ is plotted on the X axis, and τ  on the
Y axis. This is normally done on standard 10sqi graph paper, or alternatively with the charting
capabilities of a spreadsheet application. If the graph is plotted manually, care should be taken
selecting the range of the X and Y axes to ensure that the Mohr Circle will fit on the sheet of paper.
It is usually necessary to place the Y axis at sigma values greater than 0 because sigma may be large
compared to tau. The scale of both axes should be equivalent (i.e. one inch = 200 bar).

B) If the maximum and minimum values of σ are known, the Mohr circle can be plotted by
constructing a circle that passes through those points on the x axis, and which has a center halfway
between the two points. Mathematically the center of the circle is (σ1 + σ3)/2.

C) If the stress state of two planes that pass
through the stress field are known (σ and τ),
these two points must fall on the perimeter
of the Mohr circle. The perpendicular
bisector of the chord between these two
points will cross the x axis at the center of
the circle.

IV. Determining the Attitude of Stress Axes
and Fracture Planes

A) In addition to the magnitude of the
principal stress axes, the geologist must
also relate the orientation of the stress
ellipsoid to a "real-world" coordinate
system. The most convenient device for
accomplishing this is the stereonet with
geographic north indexed in the standard
way.

B) The following rules should serve as
guidelines for plotting stress filed elements:

1. Remember that the three
principal stress ellipsoid axes are
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mutually perpendicular, therefore, if the attitude of any two of the axes are determined the
other third must be located 90E to the plane that contains the other two.

2. Conjugate shear planes always intersect at the intermediate normal stress axis σ2  axis.

3. The maximum principle stress, σ1, bisects the acute angle formed by the conjugate shear
planes (see Figure 11-2). Likewise, the minimum principle stress  σ3 must bisect the obtuse
angle formed by the conjugate shear planes.

4.If the 2θ is measured from the Mohr circle plot, remember that in reality, θ is the angle that
the fracture plane makes with σ1. A common mistake is to use θ as if it where the angle that
the fracture plane makes with the minimum normal stress direction (σ3) because that is the
reference from which 2θ is measured on the Mohr stress circle.

5. To determine the sense of shear on a fracture plane plotted on the stereonet it may be
necessary to rotate the entire diagram until the σ1-σ3 is horizontal.

C) Remember that the Mohr circle graph can determine magnitudes of stress for any plane passing
through the stress field, and it can determine a 2θ value. It cannot, however, yield any information
about the orientation of the stress ellipsoid axes or the fracture planes.

D) The stereonet can solve for the attitude of the stress ellipsoid axes and shear planes, however, it
cannot yield any information on the magnitude of the stresses.

V. Mathematical Basis for Mohr Circle

A) The Mohr circle can easily be expressed as a function of the maximum and minimum normal
stress values. With the below equations the stress state of any plane passing through the stress field
can be calculated:


   





1 3 1 3

2 2
2cos( )


 


1 3

2
2sin( )

where σ and τ represent the normal and shear stress respectively acting on the plane of interest
subject to a stress tensor of magnitudes σ1 and σ3.  The angle θ is the angle that the plane of interest
makes with σ1 measured clockwise from the plane to σ1.  Furthermore,  θ must be less than 90E in
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absolute magnitude, therefore, if the angle less than 90E is measured counterclockwise from the
plane to the σ1 direction, then  θ is negative.
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EXERCISE 11A: Mohr Circle and Stress Calculations 

Problem 1. Given the following orientations for the principal stress axes: 

σ1 :  0E, N90EE 
σ3 :  90E, N0EE 

find the orientation of σ2. If the θ angle is 20E for conjugate fractures, plot both shear planes on the
stereonet along with the principal normal stress directions (σ1, σ2, and σ3) labeled. As observed from
the south looking to the north, label the conjugate shear planes in terms of the sense of shear
movement- sinistral or dextral. If the conjugate shears are considered to be faults, how would you
classify each fault? Determine and report the attitude of each shear plane.

Problem 2. Assume that: 

σ1 = 2050 bars      50E, N40EE 
σ3 = 1600 bars      24E, S18EE

Scale: 1"=200 bars

What is the maximum value of τ (shear stress) along any plane that passes through a body under the
above stress state (determine graphically)?  What is the orientation of σ2 (determine on the
stereonet)?  What are the orientations of the body planes that have maximum ± τ values (determine
on the stereonet)? Report the sense of shear for each plane with your answer.

Problem 3. Given the following values of σ and τ stress for two planes passing through a body under
a stress field: 

σ τ Orientation

1. 1800 100 N0EE, 50EW 

2. 2100 200 N64EE, 30ENW 

Find the values of σ1 and σ3 (graphically). On a stereonet plot the orientation of the two planes, along
with the orientations of σ1, σ2, and σ3. Report the values of 2θ for each shear plane
Scale: 1"= 200 bars.
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EXERCISE 11B: Mohr Circle and Stress Calculations 

Problem 1. Given the following orientations for the principal stress axes: 

σ1 : 000E, 00E 
σ3 : 000E, 90E

find the orientation of σ2. If the θ angle is 30E for conjugate fractures, plot both shear planes on the
stereonet along with the principal normal stress directions (σ1, σ2, and σ3) labeled. As observed from
the east looking to the west, label the conjugate shear planes in terms of the sense of shear
movement- sinistral or dextral (use a “+” or “-“ sign next to the great circle). If the conjugate shears
are considered to be faults, how would you classify each fault? Determine and report the attitude of
each shear plane.

Problem 2. Assume that: 

σ1 = 2500 bars      060E, 50
σ3 = 1500 bars      155E, 40

Scale: 1"=200 bars

Plot σ1, and  σ3 on a stereonet. What is the maximum value of τ (shear stress) along any plane that
passes through a body under the above stress state (determine graphically)?  What is the orientation
of σ2 (determine on the stereonet)?  What are the orientations of the shear planes that have theta
angles of 30E  (determine on the stereonet)? What are the values of normal and shear stress on these
shear planes (determine graphically)? Label the shear plane great circles with (+) and (-) for dextral
and sinistral sense of shear as viewed in the down-plunge direction of σ1.

Problem 3. Given the following values of σ and τ stress for two shear planes passing through a body
under a stress field: 

σ τ Orientation

1. 2646 -402 340, 40 NE

2. 3748 54 070, 60 SE

Find the values of σ1 and σ3 (graphically). On a stereonet plot the two shear planes, along with the
orientations of σ1, σ2, and σ3. Report the values of θ for each shear plane
Scale: 1"= 200 bars.
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Figure 12-1 : Simple shear of initially random ellipsoidal pebbles to form
a preferred orientation of strain ellipsoids.

LABORATORY 12: Strain Analysis

I. Strain Analysis

A) Strain markers must be present in rock before strain can be analyzed.

B) There must be little or no mechanical difference between strain marker and matrix,
otherwise the strain analysis may be invalid.

Examples of low mechanical contrast
1. Oolites in limestone
2. Quartz pebbles in a quartzite (Metaconglomerate)

C) In practice most strain markers are not perfectly spherical in the undeformed state- if they
were we could directly measure the dimensions of any individual ellipsoid to obtain the finite
strain ellipse dimensions.

D) Field analysis of deformed rocks  generally assumes homogenous plane strain (constant
volume conditions) because it greatly simplifies calculations and is valid if the  dilation
component of strain is not significant.

E) We assume that strain markers began as randomly oriented ellipsoidal objects before
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deformation, such as pebbles in a stream bed. If strain is truly homogenous the original
ellipsoids will still be ellipsoidal after deformation.  The ellipsoids will display a
dimensional preferred orientation after deformation.  Note that non-random original
orientations will still produce a preferred attitude after deformation, however, it may
invalidate analysis of strain using the hyperbolic net, and the RF/Φ method described below.

F) Φ is the measured angle that the X axis of an elliptical strain marker makes with some
reference direction.  Usually this direction is chosen to be a significant tectonite direction,
such as the trace of S1 at the exposure. In addition to Φ, the axial ratio (X/Z) is measured as
the RF  value for each ellipse.

G) The finite strain ellipse should be imagined to be the ellipsoid body that result from the
deformation of an original sphere with diameter equal to 1.0 length.  This body is also
imagined to have suffered all deformation affecting the rocks under consideration.  Usually
one of the goals of kinematic analysis is to find the dimensions and attitudes of the axes of
the finite strain ellipse.  The ratio of the X and Z axes of the finite strain ellipse (X/Z) is
referred to as RS.  Likewise, the angle that the finite strain ellipse makes with the chosen
reference direction is termed ΦS.

II. Use of the Hyperbolic Net (De Paor's Method)

A) After RF and Φ values are tabulated for all strain marker ellipses, they are plotted on a
special projection termed the hyperbolic net. The goal of this procedure is to determine the
RS and ΦS values for the total finite strain ellipse. The hyperbolic net uses the relationships
demonstrated in Figure 12-1 above to define the "best-fit" hyperbolic curve relative to the
data.

B) Data is plotted on the hyperbolic net after the Φ and  RF  values are tabulated:

1. Rotate the overlay so that the Φ angle position is at the due north point of the
primitive. Positive angles are to the clockwise of the "R" reference tic, negative
angles are counterclockwise.

2. From the center of the net move up along the vertical line until the hyperbolic
curve that corresponds to the value of  RF is found. Mark a dot at this point.  Note
that the center of the net begins at a value of 1.

3. Continue with steps (1) and (2) above until all data is plotted.

C) After plotting the data on the net, follow these steps:
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Figure 12-2 : Plot of strain axes and foliation.

1.  Sketch a smooth line around all of the data points.  The polygon thus formed
should be as “simple” as possible (i.e. lowest number of sides).

2. Find the north-south line on the overlay that divides the data distribution into
equal area halves. This line defines the ΦS direction angle.

2. Find the “best-fit” hyperbolic curve that splits the data into 25% area quarters.
This hyperbolic curve defines the value of the axial ratio (X/Z) for the finite strain
ellipse.  This value is RS. After drawing this curve on the overlay, the four quadrants
defined by the ΦS and RS curves should divide the data into roughly 25%
proportions.

D) Note that if the data deviate significantly from the 25% per quadrant rule the strain
markers probably had a preferred attitude before deformations. This may invalidate the RF/Φ
method.

E) If we assume plane
strain, and, therefore, constant
volume throughout deformation, we
can calculate the actual dimensions
of the finite strain ellipsoid
assuming a convenient pre-
deformation diameter, such as 1 unit
length. This in turn allows the
calculation of stretch (S) values in
the principle directions. Once these
values are determined, we can
calculate, using the general Mohr
circle strain equations, the values of
λ, γ, Ψ, and α for any direction
defined as θd.

III. Plotting the Attitude of the
Finite Strain Ellipse

A) The X, Y, and Z axes of
the finite strain ellipsoid are
mutually perpendicular,
therefore, any one of these
axes will be the pole to the
plane defined by the other
two axes.  Since geologists usually purposely find the X-Z plane and measure the attitude
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of this plane at the exposure, usually the Y axis is assumed to be the pole to the XZ plane.

B) Oriented sample must be taken and labeled in the field if one is to calculate the attitude
of the finite strain axes.  In the field this is done by physically drawing the strike and dip
lines on the X-Z surface of the sample before it is disturbed.  In this way the sample may be
re-oriented in the laboratory.

C) It is often possible to relate the finite strain ellipse to tectonite fabric elements such as S1

foliation.  Stretching lineations tend to develop parallel or sub-parallel to the X axis, and are
oriented in the X-Y plane. The S1 foliation plane is often equivalent to the X-Y plane,
therefore, plots of lineation data may fall systematically along the S1 great circle.
Alternatively, plots of poles to S1 will plot in the vicinity of the minimum elongation (X) of
the finite strain ellipse.

IV. Solving for the Dimensions of the Finite Strain Ellipse

A) If plane strain is assumed, we know that the starting reference sphere and the resulting
finite ellipsoid will have the same volume.

B) Mathematical proof:

Given:
Vi = volume of undeformed sphere with radius r.
r = 1.0
Vf = volume of final ellipsoid that is the product of the homogenous deformation of
the initial sphere of volume Vi. The (X, Y, Z) directions of the ellipsoid are parallel
to the (a, b, c) directions in the below figure:
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Figure 12-3 : Undeformed and deformed strain marker reference used for derivation of
formulae.

RS = ratio of X to Z for the finite strain ellipse.

Find: Dimensions of the total finite strain ellipsoid assuming that the original sphere
is deformed by plane strain. Under these conditions the initial sphere and final
ellipsoid should have equal volume:

Vi = Vf

Vi = (4/3)πr3

VF = (4/3)πabc

Setting both volume equations equal to one another we can simplify to:

r3 = abc

Because the deformation is via plane strain, the length of b should equal the original
length r:

r2 = ac

In the original definition of the proof r = 1, therefore:
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1 = ac

Now we can use the definition of RS to solve simultaneous equations:

RS = X/Z = 2a/2c = a/c

Substituting into the above equation:

a = RS c
1.0 = (RS)(c)(c)
1.0 = RS c

2

c = Sqrt(1/RS)

Therefore:

a = 1/c = Sqrt(RS)

With these equations you can convert the RS value measured from the hyperbolic net directly
into the dimensions of the finite strain ellipse. From the dimensions the axial stretch values
can be calculated:

SX = a/r = a = Sqrt(RS)
SZ = c/r = c = Sqrt(1/RS) 
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EXERCISE 12A: Strain Analysis

Problem 1

In Figure 12-4 is a photograph of deformed ooids in limestone. Assuming that the ooids have been
affected by homogenous plane strain, conduct a strain analysis using the hyperbolic net (De Paor's
method). Use the traced outlines of the ellipsoids in Figure 12-5 to measure RF and Φ. Measure Φ
relative to the N32W reference line in Figure 12-5.  Report your measurements with a table
organized as follows:

No. X(inches) Z(inches) RF Φ

1 0.822 0.590 1.393 -4
2 0.665 0.481 1.383 6
. . . . .
. . . . .

After finding RS and ΦS, your goal will be to find the dimensions of the strain ellipsoid (i.e. the total
finite strain ellipsoid) that before deformation is assumed to have been perfect sphere with a
diameter of 1.0. When the dimensions are known, calculate the S (stretch value) for the X and Z
directions of the total finite strain ellipse. Remember that if you can assume homogenous plane
strain, then you can also assume that each ooid maintains constant volume in three dimensions and
area in two dimensions before and after deformation. Assuming that the surface in Figure 12-5
approximates the X-Z plane of the strain ellipsoid, and that foliation is perpendicular to this surface,
plot the (X, Y, Z) directions of the total finite strain ellipse on the stereonet. Assume that the
reference line in Figure 12-5 is the strike of the foliation , and that the dip of the foliation is 25SW.
Plot and label the foliation plane  and the X-Z plane on the stereonet as great circles

Problem 2

In Figure 12-6 are the traced and numbered outlines of deformed pebbles in a sample (CA-23) of
the Cheaha Quartzite. At the outcrop where this sample was collected the foliation attitude was
N10E, 35SE. In Figure 12-6, two parallel sides of the slabbed sample are traced so that you can
measure the X/Z ratios on both sides. Note that the trace line of the S1 foliation is to be used as the
Φ reference line on both faces of the sample. The sides of the slabbed sample are to be assumed to
be cut perpendicular to S1 foliation.  In addition, you are to assume that the trace of S1 on both sides
of the slab in Figure 12-6 are parallel to the strike line (N10E) of foliation. Use the hyperbolic net
to calculate RS and ΦS for the deformed pebbles.  Use a table organized as in Problem 1 to report
your measurements. From those measured values, calculate the dimensions of the total finite strain
ellipse assuming plane strain and a starting reference sphere with diameter equal to 1.0. Calculate
the stretch values parallel to the X and Z directions, and plot the (X, Y, Z) axis attitudes of the finite
strain ellipse on the stereonet. Also plot the “slab plane” and the foliation lane as great circles, and
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label them on the stereonet. Calculate the values of λ, S, γ, Ψ, and α for a line in Figure 12-6 parallel
to the long axis of pebble #25.
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EXERCISE 12B: Strain Analysis

Problem 1: Given the Figure 12-8 photograph of a meta-conglomerate exposure, measure the
length/width ratio of the strain markers and generate:

a. Spreadsheet that tabulates the length, width, and RF. Use the cleavage trace as the  
reference.
b. Hyperbolic net plot (Figure 12-7) with finite strain ellipse  and RF indicated.

Problem 2: Plot the dimensions and orientation of the finite strain ellipsoid on the meta-
conglomerate photo at any convenient location. Use Paint Shop Pro to retro-deform the photograph
to its pre-deformation geometry. To retro-deform the image follow these steps:

Step 1: Plot the finite strain ellipse on the image. The major axis should be oriented according to the
finite strain ellipse  angle calculated in problem 1. You can make the ellipse any convenient size-
just make sure that the Rf ratio calculated in problem 1 is preserved.

Step 2: Scan the meta-conglomerate photograph with the finite strain ellipse plotted on it. Load the
image into Paint Shop Pro and then use the "Image > Rotate > Free Rotate" menu option to rotate
the major axis of the finite strain ellipse parallel to the horizontal.  Turn on the window rulers with
"View > Rulers". Note the horizontal length of the image on the ruler.

Step 3: Use the select tool to highlight the entire image. Use the far right handle and the select tool
to drag the image to the right until the major axis is shortened to match the length of the minor axis.
The minor axis should be vertical so it should not change its length. Use the ruler to make sure the
major axis matches the length of the minor axis. The finite strain ellipse should now be a perfect
circle. The image is now retro-deformed so its appearance now is the same as the pre-deformation
shape. Print this image to turn in as the problem 2 answer. Make sure the finite strain ellipse- now
a circle - is labeled clearly. 
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Figure 12-4 : Scanned photograph of deformed ooids in limestone.
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Figure 12-5 : Tracing of the deformed ooids in Figure 12-4. Use this to calculate RF and
Φ.
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Figure 12-6 : Tracing of deformed pebbles in Cheaha Quartzite. Two parallel faces of the
same sample (CA-23) are displayed.
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Figure 12-7 : Hyperbolic stereonet.
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Figure 12-8 : Photograph of deformed pebbles in a metaconglomerate with the cleavage direction
indicated.
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LABORATORY 13: Fault Displacement Vectors

I. Introduction to Fault Translation

A) If there is no rotational component to a fault motion every point in the displaced mass of
rock is translated along vectors that are everywhere equal in magnitude and direction. This
condition is referred to as pure rigid-body  translation.

B) Note that if we are assuming a rigid-body deformation mechanism, there can be no
distortional nor dilational component of strain internal to the fault block.

C)  If the fault surface is not perfectly planar in the direction of net slip then the fault must
have some component of rotation, however, we can often define the scale of the fault
problem such that the amount of curvature is very small, therefore, the rotational component
may be ignored.

II. Apparent Translation (Separation)

A) Often the net slip vector of a fault is unknown because the offset geometries are planar,
such as the trace of strata or dikes. Offset planes, by themselves, will never indicate the net
slip vector unless additional information is available.  Sometimes the intersection of two
non-parallel structural planes provides a linear structure offset by the fault that allows for
the calculation of net slip.

B) To determine the net slip, a linear structure must be identified in both fault blocks that
was continuous before faulting. The vector that connects the piercing point of both linear
elements defines the net slip vector if its direction and magnitude is measured within the
fault plane.

C) When the structures that are offset by the fault are planar, the offset is apparent and must
be classified as separation instead of slip. For example, if offset strata in the vertical wall
of a quarry indicate hanging-wall down motion of 100 meters, the fault should be classified
as having 100 meters of normal separation. The term separation indicates that, in this
specific case, the normal fault motion is apparent and in fact could be purely strike slip
translation.  The reader should note that in most cases the geologist investigating a fault
“sees” separation not slip- only later analysis in the office will provide an estimate of the net
slip direction and magnitude using methods outlined below.

D) When the terms “reverse fault slip fault” or “right lateral strike slip fault” are used, you
should assume that the person describing the fault translation has determined that the offset
is true net slip and not apparent separation. However, proceed with caution on this
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assumption because some geologists (who should know better), and virtually all engineers,
erroneously classify faults with “slip” terms when all that is known about the fault
translation is apparent separation from offset planar structures.

III. Net Slip

A) The goal of any kinematic analysis of fault displacement is the solution of the net slip
vector. Once the net slip vector is determined it is resolved into two components:

1. Strike slip component- that component of the net slip vector that can be projected
to the strike line of the fault surface.

2. Dip slip component- that component of the net slip vector that can be projected to
the down-dip direction on the fault surface.

B) Faults that have significant components of both the strike slip and dip slip vectors are
termed oblique slip faults. Almost all natural faults are oblique slip although many have one
or the other component dominating the oblique slip. The naming convention of oblique slip
faults is as follows:

{minor slip component} {major slip component} slip fault

C) For example, if the net slip vector can be resolved into 500 meters of left-lateral strike
slip and 100 meters of reverse dip slip, the fault is thus named as:

reverse left-lateral strike slip fault

D) In any kinematic analysis of the net slip, it is important to plot the attitude of the net slip
vector since this the direction of travel of displaced points within the fault block that is
considered to move relative to the other block. For example, if you were a geologist trying
to find a linear ore body that was truncated by a fault, the attitude of the net slip vector
would indicate the tunneling direction within the fault plane to find the offset continuation
of the ore body in the adjacent fault block.

E) Some of the more common linear structures that are used to solve for net slip include the
lines of intersection of non-parallel planes, fold hinges, river channel deposits, i.e. any linear
structure that can be recognized in both fault blocks that was a continuous line before fault
propagation. These include angular unconformities and intersecting dike phases.

IV. Rotational Faults
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Figure 13-1 : Example of traces of rotated dikes A and B.

A) Rotational faults are usually easy to recognize because, unlike pure translational faults, they
change the attitude of the same planar structure from one fault block to another.  Pure translation
may offset a planar structure, but it cannot change the attitude of the structure.

B) The goal of kinematic analysis of rotational faults is to find the point in the fault plane that is the
piercing point of the rotational axis, and to find the angular magnitude and sense of the rotation.
Note that, in all cases, the rotational axis must be perpendicular to a planar fault surface.

C) The angular amount of the rotation can be measured by plotting the trace of the same planar
element as it exists in both fault blocks.  The angle between the two traces represent the magnitude
of the rotation.  Inspection of Figure 13-1 also determines that the sense of rotation from A to A’
is clockwise.  The same is true of B to B’.  Since A and B are in the north block, and A’ and B’ are
in the south, then the clockwise rotation is the motion of the south block relative to the north
block as view looking from
the south block

D) The position of the
rotational axis in the fault
plane can be found by
finding a pair of  points
from both fault blocks that
where superimposed before
faulting (point X and Y in
Figure 13-2). The point of
rotation must lie along the
perpendicular bisector of
the line connecting these
two points. The common
p o i n t  m a y  b e  t h e
intersection of two non-
parallel dikes in a single
fault block (see Figure 13-
1). The exact position of the
rotational axis piercing point
must match the angular
amount measured in (C),
and must match the correct
sense of rotation indicated
by the traces of the offset
planes.  In  Figure 13-2
above, the rotational axis R2
gives the correct clockwise
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Figure 13-2 : Calculation of rotational axis position.

sense of rotation for the displacement of X (north block) to position Y (south block) using the
convention of keeping the north block motionless and inspecting how the south block was rotated
relative to the north block as viewed from the south block.  The reader should note that is we reverse
either of the criteria, the viewing direction or the relative motion of fault blocks, the sense of rotation
would be reversed.
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EXERCISE 13: Fault Solutions 

Problem 1. The plane of a normal-slip fault strikes N0EE and dips 60E to the west. The fault
displaces a structural plane (N90EW, 30EN) which shows 100 meters of left-separation. What is the
amount of the net slip? Report the amount and direction of the rake angle used to solve the problem
on the stereonet.
SCALE: 1 inch =100 meters 

Problem 2. A fault (N90EW, 60EN) cuts two structural planes: Plane 1=N45EW, 30ENE; Plane
2=N50EE, 45ENW. The amounts and senses of separation are shown in Figure 13-3. What is the
amount and orientation of the net slip; what are the dip-slip and strike-slip component magnitudes?
Classify the fault according to minor-major slip sense of motion. Finally, calculate the rake angle
of the net slip vector in the plane of the fault. Report the amount and direction of the rake angles
used to solve the problem on the stereonet.
SCALE: see Figure graphical scale.

Problem 3. A fault (N30EE, 60EW) displaces two planar dikes A and B as shown in Figure13-4.
What is the angle and sense of rotation of the fault motion? Locate the center of rotation which will
account for the observed displacements, and label this point as “R”. Determine the sense of rotation
as viewed from the southeast block looking toward the northwest block, with the southeast block
remaining static, and the northwest fault block rotating due to fault motion. Construct your fault
plane cross-section with SW to the left, and NE to the right. Report the amount and direction of the
rake angles used to solve the problem on the stereonet.
SCALE: see Figure graphical scale.
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Figure 13-3 : Map for problem 2.
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Figure 13-4 : Map for problem 3.
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LABORATORY 14: Down-plunge Fold Projections

I. Introduction

The correct position in which to view a fold in profile is in the plane perpendicular to the hinge line
of the fold. In other words, you should view the fold looking directly parallel to the hinge line. The
reason that this is important is because viewing a fold in a plane oblique to the hinge will cause a
true parallel fold geometry to appear to be similar in shape. Remember that similar and parallel
geometries imply something about the origin of the fold:

Parallel Fold: a fold that maintains constant thickness measured perpendicular to the folded
layer. The deformation mechanism implied by this geometry is slip along bedding planes
which, in turn, implies that deformation is, to a large degree, a brittle phenomenon.

Similar Fold: a fold that maintains a constant thickness measured parallel to the axial plane
of the fold. These folds thicken dramatically in the nose of the fold. The mechanism implied
by this geometry is one of ductile flow. In other words, the layers that are folded were
passive and played no part in the deformation mechanism that formed the fold.

A good example of this effect can be found in the fold and thrust belt of the Appalachian foreland
in the southern Appalachians (the region centered around Birmingham, AL). The folds in the
foreland are parallel geometries in profile, yet, if you observe them in map view they appear to
thicken dramatically in the nose of the fold. The apparent similar geometry has nothing to do with
the fold mechanism but is instead due to the fact that the erosional surface makes a low angle with
the hinge of the plunging folds in this region. In fact, the plunge of the folds are often less than 5
degrees northeast or southwest. To view the folds in a true profile, one would have to project the
map image to a plane that is oriented perpendicular to the fold hinge.

II. Constructing the Down-Plunge Profile Plane

It is always possible to construct the plane of the profile in two alternative but geometrically correct
modes. The plane may be constructed as one would view the profile in a down-plunge or up-plunge
direction. Neither one is more correct but one should clearly label the strike direction of the profile
so that the viewer may correctly orient the diagram. The most common way to proceed is to
construct a down-plunge profile panel therefore the name "down-plunge" projection.

Figure 14-1 displays a complete down-plunge projection construction. The given information is the
geologic map containing a folded layer, and the hinge attitude indicator (30, S0E). The construction
was completed with the below steps:

1. Draw a rectangular grid across the fold using a convenient scale. The actual value of the
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grid size is not important. The grid must be orthogonal to the bearing of the hinge. The base
line of the grid should be the grid line perpendicular to the bearing of the hinge and farthest
in the plunge direction. Number all grid lines parallel to the baseline (1-5 in Figure 14-1).
Remember that the baseline must not cross the fold structure of interest.

2. In this step we construct the grid for the plane of the projection. In Figure 14-1 the
easternmost north-south grid line is labeled as a fold line. Along the fold line are several
arrows indicating the hinge plunge. Note that if we extended the grid lines on the map
surface parallel to the hinge that they would project to the plane perpendicular to the hinge
at a spacing of:

sin
.

30
10


x

where X is the spacing of the projection plane grid. Thus the spacing of the grid lines must
be 0.5 units apart in the projection plane in this specific example. Measure grid lines parallel
to the baseline that are 0.5 units apart and match the number of equivalent east-west grid
lines on the map surface. These are labeled as 1' through 5' in Figure 14-1.

3. After constructing the profile grid, one should identify convenient points on the map
surface where a folded layer crosses a grid line. These points are marked with dot and cross
symbols on the map surface in Figure 14-1. As you follow one of the folded layers, project
each point parallel to the hinge bearing to the equivalent position on the projection plane.
After sufficient numbers of points are projected for a layer you can "connect the dots" to
form the folded layer in the projection plane.

4. Complete step (3) above for all layers that are on the map. Don't forget to label the ends
of the projection baseline with the correct bearings. The projected folds must obey that rules
of plunging folds- antiforms are convex in the direction of plunge, whereas synforms are
concave in the plunge direction. Make sure that all of the projected folds obey this rule. Also
note that in Figure 14-1, more points are needed to correctly trace the portions of the fold
that have high curvature near the hinge zones. You can interpolate as many points as you
judge necessary to define the fold.

5. Using the legend from the geologic map, color or pattern the layers on the profile to match
the information from the map. 

With the true profile of the fold it is now possible to correctly interpret the fold mechanism from the
fold geometry. In Figure 14-1, the axial trace of the fold on the map surface and within the profile
plane is marked by the dashed line. This information could be used to estimate the attitude of the
axial plane since the attitude of the profile plane is known (plane perpendicular to the hinge), and
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the rake angle of the axial trace in the profile plane could be directly measured with a protractor.
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Figure 14-1 : Down-plunge projection construction.
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EXERCISE 14: Fold Projection

Problem 1. Construct a true fold profile using the Figure 14-2 that is included with this exercise.
Assume that the structural plunge (fold axis) of folding is 15E, S65EW. Assume that the topographic
relief in this area is negligible. After constructing the fold profile, describe the nature of the fold
mechanism (parallel or similar?), and compare that to the apparent fold mechanism as judged from
the map pattern. Construct the projection so that the profile is down-plunge, and the southeast end
of the profile is on the right side of the construction. Although the lithologies in Figure 14-2 are
indicated with patterns, you are to color the down-plunge fold profile:

Schist = White (no color)
Marble = Light blue
Quartzite = Yellow
Gneiss = Dark Red

Note that the map scale is metric.  Turn in the profile as an inked copy on vellum.  You may use a
sheet of vellum larger than 8.5x11 inches if you wish.
SCALE: see graphical scale on figure.

Problem 2: With the information from the down plunge projection estimate the axial plane attitude
of one of the folds labeled "X" on your geologic map. Draw the trace of the axial plane of this fold
on the projection and label it with the rake angle value. Plot this information on the stereonet and
calculate the attitude of the axial plane.
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Figure 14-2 : Map for problem 1 projection.
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LABORATORY 15: Constructing Geologic Cross-sections from Geologic Maps.

I. Introduction

A geologic cross-section is used to depict the subsurface structure of a mapping area based on the
geometry of the geologic map. Although some of the cross-section may be based on extrapolation,
as much as possible should be quantified based on the geometry of the geologic map, including the
attitude of map-scale fold axes in folded terranes. Obviously the geologic map and stereographic
statistical analysis should be completed before the cross-section is constructed. 

II. Cross-section Constraints

The geologic map will have lines labeled “A” to “A’” or “B” to “B’” that indicate the position of
the cross-section line. The topographic profile should be constructed from the topographic contours
crossing the line of the cross-section. Although for some purposes vertical enhancement may be used
to emphasize topographic relief, if this is done the apparent dips of geologic structures must also be
recalculated, therefore, this is generally avoided. Use the same vertical scale as the horizontal map
scale if no vertical enhancement (i.e. VE = 1.0) is desired. If computer applications are utilized to
construct the cross-section it is not unusual that contours have different units than X,Y coordinates
remember to convert units. For example, if the coordinate system is UTM the X,Y coordinates will
typically be meters, whereas the contours on 1:24,000 scale maps are in feet. The elevations should
be converted to meters for VE=1.0.

III. Cross-Section Construction Rules

Step 1: Construct the cross-section grid and topographic profile first. Label major topographic,
geologic and geographic features on the profile for reference (i.e. rivers, faults, mountain peaks,
towns,  etc.). It is often useful to label the vertical scale on one side in meters and the other side in
feet.

Step 2: Align a sheet of paper against the line of the cross-section. Mark the ends of the cross-
section with “A” and “A’” (or whatever is appropriate). In addition mark the position of every
geologic contact that crosses the cross-section line. With a stereonet calculate the apparent dip of
the contact relative to the cross-section line (see explanation below; Figure 15-1) . Draw the
inclined contact line using  this apparent dip angle from the point marked on the edge of the paper
keeping in mind the correct dip direction (Figure 15-2). If there is no strike and dip marker for the
contact near the cross-section line then the strike and dip must be estimated using the outcrop trace
and topography. Remember that en echelon or conjugate faults often have similar attitudes. Label
the opposite sides of the contact with the lithologic code for the units on each side of the contact.
If the contact is a major fault make sure to label the fault with its name.
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Figure 15-1 : Example of apparent dip calculation for a
vertical cross-section.

Step 3: Align the sheet of paper used in (Step 2) along the cross-section grid horizontal axis
constructed in (Step 1). Make sure that the correct ends of the cross-section are used during the
alignment. Project the contacts from the (Step 2) paper straight-up vertically to the topographic
profile line, and draw in the apparent dip. Only project the apparent dip a few tenths of an inch into
the subsurface. Remember that the attitude may change quickly, or the contact may be truncated
depending on folding, faulting or angular unconformities. Label the opposite sides of the contact
with the correct lithologic code.

Step 4: Finish sketching the cross-
section lightly in pencil keeping in
mind that it is typical to modify the
contacts several times before
deciding on a final product. If the
cross-section contains major
faults/unconformities it is advisable
to sketch the fault/unconformable
contacts in first since stratigraphic
contacts will truncate against the
fault/unconformity. Drag folding may
occur near fault contacts. Make sure
that arrows of relative displacement
are used on fault contacts. Fault
contacts should have thicker line
work. Stratigraphic thickness should
be preserved unless there is evidence
for map-scale ductile deformation. If
plunging fold hinges are present on
the geologic map the statistical
plunge attitude of the hinge should be
used to project the hinge point of a
contact to the cross-section profile
(see below discussion). Some
speculation may be used. For example, even though granite basement rocks may not outcrop on the
geologic map, if drilling in the area has confirmed the thickness of Paleozoic strata, and the vertical
extend of the cross-section indicates that the base of the Cambrian should appear, it is expected that
the Precambrian basement should appear below the Cambrian strata. Speculative contacts should
be dashed as on the geologic map. Speculative contacts are often projected into the “air” above the
topographic profile to display a complete structural interpretation of folding and/or faulting. 

IV. Apparent Dip Calculation.

The apparent dip of a contact in the cross-section is easily calculated on a stereonet. First, plot the
attitude of the cross-section as a vertical plane on the stereonet (Figure 15-1). The strike of the
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Figure 15-2 : Example of the geometry of plunging folds
and cross-section.

cross-section is the end that trends to a north quadrant, and the dip is always 90. A vertical dip
always plots as a straight line on the stereonet. Label the cross-section great circle so that it is not
confused with some other attitude. Note that if the strike of the contact is close to or 90 degrees to
the trend of the cross-section, the apparent dip is equal to the true dip of the contact. Plot the attitude
of the contact as a great circle. The intersection of this great circle with the cross-section will
produce a point. The rake angle of this point measured in the plane of the cross-section is the
apparent dip to be used on the cross-section. Be careful to correctly note the correct end from which
the apparent dip is measured and use the same end when plotting the contact on the cross section.
For example, suppose that a contact near the cross-section line  measured 030, 75SE is to be
projected to a cross-section line with a 090, 90 attitude (see Figure 15-2). The apparent dip
measured from the stereonet is 73 from the east end of the cross-section line. Therefore, the apparent
dip is 73 with a trend of 090. Note that the apparent dip is always less than the true dip.

Along the line of the cross-section typically there will be contacts that have been mapped to cut
across the cross-section line, however, there may not be any attitude measurements nearby to use
in the apparent dip calculation. In these cases it will be necessary to estimate the strike and dip using
the outcrop trace of the contact and the topographic contours. This in effect is a 3-point type problem
as described in Laboratory 1. If 2 points on the trace of the contact with the same elevation can be
found near the cross-section, the line connecting these 2 points will be the strike of the contact. The
geological contact “Rule of V’s” will indicate approximately the dip amount and direction if a
quantitative 3-point problem cannot be attempted. See the discussion of outcrop patterns in the
“Outcrop Prediction” chapter. 

V. Map-Scale Fold Hinge Projection

A properly constructed cross-section
must take into account the full extent
of the geologic map from which it is
constructed. For example, consider
the geologic map and cross-section
in the Figure 15-2 example. Note
that the contacts that cross the A to
A’ line are projected perpendicular
to the line from the map to the
equivalent topographic surface point.
When the Silurian/Devonian contact
in the plunging syncline is
considered it is evident that the hinge
point will project down-plunge to the
cross-section but at what depth
below the topographic surface? This
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depth can be calculated graphically or mathematically with the trend and plunge of the fold hinge.
In Figure 15-2 the Siluro-Devonian contact hinge point is projected along the trend of the hinge
until intersecting the A-A’ line. A perpendicular line to this line is constructed so it intersects the
plunge angle line constructed from the hinge point origin defines the structural depth (d) below the
topographic surface for the synclinal hinge point. This point is projected perpendicular to the cross-
section line to the equivalent position on the cross-section topographic surface, and then at a depth
(d) below the surface. This point is used to constrain the depth of the Siluro-Devonian contact in the
cross-section. Note that the hinge attitude should be calculated from stereographic analysis of
bedding from the fold area.

15-4



Exercise 15A: Geologic Cross-Sections

Problem 1: Construct a geologic cross-section along line A - A’ on the Geologic Map of the
Wyndale and Holston Valley Quadrangles, Virginia (Figure 15-3). Use a horizontal and vertical
scale of 1:24,000 (1 inch = 2000 feet). Consult with your instructor for drafting media for this
project. The paper should be at least 12 x 18 inches for completing the project. The original map and
a beginning cross-section will be displayed in an area accessible to students. Use the strike and dip
of bedding as data for a stereonet that determines statistically the plunge and bearing of map-scale
fold hinge lines. Use the Figure 15-4 A - A’ grid as a starting point. Turn in the stereonet used to
calculate the hinge attitude of folding from the geologic map. Refer to the Figure 15-2 example for
projection methods. Turn in the stereonet(s) used for calculating the statistical hinge attitude with
your cross-section. 

General Cross-section Guidelines: the below guidelines are generally followed when constructing
geologic cross-sections.

1. Use the same scale for horizontal and vertical scales (V.E. = 1.0) unless you have a very good
reason for doing otherwise. If the V.E. is something other than 1.0 you must correct all apparent dip
and plunge angles for the distortion.

2.  Sedimentary units that project to the cross section should retain their proper thickness in the
subsurface unless there is geophysical or drilling data to the contrary.

3. The projection of major structural features such as fault contacts or fold hinges should be
quantitatively determined from the attitude of the feature on the geologic map even if the structure
does not actually cross the cross section line.

4. It is standard practice to use the known regional stratigraphic column to “interpret” subsurface
structure. 

5. Fault contacts are displayed as thicker line work just as they are on the geologic map. It is normal
practice to assume fault-drag folding in the subsurface to explain the cross section structure. If
relative fault displacement can be determined on the geologic map it should be reflected in the cross
section. Use relative displacement arrows to show fault separation - do not use linework symbols
(teeth, hachures, etc.).
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Figure 15-3 : Geologic Map of the Wyndale and Holston Valley Quadrangles, VA.
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Figure 15-4 : Geologic cross-sections of the Wyndale and Holston Valley Quadrangles, VA.
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